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WARNING: BitHeadz, Inc. (“BitHeadz”) is willing to grant a non-exclusive license of this software (“SOFTWARE”) to you (“LIC-
ENSEE”) only upon the condition that you accept and agree to all of the terms contained in this license agreement (“AGREE-
MENT”).  The term SOFTWARE shall also include any and all modified versions, version updates, and upgrades of the SOFT-
WARE licensed to you by BitHeadz.  PLEASE READ THE TERMS CAREFULLY BEFORE INSTALLING THIS SOFTWARE AS INSTALLING
THE SOFTWARE WILL INDICATE YOUR COMPLETE ACCEPTANCE OF THE FOLLOWING TERMS AND CONDITIONS:

1. USE OF THE SOFTWARE: The SOFTWARE is licensed only to you the LICENSEE.  This license is not transferred to anyone
without the prior written permission of BitHeadz.  Any authorized transferee of the SOFTWARE shall be bound by the terms
and conditions of this AGREEMENT.  In no event may you transfer, assign, rent, lease, sell, or otherwise dispose of the SOFT-
WARE on a temporary or permanent basis except as expressly provided herein.

This license allows you to: (a) use the SOFTWARE only on a single computer at a single location at a time; (b) physically transfer
the SOFTWARE from one computer to another provided that it is used on only one computer at a time and that you remove any
copies of the SOFTWARE from the computer from which the program is being transferred; (c) make one (1) copy of the
SOFTWARE solely for backup purposes.  You must reproduce and include the copyright notice on the backup copy.

YOU MAY NOT: (a) distribute copies of the SOFTWARE or any written documentation to any other person or entity; (b) loan,
rent, lease, resell for profit , create derivative works based on the SOFTWARE or any part thereof, or grant any form of sub-
license of any rights to the SOFTWARE; (c) electronically transfer the SOFTWARE from one computer to another over a net-
work; (d) provide use of the SOFTWARE in a multiple user arrangement without the prior written consent of BitHeadz.

2. COPYRIGHT The SOFTWARE is owned by BitHeadz.  Its structure, organization and code are the valuable trade secrets and
intellectual property of BitHeadz.  This SOFTWARE is protected by United States Copyright Law and International Treaty provi-
sions.  You agree not to modify, translate, reverse engineer, disassemble, decompile, create derivative works, or otherwise
attempt to discover the source code of the SOFTWARE.  You also agree not to modify, translate, reverse engineer, disassemble,
or create derivative works of the written documentation without prior written permission of BitHeadz.

3. NO WARRANTY THE SOFTWARE AND ACCOMPANYING WRITTEN DOCUMENTATION (INCLUDING INSTRUCTIONS FOR USE)
ARE BEING DELIVERED TO YOU ‘AS IS’ AND BITHEADZ CANNOT AND DOES NOT MAKE ANY WARRANTY AS TO ITS USE OR
PERFORMANCE.  FURTHERMORE, BITHEADZ MAKES NO GUARANTEE OR REPRESENTATIONS REGARDING THE USE, OR THE
RESULTS OF THE USE, OF THE SOFTWARE OR THE WRITTEN DOCUMENTATION IN TERMS OF CORRECTNESS, ACCURACY,
RELIABILITY, OR FITNESS FOR ANY PARTICULAR PURPOSE.  THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE
SOFTWARE IS ASSUMED BY YOU THE LICENSEE. UNDER NO CIRCUMSTANCES WILL BITHEADZ OR ITS SUPPLIERS  BE LIABLE TO
YOU FOR ANY CONSEQUENTIAL, SPECIAL OR INCIDENTAL DAMAGES, INCLUDING BUT NOT LIMITED TO ANY LOST PROFITS OR
LOST SAVINGS, OR FOR ANY CLAIM BY ANY THIRD PARTY EVEN IF BITHEADZ OR ITS REPRESENTATIVE HAS BEEN ADVISED OF
THE POSSIBILITY OF SUCH DAMAGES.  BECAUSE SOME STATES DO NOT ALLOW THE EXCLUSION OR LIMITATION OF LIABILITY
FOR INCIDENTAL, CONSEQUENTIAL OR SPECIAL DAMAGES, THE ABOVE LIMITATIONS MAY NOT APPLY TO YOU.

4. ENTIRE AGREEMENT This AGREEMENT will be governed by the laws of the State of California excluding the application of its
conflicts of law rules. This AGREEMENT will not be governed by the United Nations Convention for the international Sale of
Goods, the application of which is expressly excluded.  You acknowledge that you have read this AGREEMENT, understand it,
and that it is the complete and exclusive statement of your agreement with BitHeadz, and supersedes any prior written or oral
agreement, and all other communications relating to the subject matter of this AGREEMENT.  You agree that the SOFTWARE will
not be shipped, transferred or exported into any country or used in any manner prohibited by the United States Export Adminis-
tration Act or other export laws, restrictions or regulations.

Retro AS-1 and BitHeadz are trademarks of: BitHeadz, Inc. 4400 Capitola Road, Suite 202 Capitola, CA  95010 408-465-9898
408-465-9899 (fax)

Manual Version 980825



Table O
f C

ontents

Retro AS-1 Manual

3

Table Of Contents

Cover Page ........................................................................................................................... 1

Chapter 1. Introduction ...................................................................................................... 12
1.1 Welcome!................................................................................................................. 12
1.2 Features ................................................................................................................... 13
1.3 System Requirements ................................................................................................ 14
1.4 Manual Organization ................................................................................................ 15
1.5 Manual Conventions ................................................................................................. 16

Basic Computer Operations .................................................................................... 16
Important Information ........................................................................................... 16
Cross-Platform Manual........................................................................................... 17
The “Online” Portable Document Format ................................................................ 18

1.6 Mac OS versus Windows 95 ...................................................................................... 19
Output .................................................................................................................. 19
MIDI Input ............................................................................................................ 19
User Interface ........................................................................................................ 19

1.7 Key Concepts ............................................................................................................20
It’s really a Synthesizer ...........................................................................................20
Use it like an instrument .........................................................................................20
Program Files .........................................................................................................20
Setup Files .............................................................................................................20
Mixer Files .............................................................................................................20
MIDI ...................................................................................................................... 21
Polyphony .............................................................................................................. 21
Output ................................................................................................................... 21

1.8 Software Components ............................................................................................... 22
Retro AS-1 Editor Appli[9tion ................................................................................. 22
Retro AS-1 MIDI Processor Application ................................................................... 22
Retro AS-1 Keyboard Application ............................................................................ 22
Retro AS-1 Mixer Application ................................................................................. 22
Retro AS-1 Status ................................................................................................... 22
Retro AS-1 OMS Input, FreeMIDI Input,
& Serial Input utilities (Mac OS only) ...................................................................... 23
Retro AS-1 OMS & FreeMIDI drivers (Mac OS only) ................................................. 23
Retro AS-1 Windows Device Driver (Win 95 only) ................................................... 23
Retro AS-1 Control Panel ........................................................................................ 23
Retro AS-1 Programs .............................................................................................. 23
Retro AS-1 Engine .................................................................................................. 23

1.9 Who is BitHeadz? ..................................................................................................... 24

Chapter 2. Installation and Setup ....................................................................................... 25
2.1 Audio and MIDI Hardware Setup ............................................................................... 25

Audio Hardware Setup ........................................................................................... 25
MIDI Hardware Setup ............................................................................................ 26

CLICK ANY CONTENTS ITEM TO JUMP DIRECTLY TO THAT PAGE



Table O
f C

ontents

Retro AS-1 Manual

4

2.2 Mac OS Installation .................................................................................................. 26
How to install Retro AS-1 ....................................................................................... 26
How to deinstall Retro AS-1 .................................................................................... 27
Where the software components are installed (Mac OS) ........................................... 28

2.3 Mac OS Setup........................................................................................................... 29
Sound control panel or Monitors and Sound control panel? ...................................... 29
2.3.1 Sound Manager setup for non-PCI Macs using the Sound control panel ............ 29
2.3.2 Sound Manager setup for PCI Macs using the Monitors & Sound control panel: .. 31

2.4 Windows 95 Installation ........................................................................................... 34
Before You Install .................................................................................................. 34
How to install Retro AS-1: ...................................................................................... 35
How to deinstall Retro AS-1: ................................................................................... 36
Where the software components are installed (Windows 95) .................................... 37

2.5 Windows 95 Setup.................................................................................................... 38
How To Set Volumes in Windows 95 ....................................................................... 38

Chapter 3. Quick Start ........................................................................................................ 40
Important Synthesizer Information ......................................................................... 40

3.1 Auditioning Sounds with the Keyboard ....................................................................... 41
Keyboard Overview................................................................................................. 41
To Trigger Sounds using the Retro AS-1 Keyboard: .................................................... 41

3.2 Activating MIDI Input ............................................................................................... 43
Overview .............................................................................................................. 43
To Activate MIDI Input on Mac OS: ......................................................................... 43
To Activate MIDI Input on Windows 95: .................................................................. 45

3.3 Basic Editor Operations ............................................................................................. 46
Editor Program File Overview ................................................................................. 46
Editing Programs ................................................................................................... 49

3.4 Basic MIDI Processor Operations ................................................................................50
Overview ...............................................................................................................50

3.5 Parameter Editing Conventions .................................................................................. 52

Chapter 4. Working with MIDI ........................................................................................... 54
4.1 MIDI Overview ......................................................................................................... 54

4.1.1  Key MIDI Concepts ....................................................................................... 55
4.2 External MIDI input (Mac OS) ................................................................................... 56

4.2.1 MIDI Flow within Retro AS-1 ......................................................................... 56
4.2.2 Using Retro AS-1 Serial Input ......................................................................... 57
4.2.3 Using Retro AS-1 OMS Input and Retro AS-1 FreeMIDI Input ............................ 58

4.3 MIDI Software Integration (Mac OS) .......................................................................... 59
4.3.1 OMS and FreeMIDI Overview ......................................................................... 59

4.4 Configuring the OMS Driver ...................................................................................... 60
4.4.1 Configuring OMS MIDI applications................................................................ 62

How to setup Opcode Vision/StudioVision ........................................................ 62
How to setup Steinberg Cubase ......................................................................... 63

4.4.2 Setting up MIDI Clock Sync via OMS .............................................................. 64
Vision/StudioVision Sync Setup ........................................................................ 64
Cubase Sync Setup ........................................................................................... 66

CLICK ANY CONTENTS ITEM TO JUMP DIRECTLY TO THAT PAGE



Table O
f C

ontents

Retro AS-1 Manual

5

4.5 Configuring the FreeMIDI Driver ............................................................................... 67
4.6 External MIDI input (Windows) ................................................................................. 71

4.6.1 MIDI Flow within Retro AS-1 and Windows 95 ................................................ 71
4.6.2 Retro AS-1 Without 3rd-Party MIDI Applications .............................................. 71
4.6.3 The MIDI Input Port ...................................................................................... 72
4.6.4 Stand-Alone Operation ................................................................................... 72

4.7 MIDI Software Integration (Windows) ....................................................................... 73
4.7.1 Device Driver ................................................................................................ 73
4.7.2 Multimedia Control Panel .............................................................................. 73

4.8 Configuring the Retro AS-1 Device Driver (Windows) ................................................. 74
4.8.2 Configuring the Windows MIDI Mapper .......................................................... 75
4.8.3 Real-World Examples ..................................................................................... 78
4.8.4. Using Retro AS-1 With Third-Party Audio Sequencers ..................................... 82
4.8.5. Audio Sequencers and DirectSound ............................................................... 82

Chapter 5. Control Panel Reference .................................................................................... 83
5.1 Control Panel Overview ............................................................................................ 83

5.1.1 System Performance ...................................................................................... 83
5.1.2 Key Control Panel Concepts ........................................................................... 84

5.2 Configuration settings ............................................................................................... 85
5.3 Controllers Settings ................................................................................................... 87
5.4 Global Effects Settings .............................................................................................. 89
5.5 Input/Output Settings ............................................................................................... 90
5.6 Miscellaneous Settings ............................................................................................... 91

Chapter 6. MIDI Processor Reference ................................................................................. 93
6.1 MIDI Processor Overview.......................................................................................... 93

6.1.1 MIDI Processor Setups ................................................................................... 93
6.1.2 MIDI Processor Files ...................................................................................... 94

6.2 Key MIDI Processor Concepts .................................................................................... 94
6.3 MIDI Processor Menus .............................................................................................. 95

File menu .............................................................................................................. 95
Edit Menu ............................................................................................................. 96
Preferences... ......................................................................................................... 97
Synthesizer Menu .................................................................................................. 99
Windows Menu .................................................................................................... 100

6.4 Setup List Parameters .............................................................................................. 100
The Setup List ...................................................................................................... 100

6.5 Split/Layer Parameters ............................................................................................. 101
Mode radio buttons .............................................................................................. 101
Setup Layers ......................................................................................................... 102
Comments Window .............................................................................................. 103

6.6 Arpeggiator Parameters ............................................................................................ 103
Arpeggiation Type Radio Buttons ........................................................................... 103
Other Arpeggiator Controls .................................................................................... 105

CLICK ANY CONTENTS ITEM TO JUMP DIRECTLY TO THAT PAGE



Table O
f C

ontents

Retro AS-1 Manual

6

Chapter 7. Editor Reference ............................................................................................... 108
7.1 Editor Overview ...................................................................................................... 108

7.1.2 Key Editor Concepts ..................................................................................... 109
7.1.3 Parameter Editing Conventions ...................................................................... 109

7.2. Editor Menu Items .................................................................................................. 110
File Menu............................................................................................................. 110
Edit Menu ............................................................................................................ 112
Preferences... ........................................................................................................ 113
Page Menu ........................................................................................................... 114
Synthesizer Menu ................................................................................................. 115
Windows Menu .................................................................................................... 116

7.3 Main Page ............................................................................................................... 116
Oscillator Overview .............................................................................................. 116
Oscillator Parameters ............................................................................................ 117
Oscillator Menus .................................................................................................. 118
Oscillator Sliders ................................................................................................... 120
Filters Overview ................................................................................................... 122
Filter Parameters ................................................................................................... 123
Filter Sliders ......................................................................................................... 126
Configuration Display ........................................................................................... 127

7.4 Modulation Page ..................................................................................................... 128
Routings Parameters ............................................................................................. 128
Modulators Parameters .......................................................................................... 131
Modulator Type Menu ........................................................................................... 133
Modulator Trigger Menu ....................................................................................... 137

7.5 Effects Page ............................................................................................................. 139
Effects Overview................................................................................................... 139
The Insert Effect Parameters .................................................................................. 140
The Global Effects ................................................................................................ 147

7.6 Global Page ............................................................................................................. 151

Chapter 8: Keyboard Reference..........................................................................................155
8.1 Keyboard Overview ................................................................................................. 155
8.2 Key Keyboard  Concepts........................................................................................... 156
8.3 Keyboard Menus ..................................................................................................... 156

File Menu............................................................................................................. 156
Edit Menu ............................................................................................................ 156
Synthesizer Menu ................................................................................................. 156

8.4 Keyboard Parameters ............................................................................................... 158

Chapter 9. Mixer Reference ............................................................................................... 161
9.1 Mixer Overview ....................................................................................................... 161

Using the Mixer with the Editor ............................................................................. 162
Global Effects with the Mixer ................................................................................ 162

9.2 Key Mixer Concepts ................................................................................................. 164
9.3 Mixer Menus ........................................................................................................... 164

File Menu............................................................................................................. 164
Edit Menu ............................................................................................................ 165
Synthesizer Menu ................................................................................................. 166

9.4 Channel Strips ......................................................................................................... 167
9.5 Master Section ........................................................................................................ 169

CLICK ANY CONTENTS ITEM TO JUMP DIRECTLY TO THAT PAGE



Table O
f C

ontents

Retro AS-1 Manual

7CLICK ANY CONTENTS ITEM TO JUMP DIRECTLY TO THAT PAGE

Appendix A: Working with Banks and Programs ..............................................................172

Appendix B: Optimizing Performance ...............................................................................176

Appendix C: Troubleshooting ............................................................................................179

Appendix D: Using Digidesign Direct IO............................................................................183

Appendix E: Analog Synthesis Demystified .......................................................................186

Appendix F: MIDI Implementation .................................................................................... 191
I. The Official MIDI Implementation Chart ...................................................................... 191
II. Supported MIDI Control Numbers .............................................................................. 192
III. System Exclusive Commands .................................................................................... 193
IV. Non-Registered Parameter Numbers (“NRPNs”) ......................................................... 193

Appendix G: Record To Disk.............................................................................................. 201

Appendix H: QuickTime™ Driver .......................................................................................203

Appendix I: OMS Names ...................................................................................................209

Index ................................................................................................................................216

Manual & Layout By Theo Byassee
Software Created By Steve O’Connell

Software Development By David Sumich & Fernando Martinez
Sales & Marketing By Earl Sondreal
Graphics & Design By André Rocke

Software Quality Assurance By Will Puckett

Mark Gavini
Will Oxford

Bobby Lombardi
Jake Thorne
Doug Wood

Ed Gray
Jonnie Gillham

Jim Cooper
Adam Crary

Andrew Schlesinger
Mike Struble

Bob Frye
Jaime Lagueruela

Nick Peck
Ron MacLeod

Ed Dickie
Michael Anthony
Craig Negoescu

Michael Bernardø
Randy Hollingsworth

Charlie Clouser
Jim Reekes

Special Thanks to:

Credits



C
hapter 1: Introduction

Retro AS-1 Manual

8

Chapter 1. Introduction
Chapter 1 Contents
1.1 Welcome!
1.2 Features
1.3 System Requirements
1.4 Manual Organization
1.5 Manual Conventions
1.6 Mac OS versus Windows 95
1.7 Key Concepts
1.8 Software Components
1.9 Who is BitHeadz?

1.1 Welcome!
Thank you for your interest in Retro AS-1, the full-featured professional
software synthesizer from BitHeadz. At last there is software that is so
convenient and sounds so fantastic, your computer will become your favorite
sound module. Using sizzling new DSP technology, you can recreate the sounds
of all the classic analog synthesizers or create amazing new soundscapes of
your own from scratch with full programmability.

Just imagine. Your creativity will no longer be stifled by “old-school” hardware
limitations on oscillators, filters, modulation, and effects. And of course, it's
fully polyphonic and multi-timbral, with fast response time, and more, all at
a fraction of the price of hardware synthesizers.

Extensive MIDI implementation allows real-time control of all parameters
and easy integration into existing MIDI setups. You can play Retro AS-1 “live”
just like any other musical instrument with layers, splits, and full MIDI
continuous control, or use it as a multi-timbral sound module running behind
your favorite MIDI application on the same computer.

Use the full-featured arpeggiator to generate analog-style “sequences”. You
can even write the synthesizer’s complete multi-timbral stereo output to disk
as an audio file for use in your favorite digital audio applications.

Is it too good to be true? No! Computer hardware and software is finally fast
enough to execute our latest “rocket science” music technology, and you get
to enjoy the benefits of it.

Retro AS-1 will provide you with a wealth of new sonic opportunities. We
hope you enjoy using Retro AS-1 as much as we enjoyed creating it!

The official Retro AS-1 logo
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1.2 Features
General

• Outstanding 16-bit, 44.1kHz sound quality
• Excellent real-time play response time
• 100 percent programmable
• Over 100 parameters; up to 200 values per parameter
• "Musician Friendly" user interface
• Unlimited presets; includes 1000 factory presets
• Full simultaneous MIDI application compatibility
• Up to 32 note polyphony (CPU dependent)
• CPU limiting to accommodate MIDI applications
• On-screen keyboard; no MIDI controller required to trigger sounds
• Ability to write synthesizer output to disk in audio file format (8, 16, or 24 bit)
• Stereo output

Oscillators
• Up to 3 oscillators per voice (not including low frequency oscillators)
• 8-octave range per oscillator
• 9 waveform types: Saw, Pulse, Triangle, Sine, Sine squared, Glottal, Noise (white, pink, red)
• Continuous control of waveform symmetry
• Sync any oscillator to any other oscillator or filter
• Frequency modulation from any oscillator or filter

Filters
• 2 assignable filters per voice
• 13 filter types, including 4-pole resonant lowpass, highpass, bandpass,

allpass, notch, and state-variable
• Multiple inputs allow parallel and/or serial filtering
• Filters can be modulated by oscillators (“poly mod”)

Modulation
• Dozens of modulation routings
• Dozens of envelopes and low frequency oscillators (“LFO’s”)
• Six different LFO shapes
• LFO’s can be synchronized to MIDI clock
• Most parameters are available as a modulation source and/or destination
• Four continuous MIDI controller modulation sources are available simultaneously
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Effects
• 2 insert (serial) effects processors per voice
• 2 additional global (parallel) effects processors
• 2 global effect sends per MIDI channel
• Fully parametric and shelf equalizers
• Multiple stereo reverb and reflection algorithms
• Stereo delays, chorus, phaser, and flange
• Overdrive and distortion effects
• Delay times can be synchronized to MIDI clock

Arpeggiator
• Multiple latch and assignment modes
• Enter notes manually or use on-screen keyboard for controller-free play
• Arpeggiator can be synchronized to MIDI clock

MIDI
• MIDI Processor enables full control of layers and splits
• 16 simultaneous MIDI channel multi-timbral
• Real-time control of all parameters simultaneously via NRPNs
• Serial port application included for direct MIDI input (Mac OS only)

1.3 System Requirements
• 32 megabytes RAM
• Compatible CD-ROM drive
• 800 x 600 or higher resolution monitor with 256 (8-bit) or more colors

Mac OS
• 120MHz or faster PowerPC® processor
• Operating system software version 7.6.1 or higher (OS 8 or higher recommended)
• 40 MB free hard disk space (10 MB with HFS+)

Windows 95
• 200MHz or faster Pentium processor
• Direct X supported sound card
• 10 MB free hard disk space
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Package Contents
• Software installer on CD-ROM
• User Manual on CD-ROM
• Registration card

Suggested System Enhancements
• Quality stereo sound monitoring system
• MIDI controller and interface

1.4 Manual Organization
This user manual explains how to install, configure, and use the
Retro AS-1 software synthesizer. There are nine main sections:

Chapter 1: Welcome to Retro AS-1!
• Chapter 1 introduces the user to the product features and

concepts, system requirements, and software components.
Important information about manual organization, conventions,
and Mac OS/Windows 95 differences are also covered here.

Chapter 2: Installation and Setup
• This chapter provides instructions for product installation and

system configuration on the Mac OS and Windows 95 platforms.

Chapter 3: Quick Start
• This chapter is written to get Retro AS-1 up and running quickly

and gives brief instructions for the various software
components.

Chapter 4: Working with MIDI
• This chapter provides details on how to use MIDI with Retro

AS-1 and describes how to integrate Retro AS-1 into existing
MIDI environments with OMS, FreeMIDI, and Windows 95.
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Chapters 5 through 9: Reference Section
These chapters describe each software component function and parameter in full detail.

• Chapter 5: Control Panel Reference
• Chapter 6: MIDI Processor Reference
• Chapter 7: Editor Reference
• Chapter 8: Keyboard Reference
• Chapter 9: Mixer Reference

Appendices
• Appendix A: Working with Banks and Programs
• Appendix B: Optimizing Performance
• Appendix C: Troubleshooting
• Appendix D: Using Digidesign Direct IO
• Appendix E: Analog Synthesis Demystified
• Appendix F: MIDI Implementation
• Appendix G: Record To Disk
• Appendix H: QuickTime™ Driver
• Appendix I: OMS Names

1.5 Manual Conventions

Basic Computer Operations
This manual assumes you are proficient with the computer platform you are using. You should
know how to use the mouse, launch and quit applications, open/save/delete files, navigate the
hard disk, access control panel settings, and similar basic operating system functions.

Important Information
Of course, we recommend reading the entire manual to fully understand and implement the
power of Retro AS-1. However, certain passages contain particularly important information.

Information that is critical to the performance and/or sound quality of the synthesizer is denoted
by “Mr. Waveform” and a cyan highlight box.

Information that is particularly useful for the operation of the synthesizer is denoted by “Mr.
Waveform” and a green highlight box.
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Cross-Platform Manual
The Retro AS-1 Manual is the same for both the Mac OS and Windows
95 platforms. All information presented is applicable to both systems
unless otherwise denoted by the Mac OS and Windows 95 symbols
shown here.

The red “M” symbol indicates the information pertains only to the
Mac OS platform.

The blue “W” symbol indicates the information pertains only to the
Windows 95 platform.

Screenshots

The manual uses pictures of the computer screen
(“screenshots”) to give a visual aid when describing
features and functions of the software. The user
interface on Mac OS and Windows 95 varies
primarily in the appearance of the windows due to
differences in the operating systems. However,
because the layout within the windows, the objects
contained within them, and their functionality is
identical in both versions, Mac and Windows
screenshots are used interchangeably in this
manual.

When a particular screen is different between the
two platforms, both screenshots will be shown.

Even though they look slightly different, Mac OS and
Windows 95 screenshots are shown interchangably in the

manual if the window(s) have the same functionality.
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The “Online” Portable Document Format
This manual is optimized to take advantage of the most
useful Portable Document Format features. Here are
some Adobe Acrobat Reader tips:

• The Table Of Contents, the Index, and blue
underlined text are active hyperlinks. The cursor
changes to a pointing hand when placed over a
hyperlink. Click a hyperlink to jump directly to the
corresponding linked page.

• The Bookmarks are handy for navigating around
the manual. Bookmark sections can be expanded
or contracted by clicking the disclosure triangle

• The manual opens to a default “view” size of 100%.
The view size can be adjusted for readability. Use the
Zoom function (click and hold the magnifying glass icon
at bottom of window) to change the view size.

• The graphics (screenshots and illustrations) look best
when viewed at the default view size of 100%.
Graphics that look poor when viewed at 100% will
look perfect when viewed at 200%.

• The manual can be printed for “hard copy” from
within the Acrobat Reader application by selecting
Print... from the File menu.

• All the graphics will look good when printed,
regardless of the view size.

The Bookmarks and index are active
hyperlinks. The cursor changes to a pointing
finger when placed over a hyperlink. Click a

hyperlink to jump directly to the page.

Click the bookmark triangles to expand
and contract the hierarchy.

Click and hold the
magnifying glass icon to

change the view size.
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1.6 Mac OS versus Windows 95
The operational features, functionality, and user interface of Retro AS-1 for the PC are nearly
identical to the Mac OS version. The main difference is in the product installation and configuration,
which is unique to each platform due to the underlying hardware and operating system differences.
These differences are detailed in this section.

Output
Retro AS-1 output is routed to the Sound Manager (Mac OS) or DirectSound (Windows 95). Sound
Manager and DirectSound (a sub-component of DirectX) are components of the operating system
that receive audio signals from various sources and are responsible for routing those signals to the
audio outputs. Output can also be written directly to disk with the Record To Disk feature.

The output of Retro AS-1 for Mac OS is directed to the Sound Manager which routes the signal to
the Mac built-in audio outputs, or Digidesign Direct IO. The Sound Manager can be bypassed on
PCI Macs using Direct IO and Digidesign digital audio hardware. The Record To Disk audio file
uses the Audio Interchange File Format (“AIFF”).

Retro AS-1 for Windows 95 requires DirectSound, a sub-component of DirectX. DirectX is the
multimedia software layer of Windows 95 that enables compatibility between many different
hardware configurations. By using DirectSound, Retro AS-1 can be used on the widest variety of
PC computer systems. The Retro AS-1 Installer provides the option to install DirectX. The Record
To Disk audio file format is Wave format (“.wav”).

MIDI Input
To use Retro AS-1 as a MIDI sound module, the synthesizer engine must receive MIDI data. To
receive MIDI data from an external MIDI source, MIDI input must be activated.

Retro AS-1 for Mac OS can receive external MIDI data in three ways: with our direct serial input
port application, or via OMS or FreeMIDI.

Retro AS-1 for Windows 95 can receive external MIDI data from two sources: a standard Windows
MIDI output driver (which is installed when a hardware MIDI input port is installed into the PC
system), or the Retro AS-1 device driver, which is used by third-party MIDI applications to pass
MIDI to Retro AS-1.

User Interface
The user interface varies primarily in appearance variations of the windows due to differences in
the operating systems. The layout within the windows, the objects contained within them, and
their functionality is usually identical.

When a particular screen is different between the two platforms, both screens will be shown and
the differences explained in detail.
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1.7 Key Concepts

It’s really a Synthesizer
All Retro AS-1 functionality is implemented using digital signal processing technology. There are
no samples, wavetables, or digital audio recordings of any kind within Retro AS-1. All audio is
generated on the fly, in real-time, as you manipulate and play back
the sounds.

Use it like an instrument
No additional hardware or software is required to use Retro AS-1. Sounds can be triggered internally
using the on-screen keyboard utility. Using a MIDI controller (such as a MIDI compatible keyboard)
and interface (not included), sounds can be played in real-time like a conventional hardware
synthesizer with layers, splits, and full MIDI continuous control. With the included MIDI drivers,
Retro AS-1 can be used as a multi-timbral sound module, running in the background behind your
favorite MIDI application on the same computer.

Program Files
All synthesizer voicing parameters are accessed using the Retro AS-1 Editor application. Each
Editor file is a complete synthesizer "patch" that includes multiple oscillators, filters, modulation
routings, and insert effects. We call this complete set of voicing parameters a program. The
synthesizer engine loads program files from disk into RAM dynamically as required for playback
on each of the 16 MIDI channels. Groups of related programs can be easily arranged into banks.

Setup Files
The Retro AS-1 MIDI Processor is a powerful performance tool that enables you to modify MIDI
data in the synthesizer engine by programming layers (two programs sounding simultaneously),
splits (two different programs on each side of the keyboard), and arpeggiations (notes in a chord
played sequentially, one at time). The MIDI Processor can be thought of as our own version of the
multis, performances, or combinations in hardware keyboard products. We call one complete
group of layer, split, and arpeggiation settings a Setup. Each MIDI Processor file can contain
dozens of setups.

Mixer Files
Multi-timbral settings can be created and modified using the Retro AS-1 Mixer application. Each
Mixer file contains a complete set of values for bank and program selection, volume, pan, mute,
solo, and global effect send levels on each of the 16 MIDI channels. Global effects parameters can
also be accessed in the Mixer, and their values are stored in the Mixer file. Mixer files enable fast
and easy multi-timbral reconfigurations for use in particular MIDI environments.
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MIDI
Retro AS-1 can run in the background behind your favorite MIDI application
on the same CPU, providing excellent synthesizer timbres without additional
hardware. Up to 4 simultaneous real-time modulations using standard MIDI
controllers can be stored in a program for expressive performances.
Additionally, almost every voicing parameter can be accessed simultaneously
for real-time control using our extensive MIDI implementation.

Retro AS-1 includes a serial port driver that enables direct connection to a
MIDI interface without the hassles of third-party MIDI operating systems
such as MIDI Manager, OMS, or FreeMIDI. However, OMS and FreeMIDI
drivers are included to allow for complete integration into existing MIDI setups.

Retro AS-1 uses any Windows MIDI input (hardware) port for external MIDI
control. Also included is a standard Windows device driver to allow MIDI
connections from MIDI software applications running on the same CPU.

Polyphony
Because there is no dedicated hardware to perform certain tasks, the
computer's CPU must handle all synthesizer routines. Therefore, the available
polyphony is dependent upon CPU type, clock and bus speed, voice
complexity, and other applications that may be running simultaneously.
CPU processing resources can be reserved or limited in the Retro AS-1 control
panel, and polyphony can be restricted to allow  use on slower computer
systems.

Output
The Retro AS-1 output signal is sent to Sound Manager (Mac OS) or
DirectSound (Windows 95), which then routes the signal to the audio outputs
for connection to a mixer, headphones, stereo system, recording device, or
any other audio input. Using the Record To Disk feature, the synthesizer
output (including multi-timbral output with effects) can be recorded to disk
as an audio file for use in digital audio applications.

The output of Retro AS-1 for Mac OS goes to the Sound Manager, part of the
Macintosh operating system, for output to the Mac built-in audio outputs.
Proper Sound Manager setup is critical for optimum performance and sound
quality. Third-party digital audio expansion cards can be used for even higher
fidelity and digital I/O.

The output of Retro AS-1 for PC goes to DirectSound (a sub-component of
DirectX), part of the Windows 95 operating system. DirectSound then routes
the signal to the sound card where the audio outputs are located.
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1.8 Software Components
The Retro AS-1 package is a modular collection of eight main software
components, all designed to work together while maintaining ease of
use and sensible functionality grouping. Each of the components is
briefly described below. For detailed component descriptions, refer to
its associated reference chapter.

Retro AS-1 Editor Application
The Editor is the main sound design application, where synthesizer
programs are created, modified, and saved. The synthesizer voicing
parameters are accessed here. The Editor is mainly for voicing only; it
does not need to be open to use the synth. For details, see Chapter 7.

Retro AS-1 MIDI Processor Application
The MIDI Processor is a powerful software controller that allows you
to control layers, splits, arpeggiations, and other “live play” controls.
It receives MIDI data from the synthesizer engine, then processes it
using a variety of functions before returning it back to the engine for
audio output. The MIDI Processor does not need to be open to use the
synth. For details, see Chapter 6.

Retro AS-1 Keyboard Application
This is an on-screen keyboard that allows you to audition Retro AS-1
sounds without using a MIDI controller. It has several utility functions
for selecting programs and triggering notes and chords. For details,
see Chapter 8.

Retro AS-1 Mixer Application
The Mixer is where you can create, edit, and save multi-timbral mixes.
You can also edit the global effects processors here and set their
individual send levels per MIDI channel. For details, see Chapter 9.

Retro AS-1 Status
The Status window allows you to view polyphony and CPU usage in
real-time. It provides visual feedback to assist in optimizing system
configuration parameters. For details, see Chapter 5.

The Status window is always open on Windows 95 when the
synthesizer is active.

Retro AS-1 Editor

Editor Program file

Retro AS-1 MIDI Processor

MIDI Processor Setup file

Retro AS-1 Keyboard

Retro AS-1 Mixer

Mixer multi-timbral file

Retro AS-1 Status
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Retro AS-1 OMS Input, FreeMIDI Input,
& Serial Input utilities (Mac OS only)
These utilities are used to get MIDI data from the Macintosh serial
ports to the synth engine during “live play” or anytime OMS or FreeMIDI
applications are not active. They are background applications that are
opened automatically when the Editor, MIDI Processor, or Mixer
applications are launched. For details, see Chapter 2.

Retro AS-1 OMS & FreeMIDI drivers (Mac OS only)
These driver components are used in conjunction with third-party MIDI
operating systems to run the synthesizer from within existing MIDI
software environments. They allow you to trigger Retro AS-1 from
MIDI applications running on the same computer as the synthesizer.
For details, see Chapter 2.

Retro AS-1 Windows Device Driver (Win 95 only)
The device driver for our software “MIDI module” is used by the
Windows 95 MIDI Mapper and/or third-party MIDI applications to
provide a multi-timbral destination for transmitting MIDI information
to the Retro AS-1 synthesizer engine. For details, see Chapter 3.

Retro AS-1 Control Panel
The control panel is the global settings utility. It allows you to edit
system configuration parameters such as polyphony, CPU usage, sample
rate, MIDI controller assignments, output device, and more. For details,
see Chapter 5.

Retro AS-1 Programs
The Retro AS-1 Programs folder is where the synthesizer programs are
located. Program files can reside anywhere but must be within the
Retro AS-1 Programs folder to receive MIDI Bank and Program change
commands. Programs are arranged into banks by creating a folder
hierarchy within the Retro AS-1 Programs folder. For details, see
Appendix A.

Retro AS-1 Engine
The system components are the host-based processors that perform
the actual synthesis. This “synth engine” performs its duties in the
background at the system level, behind all other applications.

The synth engine itself, when activated, requires 6 megabytes of system
memory in addition to any other applications being used.

Serial/OMS/FreeMIDI Input

Retro AS-1 MIDI Driver

Retro AS-1 Control Panel

Retro AS-1 Engine

Retro AS-1 Objects Library

Retro AS-1 Programs folder

Retro AS-1 Device Driver
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1.9 Who is BitHeadz?
BitHeadz is a software technology company specializing in the design
and development of high quality software solutions for the computer
and professional music industries. Our focus is to provide advanced
software synthesis, professional quality sound sets, custom interactive
content, and audio applications and tools for the PC and Macintosh
environments. With our established expertise in these areas, BitHeadz
is committed to providing the best sounding software in the industry.

BitHeadz long-range goal is to develop interactive music applications
that will target two related markets; the computer industry and the
professional electronic music industry.  Current industry data shows
that over the next five years, as a result of the convergence of these
two markets, a significant increase of professional musicians and
hobbyists alike will rely on computer technology to listen, play, enjoy,
and create music of all types.

The official BitHeadz logo

www.bitheadz.com

http://www.bitheadz.com/
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Chapter 2. Installation and Setup
Chapter 2 Contents
2.1 Audio and MDI Hardware Setup
2.2 Mac OS Installation
2.3 Mac OS Setup
2.4 Windows 95 Installation
2.5 Windows 95 Setup

Please pay special attention to this chapter. You should read the section
for your computer operating system in its entirety. It contains
information that will affect Retro AS-1 sound quality and performance.

2.1 Audio and MIDI Hardware Setup
Retro AS-1 is a high fidelity, stereophonic musical instrument. For
maximum enjoyment, we recommend connecting your computer to a
high quality stereo sound monitoring system such as stereo
headphones, an amplifier/speaker combination, or mixer.

Audio Hardware Setup

IMPORTANT! Turn the volume of your sound system all the way
down until specifically instructed to turn it up.

Most computer sound output jacks accept a standard
stereo 1/8-inch miniplug connector. Some systems
may have RCA jacks for sound output. Use whichever
output is most appropriate for your system.

Connect the computer sound output jack to the line-
level input of your sound system using an appropriate
adapter cable (not included). A typical cable for such
connections is a “stereo 1/8-inch male TRS (tip-ring-
sleeve) miniplug to dual-RCA plugs,” available at any
electronics supply store.

For more detailed instructions on how to interconnect
your audio hardware components, consult the
documentation that came with the audio hardware.

Figure 2.1.1. Connecting the
computer to a sound system.

Your particular audio setup may
vary.
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MIDI Hardware Setup
Follow the instructions included with your MIDI controller and MIDI
interface to connect them to your computer.

Additional MIDI information, including MIDI software configuration,
can be found in Chapter 4, Working with MIDI.

2.2 Mac OS Installation
This entire section is for Mac OS only. Installation and setup instructions
for Windows 95 is in sections  2.4 and 2.5 of this chapter.

Retro AS-1 has an automated installer that places the necessary software
components where they are needed on your hard disk.

How to install Retro AS-1
1. Insert the Retro AS-1 CD-ROM disk into the

Mac OS-compatible CD-ROM drive.
The CD-ROM icon will appear on the Desktop.

2. Double-click the Retro AS-1 CD-ROM icon
to open the Retro AS-1 CD-ROM window.

3. Double-click the Retro AS-1 Installer icon.
The Retro AS-1 splash screen will appear. Click
Continue to advance to the Read Me screen.

4. Read the important information contained in
the text window.
The text window contains critical information
about Retro AS-1. Click Continue to advance to
the License Agreement screen.

5. Please read the license agreement.
By installing the softw are, you are bound to its
terms. Click A gree to advance to the password
entry screen.

Figure 2.2.1. The Retro AS-1 CD-
ROM window.
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7. Enter your password.
Enter your password from the Retro AS-1 registration card included
in the box. Click OK to advance to the installation options scr een

8. Click Install to install the default software package.
The default Easy Install package is recommended for initial installations.
For advanced  installation options, select Custom Install from the
pull-down menu.

9. Select a destination for the Retro AS-1 Folder then click
Install.
The Retro AS-1 components will be written to disk at the location
you select using the standard Mac OS save dialog box. You can
select volumes other than the startup volume for the Retro AS-1
Folder. The required system files will be installed into the System Folder
on the volume you select.

10.That’s it! You do not need to restart when the process is
complete.
Installation is now complete. However, to ensure you have the latest,
greatest version of Retro AS-1, please proceed to step 11.

11.Download and install the latest version of Retro AS-1 from
our web site.
BitHeadz is committed to ongoing product development. When
product updates are released, they are posted on our web site for
downloading at www.bitheadz.com/Updates.html . Instructions for
updating are included in the update installer.

How to deinstall Retro AS-1
1. Follow steps 1-7 of the installation procedure in the

previous section.
The installation options window appears.

2. Select Uninstall from the install options pull-down menu.
The Uninstall window appears.

3. Click the Uninstall button.
Done! All of the Retro AS-1 components will be moved to the trash.

http://www.bitheadz.com/updates.html
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Figure 2.2.2. Where the
software components are

installed in Mac OS.

RETRO AS-1 COMPONENT INSTALLED LOCATION

Retro AS-1 Folder User selectable

Retro AS-1 Editor Retro AS-1 Folder

Retro AS-1 MIDI Processor Retro AS-1 Folder

Retro AS-1 Programs Retro AS-1 Folder

Retro AS-1 Manual Retro AS-1 Folder

Retro AS-1 Utilities Folder Retro AS-1 Folder

Goodies Folder Retro AS-1 Folder

Retro AS-1 Keyboard Retro AS-1 Utilities Folder

Retro AS-1 Mixer Retro AS-1 Utilities Folder

Retro AS-1 Status Retro AS-1 Utilities Folder

Serial/OMS/FreeMIDI Input Retro AS-1 Utilities Folder

Retro AS-1 Programs alias System Folder: Root Level

Retro AS-1 Control Panel System Folder: Control Panels

Retro AS-1 Engine System Folder: Extensions

Retro AS-1 Objects Library System Folder: Extensions

Retro AS-1 OMS Driver System Folder: OMS Folder

Retro AS-1 FreeMIDI Driver System Folder: FreeMIDI Folder

Where the software components are installed (Mac OS)
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2.3 Mac OS Setup

NOTE: If you have a Digidesign audio expansion card installed in
your system, please see also Appendix D.

The Mac OS Sound Manager software needs to be set up correctly for
you to hear maximum fidelity from Retro AS-1. It only needs to be set
up one time; control panel settings are retained even after system
shutdown.

IMPORTANT! Turn the volume of your sound system all the way
down until specifically instructed to turn it up.

Sound control panel or Monitors and Sound control
panel?
How the Sound Manager configuration windows look depends on
which type of Macintosh you have, non-PCI (older style) or PCI (most
Macs and clones since August 1995). You can usually tell which type
of system you have by looking at the control panel used within the
system software. Look in your Control Panels folder (accessed from
the Apple Menu). If your system has only the Sound control panel,
your system is probably not PCI. If your system has the Monitors &
Sound control panel, you probably have a PCI Mac.

2.3.1 To set up the Sound Manager for non-PCI Macs
using the Sound control panel (skip to
section 2.3.2 for PCI Macs):
1. Turn down the volume of your sound

monitoring system to its minimum setting.

2. Open the Sound control panel.
The Sound control panel is located in the Contr ol
Panels folder, which can be accessed from the Apple
Menu.

3. Choose Volumes from the pull-down menu.

4. Drag the slider bar for Built-in volume all the
way to maximum.
This is the Macintosh master output level control. It is independent
of the Alert Sounds volume control.

Figure 2.3.1. Choosing Volumes
in the Sound control panel.
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IMPORTANT! The Volume slider controls the master
system volume. It is a digital level control; the volume is
lowered by “dropping bits.” For maximum signal-to-noise
ratio, leave this control at maximum and use your
monitoring system controls to set the listening levels.

5. Click on the volume slider bar when it is at
maximum while slowly increasing the
monitoring system volume to your desired
listening level.

6. Choose Sound Out from the pull-down menu.
The Sound Out window details shown here may vary
according your Macintosh model.

7. Select the resolution for audio output.
Use the highest settings your Macintosh allo ws for
maximum fidelity . We recommend the following
settings:

Rate: 44.100kHz
Size: 16 bit
Use: Stereo

IMPORTANT! The sample
rate  setting should match
the setting in the Retro AS-1
control panel, otherwise
additional CPU processing
will be required for sample
rate conversions. See
Chapter 5. Control Panel
Reference, for more
information.

Figure 2.3.2. The Sound control
panel Volumes window. This
setting should always be at

maximum for highest fidelity.

Figure 2.3.3. The Sound control
panel Sound Out window. The

Rate setting should always match
the Retro AS-1 control panel

sample rate setting.
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8. Choose Alert Sounds
from the pull-down
menu.

9. Set the system alert
sound volume.
The Alert Volume  slider
controls only the level of
the system alert sound. It
is independent of the
Volumes control, which is
the master Macintosh level
control.  This setting should
be considerably less than
maximum (typically 30%
or lower), so the s ystem
beep will not be as loud as
the synthesizer output.

10.Close the Sound
control panel.
That’s it! Control panel settings remain current, even after rebooting.

2.3.2 To set up the Sound Manager for PCI Macs using
the Monitors & Sound control panel:
1. Turn down the volume of your sound monitoring system to

its minimum setting.

2. Open the Monitors & Sound control panel.
The Monitors & Sound control panel is located in the Control Panels
folder, which can be accessed from the Apple Menu.

3. Click on the Sound icon at the top of the Monitors & Sound
window

4. Drag the slider bar for Sound Out Level all the way to
maximum.
This is the Macintosh master output level control. It is independent
of the Alert Sounds volume control.

Figure 2.3.4. Sound Control Panel
Alert Sounds window. The Alert
volume should be lower than the

Volumes level.
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IMPORTANT! The Volume slider controls the master system volume.
It is a digital level control; the volume is lowered by “dropping bits.”
For maximum signal-to-noise ratio, leave this control at maximum
and use your monitoring system controls to set the listening levels.

5. Click on the volume slider bar when it is at maximum while
slowly increasing the monitoring system volume to your
desired listening level.

6. Select the Sound Output Quality.
We recommend 44.100kHz for maximum fidelity.

IMPORTANT! The sample rate  setting should match the setting in
the Retro AS-1 control panel, otherwise additional CPU processing
will be required for sample rate conversions. See Chapter 5. Control
Panel Reference, for more information.

Figure 2.3.5. The Monitors &
Sound control panel sound

settings. The Sound Out Level
should always be at maximum.

The Sound Output Quality setting
should match the Retro AS-1

control panel sample rate setting.
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7. Click on the Alerts icon at the top of the Monitors & Sound
window.

8. Set the System Alert Volume.
The System Alert Volume  slider controls only the level of the system
alert sound. It is independent of the Sound Out Level control, which
is the master Macintosh output level control. This setting should be
considerably less than maximum (typically lower than 30%), so the
system beep will not be as loud as the synthesizer output.

10. Close the Monitors & Sound control panel.
That’s it! Control panel settings remain active, even after rebooting.

Where to go from here
Retro AS-1 installation and basic Mac OS setup is now complete!

You are now ready to use Retro AS-1 as a stand-alone synthesizer with
live MIDI input. Proceed to Chapter 3, QuickStart, to learn the basic
operations of the Retro AS-1 applications.

Figure 2.3.6. The Monitors &
Sound control panel Alerts
settings. The System Alert

Volume should be lower than the
Sound Out Level (see figure

2.3.5).
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2.4 Windows 95 Installation

Before You Install
The Windows 95 computing environment can be complicated,
especially when dealing with multimedia hardware and software. To
ensure proper functionality when adding software and/or hardware
components to your system (and to avoid troubleshooting hassles
later!), operational problems should be resolved BEFORE installing
new component(s).

Please confirm the following steps A, B, and C before proceeding with
the installation of Retro AS-1:

A. Confirm that your sound card supports DirectSound.

Retro AS-1 requires DirectSound (a sub-component of DirectX) version
3.0 or higher. Contact the sound card manufacturer to confirm the
card supports DirectSound. If the sound card supports DirectSound,
the software that came with the sound card probably installed DirectX.
You can confirm DirectX installation and support using the following
technique:

1. Open the Add/Remove Programs control panel.
Add/Remove Programs can be accessed using Start
Menu>Settings>Control Panel.

2. While Install/Uninstall is the active tab, double-click the
DirectX Drivers item in the installed software list.
The DirectX Setup window appears. If DirectX Drivers is not shown
in the list, DirectX is probably not installed. The Retro AS-1 Installer
can optionally install DirectX.

Figure 2.4.1. The DirectX Setup
window in the Add/Remove

Programs control panel.
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3. Confirm the DirectSound component is Certified.
If the DirectSound component row shows certified, your card
supports DirectSound. If DirectSound shows No hardware support,
your sound card does not support DirectSound.

NOTE: The Retro AS-1 Installer will optionally install the DirectX
drivers to the latest version (5.0) if necessary.

B. The DirectSound-supported sound card and audio monitor-
ing system must be properly installed and configured.

Follow the installation and configuration instructions that came with
the hardware. Verify proper installation by using the MediaPlayer
application that is included with Windows 95
(Start>Programs>Accessories>Multimedia) to confirm playback of
digital audio (.WAV) files.

C. The MIDI interface (if any) must be properly installed and
configured.

Follow the instructions that came with the hardware. Verify proper
installation by confirming your MIDI application is sending and
receiving MIDI. Retro AS-1 will use the MIDI hardware port for MIDI
input.

NOTE: If you have any problems with the hardware or software,
consult the soundcard, MIDI card, or PC manufacturer for assistance.
BitHeadz cannot provide support for items unrelated to Retro AS-1.

The Software Installer
Retro AS-1 has an automated installer that places the necessary software
components where needed on your hard disk.

How to install Retro AS-1:
1. Insert the Retro AS-1 CD-ROM disk into the Windows 95-

compatible CD-ROM drive.

2. Select Run... from the Windows 95 Start Menu.
The Run window appears.

3. Type D:Setup into the Open command line and click OK.
The Retro AS-1 Installer window appears. If your CD-ROM drive
letter is not D, substitute the correct letter.
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4. Follow the instructions on the screen.
The installer will guide you through the process.

5. Restart when the process is complete. That’s it!
After rebooting, Retro AS-1 will be ready for use. However, to ensure
you have the latest, greatest version of Retro AS-1, please proceed
to step 11.

6. Download and install the latest version of Retro AS-1 from
our web site.
BitHeadz is committed to ongoing product development. When
product updates are released, they are posted on our web site for
downloading at www.bitheadz.com/Updates.html . Instructions for
updating are included in the update installer .

How to deinstall Retro AS-1:
1. Make sure all Retro AS-1 components are quit.

The Editor, Keyboard, MIDI Processor, Mixer, and any MIDI
application(s) using the Retro AS-1 device driver must be closed.

2. Open the Add/Remove Programs control panel.
Add/Remove Programs can be accessed using Start
Menu>Settings>Contr ol Panel.

3. While Install/Uninstall is the active tab, select Retro AS-1
from the installed programs list then click the Add/Remove
button.
The confirm File Deletion window appears.

4. Click Yes to remove Retro AS-1 from your system.
The installed Retro AS-1 components will be deleted. However, the
device driver must be manually deleted.

5. In the Multimedia Properties control panel, click the
Advanced tab.
The Retro AS-1 device driver is accessed here.

6. Click the plus sign next to MIDI Devices and Instruments.
The list of installed MIDI devices is displayed.

7. Double-click Retro AS-1 in the list.
The Retro AS-1 Properties window is displayed.

http://www.bitheadz.com/updates.html
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RETRO AS-1 COMPONENT INSTALLED LOCATION

Retro AS-1 Folder User selectable

Retro AS-1 Editor Retro AS-1 Folder

Retro AS-1 MIDI Processor Retro AS-1 Folder

Retro AS-1 Keyboard Retro AS-1 Folder

Retro AS-1 Mixer Retro AS-1 Folder

Retro AS-1 Manual Retro AS-1 Folder

Retro AS-1 Programs \Windows\

RetroCfg.dll \Windows\System\

RetroAS1.cpl \Windows\System\

RetroAS1.drv \Windows\System\

RetroAS1.vxd \Windows\System\

RetroAS1.exe \Windows\System\

RetroLib.dll \Windows\System\

RetroAPI.dll \Windows\System\

Figure 2.4.1. Where the
software components are
installed in Windows 95.

8. Click Remove to delete the Retro AS-1 device driver then reboot.
Retro AS-1 deinstallation is now complete.

Where the software components are installed (Windows 95)
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2.5 Windows 95 Setup
Windows 95 needs to be set up correctly for you to hear maximum
fidelity from Retro AS-1.

How To Set Volumes in Windows 95
Windows 95 controls the master system volumes for all devices using
its built-in digital mixer and Volume Control application. For maximum
fidelity within Retro AS-1, it is important to set up the system volumes
correctly.

IMPORTANT! Turn the volume of your sound system all the way
down until specifically instructed to turn it up.

1. Open the Volume Control application (SNDVOL32.EXE).
Volume Control can be accessed from the Start Menu
(Start>Programs>Accessories>Multimedia>Volume Control) or by
double-clicking the Speak er icon at the right side of the Task Bar.
The executable file SNDVOL32.EXE is located in the Windo ws
directory. Figure 2.5.1. Accessing Volume

Control from the Start Menu.

Figure 2.5.2 You can also double-
click the Task Bar speaker icon to

open Volume Control.
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2. Move the MIDI slider
to maximum.
This control sets the
output level of the
Retro AS-1 synthesizer
engine relative to the
other sl iders (CD
Audio, Wave, etc.)

3. Move the Volume
Control (leftmost
slider) to maximum.
This control sets the
master output of the
sound system (it effects
all the other sliders).

IMPORTANT! These
sliders control the master
system volumes. They
are digital level controls;
the volume is lowered by
“dropping bits.” For maximum signal-to-noise ratio, leave the MIDI
and Volume Control sliders at maximum and use your monitoring
system controls to set the listening levels.

4. Slowly increase the monitoring system volume to the desired
listening level while sound is playing from the computer.
Use any audio source (Audio CD, WAV file, MIDI file , etc) for setting
the monitoring volume. Media Player (accessed from Start Menu,
same location as Volume Control) is great for playing any media
quickly.

5. If clipping (digital distortion) occurs, lower the Master
Volume Control (step 3) while monitoring the output just
until the clipping disappears.

6. Done! You may close Sound Control or leave it open.

Where To Go From Here
Retro AS-1 installation and basic Windows 95 setup is now complete!

You are now ready to use Retro AS-1 as a stand-alone synthesizer with
live MIDI input. Proceed to Chapter 3, QuickStart, to learn the basic
operations of the Retro AS-1 applications.

Figure 2.5.4. This “mini slider”
pops up when you click once on
the Task Bar speaker icon. You
can use it to control the master

system volume.

Figure 2.5.3. The Volume Control
interface. The MIDI slider should

be at maximum. The “master”
Volume Control slider (far left)
should be as high as possible
before the onset of clipping

distortion.
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Chapter 3. Quick Start
Chapter 3 Contents
3.1 Auditioning Sounds with the Keyboard
3.2 Activating MIDI Input
3.3 Basic Editor Operations
3.4 Basic MIDI Processor Operations
3.5 Parameter editing conventions

In this chapter you will learn how to play sounds using the Retro AS-
1 Keyboard and a MIDI controller. Basic operations of the Editor and
MIDI Processor applications are also covered here.

Advanced MIDI operations for Mac OS and Windows 95 are covered
in Chapter 4; Working with MIDI.

Detailed explanations of every Retro AS-1 component and their
parameters are covered in the Reference section of this manual which
begins with Chapter 5.

All instructions included here assume you have already completed the
installation and setup processes described in Chapter 2. If you haven’t
already installed the software, connected your audio and MIDI
hardware, and configured the Sound Manager (Mac OS) or Volume
Control (Windows 95) as described in Chapter 2, please do so before
continuing with this chapter.

Important Synthesizer Information
We strongly recommend reading the Key Concepts section in Chapter
1 before proceeding. It contains a general overview of the product and
how it works.

Retro AS-1 is comprised of several “modular” software components.
The main component is the synthesizer engine. The synth engine is
the component that produces the audio signal. The other modules
(Keyboard, Editor, MIDI Processor, Mixer, MIDI driver) are components
that control the synth engine.

IMPORTANT: The synth engine cannot be opened directly. It is only
launched when activated by one of the other components.
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3.1 Auditioning Sounds with the Keyboard

Keyboard Overview
The Retro AS-1 Keyboard application is an on-screen utility for triggering
Retro AS-1 sounds without a MIDI controller or any other MIDI
hardware or software. The Keyboard allows you to trigger a 9-octave
range of individual notes and chords, change the active voice selection,
control note velocity values, and transmit controller information. The
Keyboard is the most direct and least complicated method of triggering
sounds. It requires no MIDI input and very little CPU and RAM
resources.

NOTE: Each Keyboard parameter and its function is explained in
detail in Chapter 8.

To Trigger Sounds using the Retro AS-1 Keyboard:
1. Launch the Retro AS-1 Keyboard application.

The Keyboard window will appear.

With Mac OS, you can open the application in tw o ways: by choosing
Keyboard... from the Synthesizer menu within the Editor, MIDI
Processor, or Mixer applications, or by double-clicking the Retro AS-
1 Keyboard application icon. Retro AS-1 Keyboard is located in the
Retro AS-1 Utilities folder, inside the Retro AS-1 Folder.

With Windows 95, you can open the application in three ways: by
choosing Keyboard... from the Synthesizer menu within the Editor,
MIDI Processor, or Mixer applications; by double-clicking the Retro
AS-1 Keyboard application icon; or Start Menu>Programs>Retro AS-
1>Retro AS-1 Keyboard. The application is installed (by default) at
the following location: Program Files/BitHeadz/Retro AS-1/Retro AS-
1 Keyboard.exe.

Figure 3.1.1. The Keyboard
window. Where you click

on the keys (top or
bottom) determines the

MIDI velocity for the note.
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2. Click on the black and white “keys” to trigger sounds.
Clicking a key sends the corresponding MIDI pitch to the synthesizer.
You are now hearing the active program file. Where you click on
the key determines the velocity value of the note. Clicking towards
the top of the key transmits a lower velocity for the note; clicking
towards the bottom of the note transmits a higher velocity value.
The computer QWERTY keyboard will also trigger sounds when
the Keyboard application is active.

IMPORTANT! If you don’t hear sound output from the Keyboard or
sound quality is poor, refer to Appendix C, Troubleshooting.

3. Select and audition various voices.
The program that is displayed under the Program pull-down menu is
the program you will hear. Use the Bank and Program menus to
select various factory programs to familiarize yourself with the
amazing sonic capabilities of Retro AS-1.

NOTE: If the Editor is open, you can select Editor from the Bank and
Program menus, allowing you to hear and modify the program(s)
that are currently loaded into the Editor.

NOTE: More information about Banks and Programs is covered in
Appendix A, Working with Banks and Programs.

4. Experiment with the Chord and Range functions.
Multiple notes can be triggered with the Chord function. Use the
pull-down menus to change the chord quality and the octave range.

In most of the factory programs, Controller A will affect the sound.
We invite you to try the Controller A slider when auditioning programs
(refer to figure 3.1.1).

Important! If synthesizer performance is poor (limited polyphony
and/or sluggish CPU response), see Appendix B, Optimizing
Performance.
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3.2 Activating MIDI Input

NOTE: This section is about using Retro AS-1 “stand alone” with a
MIDI controller. For information about integrating Retro AS-1 with
third-party MIDI applications, see Chapter 4, Working With MIDI.

Overview
Retro AS-1 can be “played” just like any other MIDI sound module
using a MIDI controller and interface. Such situations include playing
the synthesizer live, using a hardware (external) sequencer, or running
MIDI applications on a separate computer. How MIDI input is activated
is determined by the computer platform.

In .Mac OS, when the synth engine launches, Retro AS-1 Serial Input
(the direct serial port driver application) launches automatically when
“Serial” is selected as the Default MIDI Input source in the Retro AS-1
control panel. Retro AS-1 Serial Input receives MIDI information from
the Macintosh serial port and passes it directly to the synth engine. It
is used any time you want to use Retro AS-1 as a sound module without
using OMS or FreeMIDI. Retro AS-1 Serial Input remains active when
it is in the background.

In Windows 95, when the synth engine launches, Retro AS-1 “grabs”
the default hardware MIDI input port if “use Direct MIDI Input” is
selected in the Retro AS-1 control panel. The default MIDI hardware
port that will be used is specified in the Retro AS-1 control panel.
Once the MIDI input port is in use by Retro AS-1, it cannot be used by
another MIDI application. Conversely, if another MIDI application
“grabs” the MIDI input port before Retro AS-1 is launched, the MIDI
input port will be unavailable to Retro AS-1. Installed MIDI hardware
devices can be viewed in the System Properties Device Manager (System
control panel) under Sound, video and game controllers.

To Activate MIDI Input on Mac OS:
1. Verify the MIDI hardware is properly connected.

You will need a MIDI controller (or something else that transmits
MIDI), MIDI cable, MIDI interface, and serial cable (none are included
with Retro AS-1). Follow the installation instructions that came with
the MIDI hardware.
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2. Launch the Serial Input application.
Double-click the Retro AS-1 Serial Input application icon from the
Mac OS Finder. The application is located in the Retro AS-1 Utilities
folder, inside the Retro AS-1 Folder. The Serial Input application
window will be visible.

NOTE: Retro AS-1 Serial Input is launched automatically when the
Editor, MIDI Processor, or Mixer application is launched. This default
action can be disabled in the Retro AS-1 control panel.

3. Choose the MIDI port you are using.
When Serial Input is the active (foremost) application, the Port menu
will be visible . Choose the Macintosh serial port your MIDI interface
is connected to from the Port menu. Select either Printer or Modem.
For PowerBooks with only one serial port, select Modem. If you have
a MIDI Time Piece in Fast mode, choose Fast from the Port menu.
The active selection is indicated with a check mark.

IMPORTANT!  If you are using the Printer port for MIDI connections,
AppleTalk must be unloaded while using MIDI. To unload AppleTalk,
make it Inactive in the Chooser utility, which is accessed from the
Apple Menu, then reboot.

4. Trigger sounds using the MIDI source.
Now you can “play” your computer like a MIDI sound module . You
can select different programs using MIDI program change commands
or the Keyboard, Editor, MIDI Processor, or Mixer applications. You
can modify programs in real-time while receiving MIDI from the
controller using the Editor if the MIDI Channel parameter on the Editor
global page matches the MIDI transmission channel. If you are
transmitting MIDI to the synthesizer on more than one channel, you
can use the Retro AS-1 Mixer to specify the synthesizer’s multi-timbral
settings.

IMPORTANT! The Serial Input utility requires a Macintosh hardware
module called Serial DMA which is built into most PowerMacs. Serial
Input will display the message “This Macintosh does not have the
hardware required to support the Serial DMA Driver” on Macintosh
models that do not support Serial DMA. In this case, the OMS or
FreeMIDI systems must be used to get MIDI into Retro AS-1. See
Chapter 4 for more information.

Figure 3.2.1. The Serial Input
window. The application is used
to get MIDI from the serial port
to the synth engine. The “LEDs”
indicate incoming MIDI activity

on each of the 16 MIDI channels.

Figure 3.2.2. The Port menu in
Retro AS-1 Serial Input. Select the
serial port your MIDI interface is

connected to.
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To Activate MIDI Input on Windows 95:
1. Verify the MIDI hardware is properly connected and

configured.
You will need a MIDI controller (or something else that transmits
MIDI), MIDI cable, and MIDI interface (none are included with Retro
AS-1). Follow the installation instructions that came with the MIDI
hardware.

2. Verify no other MIDI applications are active.
The first MIDI application to launch (usually) “grabs” the MIDI input
hardware port. Quit all MIDI applications to ensure the MIDI input
port is available to Retro AS-1.

3. Launch the synth engine to activate MIDI input.
The synth engine is launched
whenever a Retro AS-1 component
(Keyboard, Editor, MIDI Processor,
Mixer, MIDI driver) is launched. For
this example, launch the Retro AS-1
Keyboard using the method
described in the previous section.
The synth engine “gr abs” the MIDI
input port (this default action can be
disabled) specified in the Retro AS-1
control panel.

Important! If multiple MIDI input hardware ports are installed in your
system, the input port you want Retro AS-1 to use is specified in the
Retro AS-1 control panel. The default selection is port ID #0.

4. Trigger sounds using the MIDI source.
Now you can “play” your computer like a MIDI sound module . You
can select different programs using MIDI program change commands
or the Keyboard, Editor, MIDI Processor, or Mixer applications. You
can modify programs in real-time while receiving MIDI from the
controller using the Editor if the MIDI Channel parameter on the
Editor global page matches the MIDI transmission channel. If you are
transmitting MIDI to the synthesizer on more than one channel, you
can use the Retro AS-1 Mixer to specify the synthesizer’s multi-
timbral settings.

Figure 3.2.3. In Windows 95
only, the Retro AS-1 window is

open whenever the synth engine
is active.  The “LEDs” indicate

incoming MIDI activity on each
of the 16 MIDI channels.
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3.3 Basic Editor Operations
The Retro AS-1 Editor is the main sound design application, where
synthesizer programs are created, modified, and saved. All voicing
parameters are contained within the program. Each program file is a
complete synthesizer “patch.”

This section explains how to open, audition, and edit voice documents.

NOTE: The primary function of the Editor is to create and modify
synthesizer program voicings. It does not need to be open to play
existing programs.

NOTE: Each Editor parameter and its function is explained in detail in
Chapter 7.

Editor Program File Overview
When the  Retro AS-1 Editor application is launched, a standard
document file window appears. This file contains all of the synthesizer
voicing parameters and is called a Retro AS-1 program. Each program
is a complete synthesizer "patch" that includes multiple oscillators,
filters, modulation routings, and effects. The program can be edited as
desired and saved as a file.

So, to audition or edit your favorite synthesizer voice, just open it
from disk using the standard open file dialog box. When you are finished
auditioning and/or modifying the voice, you may save it under the
same or different name or just close the file window without saving.

The Editor application and its program files can be thought of as similar
to a word processor, spreadsheet, or other application and its associated
document files. Multiple program windows can be open simultaneously;
the frontmost active window (the one with grey lines in the title bar)
is always the active program available for auditioning.

Opening and Saving Program Files

To Open Existing Programs from Disk:

1. Launch the Retro AS-1 Editor application.
With Mac OS, you can open the application in two ways: by choosing
Editor... from the Synthesizer menu within the Keyboard, MIDI
Processor, or Mixer applications, or by double-clicking the R etro AS-
1 MIDI Processor application icon. The Retro AS-1 Editor is located
at the root level of the Retro AS-1 Folder.
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With Windows 95, you can open the application in three ways: by
choosing MIDI Processor... from the Synthesizer menu within the
Keyboard, MIDI Processor, or Mixer applications; by double-clicking
the Retro AS-1 Editor application icon; or from Start
Menu>Programs>Retro AS-1>Retro AS-1 Editor. The application is
installed (by default) at the following location: Program Files/BitHeadz/
Retro AS-1/Retro AS-1 Editor.exe.

2. Open a program file.
Choose “Open...” from the File menu (make sure Retro AS-1 Editor
is the active application). Navigate to the Retro AS-1 Programs folder
at the root level of the Retro AS-1 Folder using the standar d open
file dialog box routines. Select the program file you want, then click
Open. The program appears in a window. At this point, the program
is active and ready to be auditioned and/or edited. Alternately, you
can double-click a program file to open it.

NOTE: Multiple program files can be open simultaneously; the
frontmost window is always the active program. If more than one
program file is open, you can switch between them using the
Window menu.

Figure 3.3.1. The main page, one
of four parameter pages in a

program file. All voicing
parameters are accessed using

the Editor.
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NOTE: Sounds can be triggered from within the Editor by pressing
the space bar. This option, and the note that is played, can be changed
in the Preferences window under the Edit menu.

To Create a New Program File:
1. Launch the Retro AS-1 Editor application.

If it isn’t open already, launch the Editor using the methods described
in the previous section.

2 Select New... from the File menu.
A new default program window appears. The program can now be
auditioned and/or edited as desired. The default program has very
basic settings but should always produce a sound output.

NOTE: A new default program is created every time the Editor is
launched. This factory default action can be disabled in the Editor
Preferences window, which is accessed from the Edit menu in the
Editor.

NOTE: The default program can be customized. See “Save as ‘New’
Template” in Chapter 7, section 7.2.1 for details.

To Save the Changes in a Program file:
1. Activate the program you want to save.

2. Choose Save from the File menu.
If you choose Save from the File menu, the original document will
be permanently overwritten and cannot be recovered. (F actory
programs can always be restored from the CD-ROM.) To save the
file without overwriting the original document, use the Save As...
command, described below.

To Save a Program with a New Name Leaving the
Original File Untouched:
1. Activate the program you want to save.
2. Choose Save As... from the File menu.

Save As... will write a new file to disk and change the name in the
title bar of the active file window. To overwrite the existing file
without creating a new file, use the Save command.
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3. Type a new name for the file.
If you are saving to a different location than the original file , you can
use the same name without overwriting the original file .

4. Select a location for the new file.
Navigate to the location of your choice using the standar d save dialog
box routines.

5. Click Save to write the file to disk.
If you select the same location as the original file and use the same
name, you will be ask ed if you want to replace the original file with
the new file.

Editing Programs

Editor Overview

Programs can be edited by altering parameters in the factory
sounds or by creating a new voice from scratch by selecting
New from the File menu.

There are four pages of parameters in a program: Main
(oscillators and filters), Modulation, Effects, and Global. Each
page contains a group of related parameters. Change pages by
selecting from the Page menu, or click the page tabs at the top
of the voice window.

All parameters in a program are always active and available for
editing. Experiment with changing parameter values to see what
affect they have on a sound. Studying the factory program
settings is a good way to learn how parameters interact to get a
particular sound.

Figure 3.3.2. Pages within an
Editor program can be selected

from the Page menu or by
clicking the page tabs within the

program window.
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It Ain’t Broke!

You may find that changing a parameter value does not affect the
sound. This can be a common occurrence, but it does not mean
something is wrong. A synthesizer is a complex device. Oscillators,
filters, and modulations can all affect each other, depending on signal
routings.

If the parameter you are changing belongs to a component that is not
active (for example, changing the frequency of an LFO that is not
assigned to a destination), the change will have no effect. Additionally,
a parameter may be under the control of another parameter. For
example, lowering the filter cutoff directly will have no effect if that
filter is already opened by a modulator such as an envelope.

NOTE: For related information, see Appendix E, Analog Synthesis
Demystified.

3.4 Basic MIDI Processor Operations

Overview
The Retro AS-1 MIDI Processor allows you to modify MIDI data in the
synthesizer engine. It is here that you can program layers, splits, and
arpeggiations. The MIDI Processor can be thought of as our own version
of the Multis or Combinations of other manufacturer’s hardware
keyboards. Each MIDI Processor document file can contain dozens of
layers, splits, and arpeggiations that we call “Setups”.

Once launched, the MIDI Processor remains active even when running
behind other applications, such as the Editor. For example, you can
edit your favorite programs in real time while playing an arpeggiation.
The MIDI Processor is most effectively used with a MIDI controller,
although the Retro AS-1 Keyboard and MIDI applications can be used
as well. Several setups were placed in the MIDI Processor Setups folder
at the root level of the Retro AS-1 Folder during installation. These
Setup files demonstrate the versatility and sonic power of Retro AS-1.

NOTE: Each MIDI Processor parameter and its function is explained
in detail in Chapter 6.
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To use the MIDI
Processor:
1. Launch the MIDI

Processor
application.
With Mac OS, you can
open the application in
two ways: by choosing
MIDI Pr ocessor... fr om
the Synthesizer menu
within the K eyboard,
Editor, or Mix er
applications , or by
double-cl icking the
Retro AS-1 MIDI
Processor application
icon. The R etro AS-1
MIDI Pr ocessor is
located at the root level
of the Retro AS-1 Folder.

With Windows 95, you can open the application in thr ee ways: by
choosing MIDI Pr ocessor... fr om the Synthesizer menu within the
Keyboard, Editor, or Mixer applications; by double-clicking the R etro
AS-1 MIDI Pr ocessor application icon; or from Start
Menu>Programs>Retro AS-1>Retro AS-1 MIDI Processor. The
application is installed (by default) at the following location: Program
Files/BitHeadz/Retro AS-1/Retro AS-1 MIDI Processor.exe.

2. Open a MIDI Processor Setup file.
Choose Open... from the MIDI Processor’s File menu. The factory
setups are located inside the MIDI Processor Setups folder, inside
the Retro AS-1 Folder. Alternately, you can double-click a Setup file
icon.

3. Audition the setups in the list while playing MIDI.
Each setup in the list represents a completely unique set of
parameters. Each setup may be a split, layer, arpeggiation, some
combination thereof, or just a cool program. Click a setup name
from the list to instantly make the setup values active. Feel free to
experiment by modifying the setups. All parameters can be modified
in real time.

Figure 3.4.1. The MIDI Processor
window. Each setup name in the

list on the left represents a
complete setup with unique

parameter values. Click the setup
name to make a setup active.
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NOTE: Sounds can be triggered from within the MIDI Processor by
pressing the space bar. This option, and the note that is played, can
be changed in the Preferences window under the Edit menu.

3.5 Parameter Editing Conventions
All of the Retro AS-1 components use a consistent interface design for
ease of use. The parameters of these components use a combination
of menu items, on/off switches, pull-down menus, and sliders to
manipulate the available settings.

• Parameter switches such as oscillator on/off buttons and filter input
checkboxes are changed by clicking on them once with the mouse.

• Pull-down menus such as waveform type are selected by click-hold-
dragging the menu item, then releasing the mouse on the desired
selection.

• Parameter slider values can be manipulated in four different ways
(figure 3.5.1):

1. Click, hold, and drag the horizontal slider bar.
2. Increment or decrement by a value of one by clicking at the top

or bottom of the slider.
3. Increment or decrement by a value of ten percent of the total

range by clicking on the vertical slider line, between the
horizontal slider bar and the end of the vertical slider range.

4. Option-click the slider value to call up a text entry box. Input a
number directly using the number keys on your computer
keyboard, then press Return or Enter.

Figure 3.5.1. Parameter Slider
“hot spots” for editing values

Option – click (Mac OS) or
double – click (Win95) here to
bring up a text entry box. Press
Return after entering a value.

Click the slider name to
increment by one.

Click above slider bar
to increment by ten

percent.

Click, hold, and
drag the slider bar.

Click below slider bar to
decrement by ten percent.

Click the slider value to
decrement by one.
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TO LEARN MORE ABOUT: REFER TO:

Using MIDI with Retro AS-1 Chapter Four

Retro AS-1 Control Panel Chapter Five

Retro AS-1 MIDI Processor Chapter Six

Retro AS-1 Editor Chapter Seven

Retro AS-1 Keyboard Chapter Eight

Retro AS-1 Mixer Chapter Nine

Banks & Programs Appendix A

Optimizing Performance Appendix B

Troubleshooting Appendix C

Audio Expansion Hardware Appendix D

Analog Synthesis Basics Appendix E

MIDI Implementation Appendix F

Record To Disk Appendix G

QuickTime™ Driver Appendix H

OMS Names Appendix I

Where to go from here
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Chapter 4. Working with MIDI
Chapter 4 contents
4.1 MIDI Overview
4.2 External MIDI input (Mac OS)
4.3 MIDI Software Integration (Mac OS)
4.4 Configuring the Retro AS-1 OMS Driver (Mac OS)
4.5 Configuring the Retro AS-1 FreeMIDI Driver (Mac OS)
4.6 External MIDI input (Windows)
4.7 MIDI Software Integration (Windows)
4.8 Configuring the Retro AS-1 Device Driver (Windows)

4.1 MIDI Overview
Retro AS-1 has powerful MIDI implementation. The synthesizer programs
can be accessed multi-timbrally via a multitude of MIDI sources, and all
voicing parameters are available for real-time editing via the MIDI protocol.
BitHeadz designed the program to allow for maximum flexibility in configuring
the system for professional use. There are a number of advanced parameters
that can be set to match your particular working style.

This chapter explains some MIDI concepts, using external MIDI controllers,
and using third-party MIDI applications with Retro AS-1. For details on
advanced MIDI implementation, see Appendix G.

MIDI can get into the Retro AS-1 synthesizer engine in three ways:

1. With the Retro AS-1 Keyboard application, our on-screen keyboard
utility. No MIDI controller or interface is required to use the Keyboard.
Chapter 8 describes the Keyboard functionality in detail.

2. With a MIDI controller or other external MIDI device (such as a
hardware sequencer) via the Serial Input, OMS Input, or FreeMIDI
Input applications (Mac OS) or a MIDI hardware input port (Windows).

3. With a MIDI application running on the same CPU as Retro AS-1 via
the Retro AS-1 MIDI Drivers (Retro AS-1 FreeMIDI Driver and Retro
AS-1 OMS Driver for Mac OS, or Retro AS-1 device driver for
Windows). When using MIDI applications such as a sequencer, it is
up to those applications to get the MIDI input. Their “Play Through”
function then passes MIDI to the Retro AS-1 MIDI driver. (In the Mac
OS, when a MIDI sequencer is used in conjunction with a Retro AS-1
MIDI driver, the Serial Input, OMS Input, or FreeMIDI Input
applications are NOT used.)
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Once MIDI data is received by the synthesizer engine, additional MIDI
processing can take place using the Retro AS-1 MIDI Processor
application. The MIDI Processor can be thought of as an insert effect
or plug-in to the synth engine. It creates layers, splits, and arpeggiations
of the MIDI data. This processing only takes place if the Retro AS-1
MIDI processor is launched, and processing continues even if the
application is in the background. See Chapter 6 for MIDI Processor
details.

4.1.1  Key MIDI Concepts
1. MIDI data processed by the MIDI Processor is not transmitted to
anything except the synthesizer engine. MIDI output from the Processor
and the synthesizer engine is not available to MIDI applications or the
MIDI out port(s).

2. The MIDI Processor only receives data from the Retro AS-1
synthesizer engine. The Processor will not run “stand-alone” without
the synth engine.

3. The Retro AS-1 Applications do not transmit to MIDI applications
or the MIDI out port(s).

4. The Retro AS-1 Keyboard and Editor do not receive MIDI data.

5. In Mac OS, the MIDI Input utilities should not be used when OMS
or FreeMIDI applications are active. Double note triggers may result.

6. In Windows 95, the first MIDI application launched takes control of
the MIDI input port(s). For this reason, it is important to pay attention
to the launch order of any application that uses MIDI input. You can
stop Retro AS-1 from “grabbing” MIDI input port(s) using the Retro
AS-1 control panel I/O setting.

7. The synth engine is launched whenever an MIDI application is
launched if the application uses OMS or FreeMIDI (Mac OS) or the
Retro AS-1 device driver (Windows) if those MIDI drivers are installed
and configured.

7. In Mac OS, OMS or FreeMIDI must be used for MIDI input on systems
that do not support Serial DMA.
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4.2 External MIDI input (Mac OS)

4.2.1 MIDI Flow within Retro AS-1
In order to properly use Retro AS-1 with your MIDI system, it is
important to understand the flow of MIDI data within Retro AS-1. The
diagram below illustrates how MIDI is routed between the various
Retro AS-1 components.

Using Retro AS-1 “stand-alone” with an external MIDI source (such as
a MIDI controller or external sequencer) is the simplest way to use
MIDI within Retro AS-1. In this scenario, OMS and FreeMIDI can be
bypassed altogether by using the Retro AS-1 Serial Input utility
application (see section 4.2.2).

If OMS or FreeMIDI is installed, you have the option to get MIDI to the
synth engine without launching your MIDI application by using the
Retro AS-1 OMS Input or Retro AS-1 FreeMIDI Input applications. The
only purpose of these utilities is to get MIDI from the serial ports to
the synthesizer engine when OMS or FreeMIDI applications (such as
sequencers) are NOT open.

Figure 4.2.1. Mac OS MIDI flow
with Retro AS-1.
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Figure 4.2.1. The Serial Input
application window. The “LEDs”
indicate incoming MIDI activity

on each of the 16 MIDI channels.

Any of the Retro AS-1 Serial/OMS/FreeMIDI Input applications can be
opened automatically whenever the Editor, MIDI Processor, or Mixer
applications are launched. The MIDI Input utility launched (if any) is
specified by the Default MIDI Input menu within the Retro AS-1 Control
Panel (see Chapter 5, section 5.5).

When using external MIDI input on multiple channels, the Retro AS-1
Mixer application is useful for setting up and saving multi-timbral
configurations. See Chapter 9 for more information about the Retro
AS-1 Mixer.

4.2.2 Using Retro AS-1 Serial Input
The Retro AS-1
Serial Input
application is used
any time you want
to use Retro AS-1 as
a sound module
without using OMS
or FreeMIDI. Such
situations include playing the synthesizer “live” with a MIDI controller,
using a hardware (external) sequencer, or running MIDI applications
on a separate computer. The Serial Input configuration is recommended
for voice programming and live performance because it delivers the
best note-on to sound-out response time and it maximizes available
polyphony by eliminating the CPU processing required to run OMS
and FreeMIDI.

Retro AS-1 Serial Input is launched automatically by default when the
Editor, MIDI Processor, or Mixer application is launched. Full
instructions for launching and configuring Retro AS-1 Serial Input are
detailed in section 3.2 of Chapter 3.

If a port selected for MIDI is in use by another application such as
AppleTalk, fax or modem software, or OMS/FreeMIDI, Serial Input
will display “Port is in use by another application.” If you get this
message, quit the application(s) that are using the port or use a different
port for the MIDI interface.

IMPORTANT: If you are using the Printer port for MIDI connections,
AppleTalk must be unloaded while using MIDI. To unload AppleTalk,
make it Inactive in the Chooser utility, which is accessed from the
Apple Menu, then reboot.
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Figure 4.2.2. The No Serial DMA
Hardware warning. Retro AS-1

Serial Input cannot be used when
this dialog appears. Retro AS-1
OMS/FreeMIDI Input must be

used instead.

These are the software
components of Serial DMA. They

must be installed in the
Extensions folder on hardware

systems that support Serial DMA.

When Retro AS-1 Serial Input is opened, the synth engine is started
and you can “play” your computer like a MIDI sound module. No
other Retro AS-1 applications need to be launched. You can select
different programs using the MIDI program change commands or
the Keyboard, Editor, MIDI Processor, or Mixer applications. You
can modify programs in real-time while receiving MIDI from the
controller using the Editor if the MIDI Channel parameter on the Editor
global page matches the MIDI transmission channel. If you are
transmitting MIDI to the synthesizer on more than one channel, you
can use the Retro AS-1 Mixer to specify the synthesizer’s multi-timbral
settings.

The Serial Input utility requires a Macintosh hardware component
called the Serial DMA which is built into most PowerMacs. Serial Input
displays an error message (figure 4.2.2) on Macintosh models that do
not have the Serial DMA component. Unfortunately, a list containing
such systems does not exist. In this case, the OMS or FreeMIDI operating
systems must be used to get MIDI into Retro AS-1. Make sure the
Serial DMA software component extensions are installed before
concluding your machine does not support Serial DMA!

To use external MIDI input with Retro AS-1 on systems without Serial
DMA hardware, either OMS or FreeMIDI must be installed. Then the
Retro AS-1 OMS Input or Retro AS-1 FreeMIDI Input utility is used get
MIDI data from OMS or FreeMIDI and pass the MIDI data to the
synthesizer engine. If you don’t have any OMS or FreeMIDI applications
(which usually install these MIDI operating systems), the OMS
and FreeMIDI installers are provided for your convenience in the CD
Extras folder on the Retro AS-1 CD-ROM.

4.2.3 Using Retro AS-1 OMS Input and Retro AS-1
FreeMIDI Input

IMPORTANT: The Retro AS-1 OMS and FreeMIDI Input applications
cannot be used until the Retro AS-1 OMS Driver or Retro AS-1
FreeMIDI Driver is configured using the instructions in section 4.3 of
this chapter.

If OMS or FreeMIDI is installed, you can get MIDI to the synth engine
without launching your MIDI application by using the Retro AS-1 OMS
Input or Retro AS-1 FreeMIDI Input applications in conjunction with
the Retro AS-1 OMS Driver and Retro AS-1 FreeMIDI Driver. The only
purpose of these utilities is to get MIDI from the serial ports to the
synthesizer engine when OMS or FreeMIDI applications such as
sequencers are NOT open.
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Figure 4.2.3. The
Retro AS-1 OMS
Input window

Figure 4.2.4. The
Retro AS-1 FreeMIDI

Input window.

Figure 4.2.5. The Port menu in
Retro AS-1 OMS & FreeMIDI
Input applications. The MIDI

controllers displayed in the Port
menu reflect the configuration of

the current OMS or FreeMIDI
setup.

On systems that don’t support Serial DMA, Retro AS-1 OMS Input or
Retro AS-1 FreeMIDI Input must be used to get MIDI into the synth
engine when OMS or FreeMIDI applications are not active. If an OMS
or FreeMIDI application is active, the Retro AS-1 Serial/OMS/FreeMIDI
Input should NOT be used, or double note triggers will result. When
an OMS or FreeMIDI application is active, it is up to that application’s
“Play Through” function to pass MIDI to the synth engine via the
Retro AS-1 OMS or FreeMIDI Driver.

Retro AS-1 OMS and FreeMIDI Inputs are functionally identical to Retro
AS-1 Serial Input. The only difference is in the Port menu. Instead of
selecting Modem or Printer ports, the items displayed in the Port menu
reflect the controllers in the current OMS or FreeMIDI configuration.

The item selected in the Port menu (indicated by a check mark) is the
controller that will transmit MIDI to the synth engine.

4.3 MIDI Software Integration (Mac OS)
This section is dedicated to users of OMS and FreeMIDI that wish to
integrate Retro AS-1 into existing MIDI environments for use with
sequencers and other MIDI applications running on the same CPU. If
you do not use OMS or FreeMIDI, you can skip the rest of this chapter
entirely.

4.3.1 OMS and FreeMIDI Overview
These MIDI systems are third-party software packages that operate at
the system level to convert data at the serial port(s) into usable MIDI
information and transfer that data between various MIDI applications
such as Retro AS-1, MIDI sequencers, and other MIDI applications.
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OMS™ (“Open Music System”) from Opcode Systems in Palo Alto, CA,
and FreeMIDI™ from Mark Of The Unicorn in Cambridge, MA, are the
two main MIDI systems. They are used by popular MIDI applications
such as the Vision™ and Performer™ sequencers. Using OMS and
FreeMIDI, various MIDI applications (such as sequencers and keyboard
editor/librarians) can communicate with each other by sharing MIDI
data.

MIDI software application developers typically provide OMS and/or
FreeMIDI “drivers” to allow their MIDI product to communicate with
other MIDI software products. OMS and FreeMIDI do all the MIDI
routing and processing, while the drivers provide software inputs and
outputs for the MIDI operating system.

Retro AS-1 can communicate with OMS and FreeMIDI using our
supplied OMS and FreeMIDI drivers. After configuring our drivers,
your OMS- or FreeMIDI-compatible application can transmit MIDI data
to Retro AS-1 without hardware routing. These drivers cause OMS and
FreeMIDI to recognize Retro AS-1 as another “sound module” in the
MIDI environment defined from within the OMS and FreeMIDI setup
applications.

After OMS and FreeMIDI are configured to recognize Retro AS-1 as
another module, the MIDI application that uses OMS or FreeMIDI can
be configured to use Retro AS-1 as a destination for MIDI data. The
individual MIDI application tracks can then be assigned to various
Retro AS-1 “instruments” (MIDI channels). Once the MIDI application
is transmitting MIDI data to Retro AS-1 on one or more MIDI channels,
MIDI commands and/or the Retro AS-1 Mixer are used to define the
settings (program selection, volume, pan, mute, solo, and global effects)
for multi-timbral operation.

4.4 Configuring the OMS Driver
If you are using an OMS-compatible MIDI application, you probably
have already installed and configured OMS for use in your MIDI
environment. This section does not describe how to install and
configure OMS; it only explains how to add and configure our driver
for use with OMS. Consult the documentation that came with your
OMS software for general OMS instructions.

OMS only needs to be configured when your MIDI environment
changes. You will only have to follow the steps in this section once to
use OMS with Retro AS-1.
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IMPORTANT!  OMS must be already installed and configured before
proceeding with the Retro AS-1 OMS Driver configuration.

The Retro AS-1 OMS Driver was placed inside the OMS Folder (located
at the root level of the active System Folder) by the Retro AS-1 Installer.
If OMS was not already installed, the folder was created for you. If
you never use OMS you can delete the OMS Folder without harm.

NOTE: As of this writing, the latest version of OMS is 2.3.4. We
recommend updating to the latest version of OMS for maximum
performance and stability.

To configure OMS to recognize the Retro AS-1 OMS Driver:

1. Launch the OMS Setup application.
The OMS Setup application is the component of OMS used to define
the MIDI hardware setup. It is located inside the OMS Applications
folder, installed at the user defined location during OMS installation.

2. Execute the Update Setup routine.
The Update Setup command is found under
the Interfaces menu item in OMS Setup
versions below 2.0, and under the MIDI
Cards & Interfaces menu item in versions 2.0
and up.  See figure 4.1.1.

IMPORTANT! OMS will not recognize Retro
AS-1 until after the Update Setup command
is run within the OMS Setup application.

3. Verify the configuration.
When the setup is properly configured, the
Retro AS-1 Driver icon is visible in the setup
window. There will be no connections to the
MIDI interface. If you use the “Test Studio”
function from the Studio menu, you should
hear Retro AS-1 sound output. See figure
4.4.2.

Figure 4.4.1. The Update Setup
dialog within the OMS Setup

application.
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Figure 4.4.2. The Retro AS-1 OMS
Driver properly installed,

configured, and recognized by
OMS. Your interface and

controller settings may vary from
those shown here. The

QuickTime Music Driver is NOT
required.

4. Quit the OMS Setup application.
OMS is now configured for use with
Retro AS-1. You won’t have to use the
OMS Setup application again unless your
MIDI environment changes.

NOTE: Please refer all technical questions
regarding OMS (not related to Retro AS-
1) to the technical support department
of Opcode Systems at (650) 856-3331.

5. Configure the OMS-compatible
MIDI application to recognize the
new device.
This step will vary depending upon
which particular MIDI software you are
using to control Retro AS-1. The command found within the OMS-
compatible application will probably be called Instruments, MIDI
Devices, or something similar. See the next section for specific
instructions.

NOTE: Please refer all technical questions regarding your MIDI
application that are not directly related to Retro AS-1 to the
manufacturer’s technical support department.

4.4.1 Configuring OMS MIDI applications

How to setup Opcode Vision/StudioVision
1. Select Instruments from the Windows menu.

The MIDI Instruments window appears, showing the currently
available output devices.

2. In the MIDI Instruments window, click and hold the small
disclosure triangle in the MIDI Instrument window title bar.

The MIDI Instruments sub-menu appears. See figure 4.4.3.

3. Select Make from Studio Setup... from the MIDI Instruments
sub-menu.
This action will automatically create a new instrument from each
device in your current OMS Studio Setup. You can optionally select
New Instrument to add devices one at a time. See figure 4.4.4. After
issuing the command, individual Instrument outputs may be re-
assigned if desired.
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4. Close the Instruments window.
Vision/StudioVision is now able to select Retro AS-1 on any of the
16 MIDI channels as a track destination or MIDI “Play Thru” channel.

How to setup Steinberg Cubase
There is only one step: Choose your Output! Cubase always displays
all OMS Devices.

Figure 4.4.3. The MIDI
Instruments sub-menu within

Vision/StudioVision.

Figure 4.4.4. The Make from
Studio Setup command

automatically creates output
devices based on the current

OMS Studio Setup.
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4.4.2 Setting up MIDI Clock Sync via OMS
Retro AS-1 version 1.10 and higher allows synchronization of LFO’s,
effect delay times, and the arpeggiator to MIDI beat clock. This section
describes how to configure OMS MIDI applications to send MIDI clock
to Retro AS-1.

NOTE: Time changes in Retro AS-1 will occur if the tempo changes
more than 5% of the  previous tempo.  This 5% “buffer” protects
against the constant changes of MIDI Sync inaccuracies that typically
shift +/- 3%.

Vision/StudioVision Sync Setup
1. Install the OMS IAC Driver.

To transmit MIDI clock commands to Retro AS-1, Vision requires
the IAC (Inter-Application Communications) Driver to be in the OMS
Folder. The OMS IAC Driver MUST be installed using the OMS
installer Custom Install option; it is not installed using Easy Install. The
OMS Installer is located on the Retro AS-1 CD-ROM in the CD Extras
folder.

Figure 4.4.5. The OMS IAC Driver
icon. This file must be installed

in the OMS Folder to use the
MIDI Sync features in Retro AS-1.

Figure 4.4.6. The OMS Installer
Custom Install window. The IAC
Driver is NOT installed during

Easy Install.
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2. Update the OMS Studio Setup to recognize the OMS IAC
Driver.

Follow the instructions in section 4.4 of this chapter.

3. From the main menu in Vision, select Options>Sync
Options.
The Vision Sync window appears.

4. Select Retro AS-1 as a destination for Beat Clock.
Make sure the box next to Retro AS-1 is checked and Beat Clock is
selected from the Send Sync pull-down menu, then click OK.

5. Done!
Retro AS-1 will now “chase” tempo changes sent to any activated
MIDI Sync component (LFO rate, delay times, arpeggiator).
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Cubase Sync Setup
1. From the main menu in Cubase, select

Options>Synchronization.
The Cubase Synchronization window appears.

2. Select Retro AS-1 for destination of MIDI Clock.
In the Sync Out portion of the Cubase Synchronization window,
select Retro AS-1 from the MIDI Clock pull-down menu, then click
OK.

3. Done!
Retro AS-1 will now “chase” tempo changes sent to any activated
MIDI Sync component (LFO rate, delay times, arpeggiator).
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4.5 Configuring the FreeMIDI Driver
If you are using an FreeMIDI-compatible MIDI application, you probably
have already installed and configured FreeMIDI for use in your MIDI
environment. This section does not describe how to install and
configure FreeMIDI; it only explains how to add and configure our
driver for use with FreeMIDI. Consult the documentation that came
with your FreeMIDI software for general FreeMIDI instructions.

FreeMIDI only needs to be configured when your MIDI environment
changes. You will only have to follow the steps below once to use
FreeMIDI with Retro AS-1.

IMPORTANT! FreeMIDI must be already installed and configured
before proceeding with the Retro AS-1 FreeMIDI Driver configuration.

The Retro AS-1 FreeMIDI Driver was placed inside the FreeMIDI Folder
(located at the root level of the active System Folder) by the Retro AS-
1 Installer. If FreeMIDI was not already installed, the folder was created
for you. If you never use FreeMIDI you can delete the FreeMIDI Folder
without harm.

NOTE: As of this writing, the latest version of FreeMIDI is 1.35. We
recommend updating to the latest version of FreeMIDI for maximum
performance and stability.

To configure FreeMIDI to recognize the Retro AS-1 FreeMIDI
Driver:

1. Launch the FreeMIDI Setup application.
The FreeMIDI Setup application is the component of FreeMIDI used
to define the MIDI hardware setup. It is located inside the FreeMIDI
Applications folder, installed at the user defined location during
FreeMIDI installation.

2. Execute the Update Interfaces routine.
The Update Interfaces command is found under the Configuration
menu item in the FreeMIDI Setup application. See figure 4.5.1.

IMPORTANT! FreeMIDI will not recognize Retro AS-1 until after the
Update Interfaces command is run within the FreeMIDI Setup
application.
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3. Verify the configuration.
When the setup is properly configured, the Retro AS-1 Driver icon
is visible in the setup window (see figure 4.5.2). There will be no
connections to the MIDI interface. The “Test Connections” menu
command within FreeMIDI will not trigger Retro AS-1 sounds because
FreeMIDI does not support AppleEvents, which our driver requires
to establish contact with the synthesizer.

Figure 4.5.2. The Retro AS-1
FreeMIDI Driver properly
installed, configured, and

recognized by FreeMIDI. Your
interface and controller settings

may vary from those shown here.

Figure 4.5.1. The
Update Interfaces
dialog within the
FreeMIDI Setup

application.
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If you still do not see the Retro AS-1 FreeMIDI Driver in the FreeMIDI
configuration window as shown above, open the FreeMIDI Preferences
window by selecting FreeMIDI Preferences... from the File menu within
the FreeMIDI Setup application. Check the Retro AS-1 Driver Input
Port checkbox as shown below, then click OK and save the
configuration. See Figure 4.5.3.

4. Quit the FreeMIDI Setup application.
FreeMIDI is now configured for use with Retro AS-1. You won’t have
to use the FreeMIDI Setup application again unless your MIDI
environment changes.

NOTE: Please refer all technical questions regarding FreeMIDI (not
related to Retro AS-1) to the technical support department of Mark
Of The Unicorn at (617) 576-3066.

Figure 4.5.3. Make sure the
Retro AS-1 Driver Input Port is
checked in the FreeMIDI Setup

Preferences window.
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5. Configure the FreeMIDI-compatible MIDI application to
recognize the new device.
This step will vary depending upon which particular MIDI software
you are using to control Retro AS-1. The command found within the
FreeMIDI-compatible application will probably be called Instruments,
MIDI Devices, or something similar.

NOTE: Please refer all technical questions regarding your MIDI
application that are not directly related to Retro AS-1 to the
manufacturer’s technical support department.

Your FreeMIDI application should now be able to select Retro AS-1 on
any of the 16 MIDI channels as a destination or MIDI “Play Through”
channel.
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4.6 External MIDI input (Windows)

4.6.1 MIDI Flow within Retro AS-1 and Windows 95
In order to properly use Retro AS-1 with your MIDI system, it is important
to understand the flow of MIDI data within Retro AS-1. The diagram
below illustrates how MIDI is routed between the various Retro AS-1
components.

4.6.2 Retro AS-1 Without 3rd-Party MIDI Applications
Using Retro AS-1 “stand-alone” without third-party MIDI applications is
the simplest way to use Retro AS-1. Using the Retro AS-1 Keyboard, you
can trigger sounds without a MIDI input port and MIDI controller.

Using a MIDI input port, Retro AS-1 can be played with external MIDI
control just like any other MIDI sound module. Such situations include
playing the synthesizer “live” with a MIDI controller, or using any external
MIDI source.

In this scenario, whenever the Retro AS-1 Keyboard, Editor, MIDI
Processor, or Mixer application is launched, the Retro AS-1 engine “grabs”
the default MIDI input port if “Use Direct MIDI Input” is selected in the
Retro AS-1 control panel.

Figure 4.6.1.
Windows MIDI flow

with Retro AS-1.



C
hapter 4

: W
orking w

ith M
ID

I

Retro AS-1 Manual

68

4.6.3 The MIDI Input Port
MIDI input port(s) in Windows 95 are created when MIDI input
hardware such as a joystick port on a sound card or an MPU-401 card
is installed.

When the MIDI input port is in use by Retro AS-1, it cannot be utilized
by any other MIDI application. If a port selected for MIDI in the Retro
AS-1 control panel is in use by another application when Retro AS-1 is
launched, Retro AS-1 will display “The selected MIDI port is in use by
another application.” If you get this message, quit the application(s)
that are using the port or select a different MIDI port in the Retro AS-
1 control panel.

4.6.4 Stand-Alone Operation
To use Retro AS-1 with an external MIDI controller, the MIDI input
port needs to be activated by starting the synthesizer engine. The synth
engine is started by launching the Keyboard, Editor, MIDI Processor,
or Mixer application.

To simply play the synthesizer with a MIDI controller, we recommend
using the Retro AS-1 Keyboard application to start the engine and
activate the MIDI input port. The Retro AS-1 Keyboard has very low
RAM and CPU requirements and it allows you to access all the Retro
AS-1 banks and programs (sounds) with pull-down menus.

Once the synth engine is activated, you can “play” your computer like
a MIDI sound module. You can select different programs using MIDI
program change commands or the Keyboard, Editor, MIDI Processor,
or Mixer applications. You can modify programs in real-time while
receiving MIDI from the controller using the Editor if the MIDI Channel
parameter on the Editor global page matches the MIDI transmission
channel.

When using external MIDI input on multiple channels, the Retro AS-1
Mixer application is useful for setting up and saving multi-timbral
configurations. See Chapter 9 for more information about the Retro
AS-1 Mixer.
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4.7 MIDI Software Integration (Windows)
This section is for users that wish to integrate Retro AS-1 into existing MIDI
environments for use with other MIDI applications running on the same CPU. If
you do not use third-party MIDI applications, you can skip the rest of this chapter
entirely.

Configuring Retro AS-1 for use with third-party MIDI applications (such as a
sequencer) can vary in complexity, depending on your experience, the MIDI
application(s), your existing MIDI environment, and other variables. You will
need to have a basic understanding about device drivers and the Windows MIDI
Mapper.

4.7.1 Device Driver
Retro AS-1 is designed to behave as “virtual hardware” in the Windows 95
environment. We provide a 16-bit device driver for our software “MIDI module”
that the Windows 95 MIDI Mapper and/or third-party MIDI applications can use
as a multi-timbral destination for transmitting MIDI information to the Retro AS-
1 synthesizer engine. This is a unique situation within Windows 95 because
device drivers are usually used for hardware purposes only.

When the third-party MIDI application is launched, the MIDI input port is
“grabbed” by the MIDI application and cannot be used directly by the Retro AS-
1 applications. However, the third-party MIDI application “MIDI thru” function
allows you to play Retro AS-1 “live” with the MIDI input port even though it is
in use by another application.

4.7.2 Multimedia Control Panel
The default MIDI device many Windows 95 MIDI applications use for MIDI
output is specified by the Windows MIDI Mapper, accessed in the Multimedia
control panel. The MIDI Mapper allows you to select the default MIDI device for
all 16 MIDI channels, or you can map individual MIDI channels to separate
MIDI devices. Many advanced MIDI applications have their own MIDI Mapper
settings for specifying MIDI output to device drivers. If an application uses their
own maps, the Windows MIDI Mapper is not used and will have no effect.

After the Windows MIDI Mapper is configured to recognize Retro AS-1 as the
default MIDI module, any MIDI application that uses the Windows MIDI Mapper
(such as MediaPlayer) will use Retro AS-1 as a destination for MIDI data. The
individual MIDI application tracks can be assigned to various Retro AS-1
“instruments” (MIDI channels). Once the MIDI application is transmitting MIDI
data to Retro AS-1 on one or more MIDI channels, MIDI commands and/or the
Retro AS-1 Mixer are used to define the settings (program selection, volume,
pan, mute, solo, and global effects) for multi-timbral operation.
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4.8 Configuring the Retro AS-1 Device
Driver (Windows)
4.8.1 Configuring the Windows MIDI Mapper to use Retro AS-1
as the default MIDI device

This setup will cause Retro AS-1 to respond to
all 16 MIDI channels.

1. Open the Multimedia control panel.
The Multimedia control panel can be
accessed from the Start Menu
(Start>Settings>Control Panel). The
Multimedia Properties window is displayed.

2. Click the MIDI tab.
This is where you will specify the MIDI
output device.

3. Click the Single Instrument radio button.
All MIDI data will be output to the selected
Single Instrument device.

4. Select Retro AS-1 as the MIDI output
destination.
In the Single
Instrument area,
there is a list of MIDI
device drivers that
are installed in
Windows 95. Scroll
the list until you see
Retro AS-1, then
click Retro AS-1 so it
becomes highlighted.
See figure 4.7.2.

5. Click Apply then
OK to close the
control panel.
Done! Now any
MIDI application that
uses the Windows
MIDI Mapper will
play Retro AS-1 as
the default output device.

Figure 4.8.1. The Multimedia
control panel applet. Double-

click the icon to open the
Multimedia Properties window.

Figure 4.8.2. The Windows MIDI Mapper configured
to use Retro AS-1 on all 16 MIDI channels.



C
hapter 4

: W
orking w

ith M
ID

I

Retro AS-1 Manual

71

4.8.2 Configuring the Windows MIDI Mapper to use
Retro AS-1 as one of several MIDI devices
This setup will enable
multiple MIDI devices to
respond, each on its own
particular MIDI
channel(s). You need to
decide which MIDI
channel(s) you want
Retro AS-1 to respond to.

1. Open the
Multimedia
control panel.
The Multimedia
control panel can be
accessed from the
Start Menu
(Start>Settings>Control
Panel). The
M u l t i m e d i a
Properties window is
displayed.

2. Click the MIDI tab.
This is where you will
select the MIDI
output device.

3. Click the Custom configuration radio button.
We will be creating a new custom MIDI Scheme (map).

4. Click the Configure button.
The MIDI Configuration window appears. In the default configuration,
no MIDI channels are assigned to MIDI devices.

Figure 4.8.3. Selecting Custom
configuration in the Windows

MIDI Mapper. Click Configure...
to open the MIDI Configuration

window.
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5. Click Channel 1 to select it then click the Change... button.
The Change MIDI Instrument window appears.

6. Select the desired MIDI output device for Channel 1 from
the Instrument pull-down menu then click OK.
The pull-down menu contains the list of MIDI device drivers that are
installed in Windows 95. The MIDI output device you choose will
receive the MIDI data transmitted by MIDI applications on MIDI
channel 1.

Figure 4.8.4. The default MIDI
Configuration window. Custom

MIDI Schemes (maps) are
created here.

Figure 4.8.5. The Change MIDI
Instrument window, where a
different MIDI device can be

specified for each MIDI channel.
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7. Repeat steps 5 and 6 for each of the 16 MIDI channels.

8. Save the MIDI Scheme with a unique name.
Click the Save As... button in the Schemes area to save the
configuration. Enter a unique name in the Save MIDI Scheme As
dialog box.

9. Click Apply then OK to close the control panel.
Your custom configuration is now complete. You can create multiple
custom configurations for use in different MIDI situations.

Figure 4.8.7. Saving the custom
MIDI Scheme with a new name.

Figure 4.8.6. A custom MIDI
Scheme with all channels

configured.

Figure 4.8.8. The newly
customized MIDI Scheme is
selected and ready for use.
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4.8.3 Real-World Examples

Configuring Retro AS-1 for use within Cakewalk

This example shows how to setup Cakewalk, a MIDI sequencer, to
allow use of Retro AS-1 as a MIDI destination.

1. Verify correct installation of Retro AS-1 before launching
Cakewalk.
You should be able to hear the synthesizer using the Retro AS-1
Keyboard application and with MIDI input. Close all Retro AS-1
components before proceeding.

2. Launch the Cakewalk application.
The Track window appears.

3. Select MIDI Devices... from the Cakewalk Tools menu.
The MIDI Ports window appears. A list of installed device drivers is
shown in the Output Ports list.

4. Click Retro AS-1 in the Output Ports list to select it.
Retro AS-1 and all the other MIDI output devices you want to use
should be highlighted.

Figure 4.8.9. The Cakewalk MIDI
Ports window. Make sure Retro

AS-1 is highlighted.
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5. Click OK to close the MIDI Ports window.
This action initializes the Retro AS-1 device driver. The Retro AS-1
status window will open, indicating the synthesizer engine is active.

6. In the Cakewalk Track window, double-click the Port for a
track.
The Track Properties window appears. See figure 4.8.12.

7. In the Track Properties window, select Retro AS-1 from the
Port pull-down menu.
This action causes Retro AS-1 to be used as a MIDI destination for
the track. See figure 4.8.12.

8. In the Track Properties window, select the desired MIDI
channel for the track from the Channel pull-down menu.
This action selects the MIDI channel Retro AS-1 will respond to for
the track. See figure 4.8.12.

Figure 4.8.10. The Retro AS-1
Status window. The synth
engine is active when this

window is open.

Figure 4.8.11. Double-click the
Port for a track to open the Track

Properties window.
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9. Click OK to close the Track Properties window.
Retro AS-1 now appears as the destination device for the track port.

At this point, if MIDI is shown as the source for the track (this is the
“MIDI Thru” function), you can play Retro AS-1 “live” with your MIDI
controller.

Figure 4.8.12. The
Cakewalk Track Properties
window. Make sure Retro
AS-1 is selected from the

Port menu.
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Configuring Retro AS-1 for use within Cubase

This example shows how to setup Cubase, a MIDI sequencer, to allow use
of Retro AS-1 as a MIDI destination.

1. Verify correct installation of Retro AS-1 before launching
Cubase.
You should be able to hear the synthesizer using the Retro AS-1 Keyboard
application and with MIDI input. Close all Retro AS-1 components before
proceeding.

2. Launch the Cubase application.
The default Arrange window appears.

3. Click and hold the Output field in the Arrange window.
A list of installed device drivers is shown in the Output list.

4. Click Retro AS-1 in the Output list to select it.
The track is now configured to use Retro AS-1 for output. Done!

At this point, you can play Retro AS-1 “live” with your MIDI controller.
You can select a different MIDI channel for the track by double-clicking
the “Chn” column for the track.

Figure 4.8.13. Selecting Retro
AS-1 as a MIDI destination

from the Cubase Output
column menu.
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4.8.4. Using Retro AS-1 With Third-Party Audio Se-
quencers
An “audio sequencer” is a hybrid MIDI/digital audio application. It
records and plays back digital audio files as well as MIDI data.

4.8.5. Audio Sequencers and DirectSound
Sound cards require a “wave driver” to pass digital audio from an
application to the sound card outputs. Most audio sequencer packages
include their own proprietary wave driver to pass digital audio to the
sound card.

DirectSound, which is utilized (and required) by Retro AS-1, also uses
a wave driver to pass digital audio to the sound card. However, most
sound cards do not support multiple clients. In other words, only one
wave driver connection can be active at any given time.

In order for Retro AS-1 to run concurrently alongside an audio sequencer
using the same sound card, the audio sequencer must use DirectSound,
or the sound card must support multiple clients. Unfortunately, both
of these scenarios are uncommon.

In order to use Retro AS-1 and an audio sequencer concurrently using
the same sound card, you may need to disable the digital audio features
of the audio sequencer and instead use MIDI only. Another alternative
is to install another sound card.
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Chapter 5 Contents
5.1 Control Panel Overview
5.2 Configuration Settings
5.3 Controller Settings
5.4 Global Effects Settings
5.5 Input/Output Settings
5.6 Miscellaneous Settings

5.1 Control Panel Over-
view
The Retro AS-1 control panel is where
system-wide configuration parameters are
modified and stored. It was placed into the
Control Panels folder by the Retro AS-1
Installer.

5.1.1 System Performance
Depending upon the speed of your
computer, your polyphony and sound
quality requirements, and other MIDI
applications that are running, the
synthesizer system parameters will
probably need to be “tweaked” to optimize
performance. The Configuration
parameters are the settings that will affect
Retro AS-1 performance and sound quality.

Because Retro AS-1 uses the computer’s
CPU to handle all of its tasks, it is possible
to overload the CPU, especially on slower
systems. The main cause of CPU overload
occurs when too many notes are played.
When the CPU is overloaded, sound output
will stutter or cut out altogether.

Chapter 5. Control Panel Reference

Figure 5.1.1. The Retro AS-1
control panel window (Mac OS).



C
hapter 5: C

ontrol Panel Reference

Retro AS-1 Manual

80

To eliminate this problem the Number of Voices, Maximum CPU %,
Sample Rate, and Buffer Length settings must be optimized for use
with your particular environment. These
settings are all interdependent and
experimentation is sometimes required to
find the “sweet spot” that works best in your
environment.

5.1.2 Key Control Panel Concepts
1. Setting changes are not activated until the
control panel is closed and the synthesizer
is relaunched. Relaunching the synth means
ALL Retro AS-1 components (including MIDI
applications using the Retro AS-1 MIDI
drivers) must be quit.

2. Configuration parameters should be
experimented with to get the best
performance from your particular computing
environment.

3. Generally speaking, lowering the
Polyphony setting is the simplest way to
avoid overloading the CPU while maintaining
fidelity.

4. Global Effects behavior is determined in
the control panel.

5. Changing the Sample Rate and Buffer
Length settings may affect the sound of a
program. For best results, voice your
programs with the settings you intend to use
them with.

IMPORTANT! Whenever control panel
settings are modified, Retro AS-1 must be
restarted in order for the changes to take
effect. To restart Retro AS-1, quit all Retro
AS-1 components (Editor, Keyboard, MIDI
Processor, Mixer, Serial/OMS/FreeMIDI
Input, MIDI drivers). New settings will take
affect the next time one of these
components is launched.

Figure 5.1.2. The Retro AS-1
control panel window

(Windows 95).
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5.2 Configuration settings
Number Of Voices

This parameter sets the maximum polyphony
(simultaneous voices) that Retro AS-1 will reproduce. The
range is from 1 to 32 voices. The default value is 8.

A larger Number Of Voices value generally requires a higher Maximum
CPU % and/or Buffer Length setting to compensate for the increased
CPU demands of additional polyphony. If the synthesizer “chokes”
(stutters or cuts out), enter a smaller Number Of Voices value and/or
change the other configuration settings.

Note: Polyphony can be limited on a per-program basis with the
Maximum Voices setting in the Editor Global page.

Maximum CPU %

This parameter sets the amount of CPU processing horsepower reserved
by the synthesizer engine. The range is from 10% to 60%. When using
Direct IO for output (Mac OS only), the range is from 10% to 40%.
The default value is 40%.

If the synthesizer “chokes” (stutters or cuts out), enter a larger
Maximum CPU % value and/or change the other configuration settings.
If you experience problems with other MIDI applications (such as
sluggish screen response or poor timing) decrease the CPU percentage.
If you are using Retro AS-1 by itself (for example, using the synthesizer
“live” as a musical instrument) you can crank this setting up without
negative effects.

The reserved CPU is relinquished to other applications whenever the
synth engine is not active (that is, when all components are quit).

Sample Rate

This parameter determines the sample rate of the synthesizer output.
The value is expressed in Hertz; the range is from 8000Hz to 48000Hz.
The default value is 44100.

A higher setting results in better upper frequency response, fidelity,
and voicing parameter resolution, but requires additional CPU
processing. A lower value requires less CPU processing and allows
more polyphony for the same CPU percentage. If the synthesizer
“chokes” (stutters or cuts out), enter a smaller Sample Rate value
and/or change the other configuration settings.

Figure 5.2.1. The Configuration
parameters. These are the

settings that affect performance
and fidelity.
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IMPORTANT! The Sample Rate setting affects not only the frequency
response, but also the resolution of the voicing parameters. Changing
the Sample Rate setting can affect the sound of a program. For best
results, voice your programs with the same sample rate setting that
you intend to use them with.

Many “vintage-style” synth voices do not require the sparkly-crisp
high end response we have become accustomed to in this digital era.
A Sample Rate setting of 22050 or even lower may be acceptable (or
even desirable) in many scenarios, including live performance and
“lo-fi” recordings.

IMPORTANT (Mac OS only)! This number should match the Sound
Manager sample rate setting for optimum system performance. If
the numbers don’t match, the Sound Manager must perform a
sample rate conversion which requires additional CPU processing
and may decrease available polyphony.

Buffer Length

This parameter determines how often data is passed from the
synthesizer to the Sound Manager (Mac OS) or DirectSound (Windows
95). The values are expressed in samples; the range is from 32 to 1024.
The default value is 64.

A lower value delivers higher voicing parameter resolution and faster
note-on response time but requires more CPU processing. A higher
value allows more polyphony for the same CPU percentage, but the
sound quality may be “grainier” and the lag time between note-on
and sound output may increase. If the synthesizer “chokes” (stutters
or cuts out), enter a larger Buffer Length value and/or change the
other configuration settings.

For live play with a MIDI controller, a value of 32 offers the best note-
on to sound-out response time (latency). A value of 64-128 may be
acceptable in many situations. When you are using a MIDI application
where the note data is already input (when you aren’t playing a
controller), you may get away with an even higher value.

IMPORTANT! The Buffer Length setting affects not only the latency
response, but also the resolution of the voicing parameters. Changing
the Buffer Length setting can affect the sound of a program. For
best results, voice your programs with the same buffer length setting
that you intend to use them with.
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About the ‘Best of Retro AS-1@22kHz’ bank

The Retro AS-1 factory programs are voiced at 44.1kHz with a buffer
length of 64 for high sound quality. Because the Sample Rate and
Buffer Length settings can affect the sound quality of programs, we
have provided a copy of the ‘Best of Retro AS-1’ bank that is optimized
for 22050/ settings for use with slower computer systems. We
recommend using this bank only when Sample Rate=22050 and Buffer
Length= in the Retro AS-1 control panel.

5.3 Controllers Settings
Controllers A, B, C, D overview

Controllers A, B, C, and D allow four MIDI
continuous controllers to be active simultaneously
for highly expressive performances. These
controller parameters allow you to set up your
favorite modulation sources for use with Retro
AS-1 programs. This is a flexible arrangement that allows you to use
different controllers without having to modify your program
modulations when switching MIDI environments.

For example, let’s say Mod Wheel is selected for Controller A in the
control panel. Whenever Controller A is selected as a source for
modulation in a program, the modulation wheel will be used for that
modulation. So if Controller A is assigned to control LFO amount in a
program, the modulation wheel will control the LFO amount. Then if
you switch to a wind controller, you could change Controller A to be
Breath Control and your programs would still have the same modulation
routings with your alternate controller.

Controller A, B, C, D menu

Each Controller has a menu for selecting the desired assignment. The
controller numbers associated with the menu items are detailed in
this table.

Figure 5.3.1. The Controller
assignment parameters.

Item Selected From
Controller Menu

Controller # Assigned
to Controller Source

Modulation Wheel 1

Breath Control 2

Foot Control 3

Expression Controller 11

Figure 5.3.2. The Controllers A,
B, C, D menu.
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Where’s the Data Slider (controller #6)?

Retro AS-1 reserves MIDI controller number 6 (data slider) for real-
time control of all synthesizer parameters via MIDI using non-registered
parameter numbers. See Appendix F for more information.

Pedal menu

The Pedal parameter determines which MIDI controller number will
be used as a source when Pedal is selected as the trigger mode for
program modulators. For example, you could program an LFO
modulator to turn on only when a pedal (footswitch) is depressed.

MIDI controller #64 (sustain) is “hard wired” within Retro AS-1 to
always control sustain, regardless of any other settings. This parameter
only effects program modulators set to trigger mode.

NOTE: The names shown in the Pedal menu do not indicate
functionality within Retro AS-1. They are merely the names given to
these controller numbers by the MIDI specification.

Figure 5.3.3. The Controllers
Pedal menu.

Item Selected From
Pedal Menu

Controller # Assigned to
Modulator Pedal

Sustain 64

Portamento 65

Sostenuto 66

Soft 67

Legato 68

Hold 2 69
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5.4 Global Effects Settings
These parameters determine the behavior of the two global effects
processors. The global effects parameters are detailed in Chapter
7, section 7.5. Global effects behavior is interactive between the
Mixer and Editor. How the global effects respond is defined by
these settings. Each possible scenario is detailed below.

Scenario 1. Global Effects Off, ‘Use From Editor’ unchecked

No global effects will be used by the synth. Settings in the Editor and Mixer will
have no effect. CPU processing requirements can be reduced with this setting.

Scenario 2. Global Effects Off, ‘Use From Editor’ checked

Global effects will be heard only when the Editor is active. The global effects
parameters on the effects page in the active Editor program determine the settings.
Settings in the Mixer will have no effect.

Scenario 3. Fixed selected, ‘Use From Editor’ unchecked

The current global effects settings will be used. The current settings reflect the
state of the last used Mixer settings. If a Mixer file is opened, the global effects
settings from that file become the current effects settings. In this scenario, the
Mixer is the only place where global effect changes will be heard in real time.

Scenario 4. Fixed selected, ‘Use From Editor’ checked

The current global effects settings from the Mixer will be used unless the Editor is
active. In this scenario, when the Editor is open the global effects settings on the
effects page of the active Editor program are used, overriding the settings in the
Mixer. When the Editor is quit, the global effects settings revert back to the current
Mixer settings.

Scenario 5. Channel is selected, ‘Use From Editor’ unchecked

The global effects settings on the effects page of the current program on the specified
MIDI channel will be used. Settings in the Mixer and Editor are not used even if
those applications are open. In this scenario, global effects settings are changed
whenever the program on the specified MIDI channel is changed.

Scenario 6. Channel is selected, ‘Use From Editor’ checked

The Global Effects settings on the effects page of the current program on the specified
MIDI channel will be used unless the Editor is open. In this scenario, when the
Editor is open the global effects settings on the effects page of the active Editor
program are used, overriding the settings on the specified MIDI channel. When
the Editor is quit, the global effects settings revert back to the current program on
the specified MIDI channel.

Figure 5.4.1. The Global Effects
configuration parameters.
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5.5 Input/Output Settings
Default MIDI Input menu (Mac OS only)

This setting determines which (if any) MIDI input utility
application (Serial Input, OMS Input, or FreeMIDI Input)
is used for MIDI input when the Editor, MIDI Processor,
or Mixer is launched. The selected utility will be
launched automatically and run in the background
allowing live MIDI input while using the Retro AS-1
applications.

Selecting OMS or FreeMIDI requires those MIDI operating systems to
be installed. If your PowerMac does not have serial DMA hardware,
Serial Input cannot be used and OMS or FreeMIDI must be installed to
allow MIDI input into Retro AS-1. See Chapter 4 for more information.

Audio Output menu (Mac OS only)

This parameter determines where the synthesizer output is directed.
The default value is the Sound Manager, for use with PowerMac built-
in audio hardware.

When Direct IO is selected, the Sound Manager is bypassed altogether,
and Retro AS-1 is routed directly to installed Digidesign digital audio
expansion hardware. If no Digidesign audio card is installed, the Direct
IO menu item is grayed out, indicating it is unavailable for selection.

NOTE: For more information about using Direct IO with audio
expansion hardware, see Appendix D.

Record To Disk Size menu (Mac OS only)

This parameter determines the digital bit depth of the audio files
produced by the Retro AS-1 Record To Disk feature. 8, 16, and 24 bits
are supported. See section 7.2 for details about Record To Disk.

MIDI Input Device (Windows 95 only)

This pull-down menu determines which MIDI
hardware port will be used for MIDI input when
the Use Direct MIDI Input checkbox is checked.
The items listed in the menu are the MIDI input
hardware devices that are properly installed and
configured in Windows 95.

Select your preferred device for live MIDI input from this menu. The
selection will have no effect if the Use Direct MIDI parameter is
unchecked.

Figure 5.5.1. Input/Output
settings (Mac OS)

Figure 5.5.2. The Default MIDI
Input menu (Mac OS only).

Figure 5.5.3. The Audio Output
menu (Mac OS only).

Figure 5.5.4. The Record To Disk
Size menu (Mac OS only).

Figure 5.5.5. Input/Output
settings (Windows 95)
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IMPORTANT! The first MIDI application launched “grabs” the MIDI
input port, making it unavailable for MIDI applications that are
launched subsequently. Be sure to launch the MIDI application that
requires the MIDI input before launching other MIDI applications.

Use Direct MIDI Input (Windows 95 only)

This checkbox determines if Retro AS-1 will “grab” the MIDI input
port when the synth engine is launched. The port that is used when
this parameter is active is determined by the MIDI Input Device
parameter.

If you are using a third-party MIDI application to control Retro AS-1 in
conjunction with the Retro AS-1 device driver (as opposed to using
Retro AS-1 stand-alone), this box should be unchecked. In this scenario,
you want the third-party MIDI application to use the MIDI input port.
You would then use the “MIDI through” function of the third-party
MIDI application to pass MIDI to Retro AS-1 via the Retro AS-1 device
driver.

5.6 Miscellaneous Settings
Warn About AppleTalk checkbox (Mac OS only)

AppleTalk requires continuous CPU processing and will reduce
Retro AS-1 performance. We strongly recommend turning AppleTalk
off whenever Retro AS-1 is being used. When this option is checked,
a warning window will appear once each time the synth engine is
launched if AppleTalk is active.

To disable the warning, uncheck the Warn About AppleTalk checkbox.
In either case, you can continue to use Retro AS-1 even if AppleTalk is
active, although with reduced performance. AppleTalk is disabled in
the Chooser utility, accessed from the Apple Menu.

Launch Retro AS-1 Status (Mac OS only)

Retro AS-1 Status is a utility application that gives a visual
indication of polyphony used and the amount of CPU usage
occurring at any given moment. The Status utility can help
you determine optimum settings for your system. Retro AS-
1 Status is located in the ‘Retro AS-1 Utilities’ folder, inside
the Retro AS-1 Folder.

Figure 5.6.1. Miscellaneous
settings (Mac OS only).

Figure 5.6.2. The Status window
(Mac OS only).
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When ‘Launch Retro AS-1 Status’ is checked, the utility is opened
automatically whenever the synthesizer is launched, and quits
automatically when the synthesizer is closed. The window position of
Retro AS-1 Status is saved as a preference.

MIDI Processor Settings (Windows 95 only)

MIDI Channel

This parameter determines the MIDI channel that
the active MIDI Processor file will respond to.
The default setting is All MIDI channels.

The MIDI Channel setting allows MIDI processing
to occur only when transmitting on a particular
MIDI channel. When set to All, MIDI processing
will occur regardless of the MIDI  transmission
channel.

Note that the selection affects the MIDI reception channel only. It has
no effect on the MIDI Channel parameter of a layer.

MIDI Program Change Selects Setup

If this option is checked, the active setup in the Setup List will be
modified with MIDI Program Change commands. The first setup in
the Setup List will be selected with MIDI program change #1, the
second setup will be selected with MIDI program change #2, and so
forth. For your convenience, setups can be reordered by dragging a
setup up or down in the list.

If this option is unchecked, synthesizer program changes will occur
normally on each MIDI channel. However, the program displayed in
the MIDI Processor will not be updated to reflect the current program.
This is due to internal architecture limitations.

Figure 5.6.3. The MIDI Processor
settings (Windows 95 only).
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Chapter 6 Contents
6.1 MIDI Processor Overview
6.2 Key MIDI Processor concepts
6.3 MIDI Processor Menus
6.4 Setup List Parameters
6.5 Split/Layer Parameters
6.6 Arpeggiator Parameters

6.1 MIDI Processor Overview
The Retro AS-1 MIDI Processor allows you to modify the synthesizer
engine MIDI data in realtime by programming layers (two programs
sounding simultaneously), splits (two different programs on each side
of the keyboard), and arpeggiations (notes in a chord played
sequentially, one at time). The MIDI Processor can be thought of as
or own version of the Multis or Combinations of other manufacturer’s
hardware keyboards.

Once launched, the MIDI Processor remains active even when running
behind other applications such as the Editor or Keyboard. The MIDI
Processor can be used with a MIDI controller during live performance,
and also with third-party MIDI applications.

6.1.1 MIDI Processor Setups
The MIDI Processor supports two simultaneous programs, each on its
own MIDI channel. Any bank or program in the Retro AS-1 Programs
folder can be selected for each sound. The two programs can have
the same range (layered), or they can be limited to separate partial
ranges (split). Each layer can be transposed chromatically as well as
by octave.

The arpeggiator can be applied to one, both, or neither layers.
Arpeggiations can be specified by chords that are played or by one-
note play. Complex note patterns can be recorded or entered manually
in a list. A variety of modifiers and trigger modes are provided.

We call one complete set of layer, split, and arpeggiation settings a
Setup. Each setup name in the setup list contains a completely unique
set of parameters. Setups in the list become active as soon as they are
selected by the mouse. MIDI program change commands can select
setups as well, making Retro AS-1 a powerful live performance tool.

Chapter 6. MIDI Processor Reference
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6.1.2 MIDI Processor Files
Each MIDI Processor
window containing multiple
setups is a document that
can be saved as a disk file.
Multiple files can be open
simultaneously; the active
(frontmost) window is
always the active document.

The design of multiple
setups within a file and
multiple files accommodates
your working style. You
could, for example, have all
your favorite splits in one
document, layers in another,
and arpeggiations in
another. Additionally, you
could arrange all the splits,
layers, and arpeggiations for
one song or live set in one document, and another song in a different
document.

6.2 Key MIDI Processor Concepts
1. MIDI data processed by the MIDI Processor is not transmitted to
anything except the synthesizer engine.

2. MIDI output from the Processor and the synthesizer engine is not
available to MIDI applications or the MIDI output port(s).

3. The MIDI Processor receives data only from the synthesizer engine.

4. The MIDI Processor will not run “stand-alone” without the
synthesizer engine.

5. To hear programs that are currently loaded in the Editor, select
Editor from the Bank and Program menus.

6. The MIDI Processor switches to Bypass mode when there are no
MIDI Processor windows open.

7. Setups in the list can optionally be selected with MIDI program
change commands.

8. Notes can be triggered with the computer keyboard space bar when
the MIDI Processor is active. This preference can be disabled if desired.

Figure 6.1.1. The MIDI Processor
window. The parameter values

change when a Setup is selected
from the list on the left.
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6.3 MIDI Processor Menus

File menu
The File menu contains commands for controlling
management tasks such as loading and saving files.

New

The New command creates a new, untitled document with
default MIDI Processor settings. Use the New command when
you want to create new setups from scratch.

Note: You can create your own default settings using the Save
As ‘New’ Template command in the File menu.

Open...

The Open command loads a previously saved MIDI Processor document
from disk, using the standard Open File dialog box. You can also open
a saved file by double-clicking its icon.

Close

The Close command closes the active MIDI Processor document.
Alternately, you can click the close box in the window title bar. If the
file has been modified since it was opened, you will be asked if you
want to save the changes. If you don’t want to overwrite the existing
disk file, choose the Save As... command instead.

Save

The Save command writes the active program file to disk, overwriting
the previously saved version of the file. If you don’t want to overwrite
the existing disk file, choose the Save As... command instead.

Save As...

The Save As command writes a new file to disk, leaving the original
file unchanged. You will have the choice to rename the file. The active
document window title will change to the name of the new file after
saving.

Save As ‘New’ Template

The Save As ‘New’ Template command allows you to create your own
default settings for new MIDI Processor documents. The settings in
the active window when this command is executed will be the same
settings created when “New...” is selected from the File menu.

Figure 6.3.1. The File menu.
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To restore the factory template settings, delete the Retro AS-1 MIDI
Processor preferences file inside the Preferences folder in the active
System Folder (Mac OS), or in the Retro AS-1 Programs folder (Windows
95).

Revert

The Revert command reloads the last saved version of the file from
disk. All changes made to the file since the last Save command are
permanently lost. Revert is convenient when you don’t like the most
recent series of modifications to your setups since the last Save
command.

Quit

The Quit command closes the Retro AS-1 MIDI Processor application.
If any Processor files that are open have been modified since the last
save, you will be asked if you want to keep those modifications.

If no other Retro AS-1 applications (Editor, Keyboard, Mixer, MIDI
driver) are open, quitting the MIDI Processor will also quit the synth
engine.

Edit Menu
The Edit menu contains several timesaving utility commands for
modifying program files. General program preferences are also found
in this menu.

Undo

The Undo command will revert the program back to the condition it
was in just before performing an edit function. Use Undo when you
don’t like the results of a parameter change.

Cut

The Cut command deletes selected data and stores it in the Clipboard
(a temporary storage buffer). The data in the Clipboard can then be
placed elsewhere using the Paste command. Cut differs from the Copy
command in that the selected data is deleted.

Copy

The Copy command copies selected data and stores it in the Clipboard.
The copied data can then be placed elsewhere using the Paste
command.

Figure 6.3.2. The Edit menu.
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Paste

The Paste command places the data from the Clipboard into the selected
data field.

Clear

The Clear command deletes the selected data without storing it in the
Clipboard.

NOTE: The Cut, Copy, Paste, and Clear commands only work on
Setups in the Setup List (see Figure  6.4.1) and comments in the text
field (see Figure 6.5.6).

Bypass

The Bypass command stops the MIDI Processor from manipulating
any MIDI data. A checkmark indicates the Bypass status.

Normally, as soon as the MIDI Processor is launched, its settings are
active until the application is quit. Using Bypass allows you to turn off
MIDI processing even when the MIDI Processor application is open.

Latch

The Latch command forces the MIDI Processor to ignore MIDI note-
off messages. Incoming notes will continue to play even if a note-off
command is received.

Preferences...
The Preferences command opens the Preferences
window which contains options for specifying general
program behavior. Preference settings are retained
from previous sessions until they are modified and
saved.

‘New’ On Startup

If this option is checked, when the MIDI Processor is
launched, a new window with the default settings
will be automatically opened.

MIDI Channel

This parameter determines the MIDI channel that the
active MIDI Processor file will respond to. The default
setting is All MIDI channels.

Figure 6.3.3a. The MIDI
Processor Preferences window

(Mac OS).



C
hapter 6: M

ID
I Processor Reference

Retro AS-1 Manual

94

The MIDI Channel setting allows MIDI processing
to occur only when transmitting on a particular
MIDI channel. When set to All, MIDI processing
will occur regardless of the MIDI  transmission
channel.

Note that the selection affects the MIDI reception
channel only. It has no effect on the MIDI Channel
parameter of a layer.

MIDI Program Change Selects Setup

If this option is checked, the active setup in the
Setup List will be modified with MIDI Program
Change commands. The first setup in the Setup
List will be selected with MIDI program change
#1, the second setup will be selected with MIDI program change #2,
and so forth. For your convenience, setups can be reordered by
dragging a setup up or down in the list.

If this option is unchecked, synthesizer program changes will occur
normally on each MIDI channel. However, the program name displayed
in the MIDI Processor will not be updated to reflect the current
program. This is due to internal architectural limitations.

NOTE: In Windows 95, the MIDI Channel and MIDI Program Change
Selects Setup parameters are located in the Retro AS-1 control panel.

Pedal menu

The preferences Pedal menu defines which MIDI controller will be
used when Pedal is selected in the arpeggiator Trigger menu (see
Figure 6.6.7). To view the list of MIDI controller numbers that are
assigned to the menu, see Chapter 5, section 5.3.

Play With Spacebar

Play With Spacebar allows you to hear the current MIDI Processor
setup without having to use a MIDI controller or the Retro AS-1
Keyboard application. When Play With Spacebar is active (when the
box is checked), pressing the space bar on the computer keyboard
will trigger the note selected from the Note pull-down menu.

Figure 6.3.4. The Preferences
Pedal menu.

Figure 6.3.3b. The MIDI
Processor Preferences window

(Windows 95).
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Synthesizer Menu
The Synthesizer menu contains several utility commands,
offering access to other key components of the Retro AS-1
package.

All Notes Off

Selecting All Notes Off from the Synthesizer menu stops all
Retro AS-1 sounds from playing. It is a “MIDI panic button”
which is useful for silencing notes that are stuck on as a result
of MIDI controller faults or other problems.

Reset

This command resets the synth engine and forces all MIDI continuous
controller values to be reset to zero.

Start Record To Disk...

The Record To Disk function writes the stereo output of the synthesizer
engine to your hard drive as an audio file. Whatever the synthesizer is
playing (notes, chords, riffs, arpeggiations, etc, on all MIDI channels,
including effects) is written directly to disk. Complete instructions for
Record To Disk are in Appendix G.

Stop Record To Disk

The Stop Record To Disk command ends the Record To Disk process.
This command will have no result unless the Record To Disk function
is active.

Control Panel...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Control Panel, where system-level configuration settings are specified
For specific information about the control panel, refer to Chapter 5.

Status... (Mac OS only)

Selecting this item from the Synthesizer menu opens the Retro AS-1
Status window, for displaying polyphony and CPU usage. For specific
information about the Status window, refer to Chapter 5.

Keyboard...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Keyboard, for triggering notes without a MIDI controller. For specific
information about the Keyboard, refer to Chapter 8.

Figure 6.3.5. The Synthesizer
menu.
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Editor...

Selecting this item from the Synthesizer menu opens the Retro
AS-1 Editor application, for accessing synthesizer voicing
parameters. For specific information about the Editor, refer to
Chapter 7.

Mixer...

Selecting this item from the Synthesizer menu opens the Retro
AS-1 Mixer application, for setting up multi-timbral operations.
For specific information about the Mixer application, refer to
Chapter 9.

Windows Menu
The Windows menu allows you to switch between active MIDI
Processor documents. The Windows menu does NOT select Setups in
the Setup List of the active document. The number of items in the
Windows menu matches the number of open document files. Selecting
a document from the menu brings that document to the front and
makes it active.

(Mac OS only) The first ten windows (in the order that they were
opened) can be activated with keyboard equivalents Command-1
through Command-10. The number of setup windows you can
have open is limited only by the application memory allocation in
the Finder.

6.4 Setup List Parameters

The Setup List
The names of all setups in the active MIDI Processor document are
displayed in the Setup List. Each setup name represents a complete
set of MIDI Processor parameters. Selecting a different setup from the
list makes the new setup parameters active.

Select setups from the list by clicking on setup names with the mouse.
Alternately, you can use the up/down arrow keys to move up and
down sequentially in the list.

Setups can be selected with MIDI program changes, if the option is
selected in the Preferences window (Mac OS, see figure 6.3.3) or the
Retro AS-1 control panel (Windows 95, see figure 5.6.3). Program
change #1 will select the first setup in the list, program change #2 will
select the second setup, and so forth.

Figure 6.3.6b. The Windows
menu (Mac OS) selects between

open MP documents, NOT
between the Setups within one

document.

Figure 6.3.6a. The Windows
menu (Windows 95) selects

between open MP documents,
NOT between the Setups within

one document.
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You can click and drag setups to reorder items in the
Setup List. Additionally, the Cut, Copy, and Paste
commands work with setups in the list. After performing
a Cut or Copy command, click an empty area in the list
then select Paste. A new setup from the Clipboard will
appear in the list.

Add... button

Clicking the Add... button creates a new setup in the
list. The Setup Name window (Figure 6.4.3) will be
opened, allowing you to type in a name for the setup.

New setups added to the list have the default settings.
Use the Save As ‘New’ Template command in the File
menu to create new default settings.

Delete button

Clicking the Delete button removes the
currently selected setup from the list.
Selecting Undo from the Edit menu will
restore a deleted setup if there have been
no other edits since the deletion.

Rename... button

Clicking the Rename... button allows you
to modify the name of an existing setup.
The Setup Name window is opened
when the button is pressed, allowing you
to modify the setup name.

6.5 Split/Layer Parameters

Mode radio buttons
When the arpeggiator is on, the arpeggiator Notes menu
(see figure 6.6.5) will override the Mode setting.

Single Mode

When Single mode is selected, no split or layering will
occur; only the First/Lower program will sound.
Incoming MIDI data is re-channelized and sent to the
synthesizer on the First/Lower MIDI channel.

Figure 6.4.2. The Setup Add,
Delete, and Rename buttons.

Figure 6.4.3. The Setup Name
window.

Figure 6.5.1. The Mode radio
buttons and Split Note menu.

Figure 6.4.1. The Setup List. Each
Setup represents a complete set of

MIDI Processor parameters.
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Split Mode

When Split mode is selected, the First/Lower program will sound below
the split note, and the Second/Upper program will sound above the
split note. The split note is selected within the split note pull-down
menu.

Split Note menu

This menu determines the break point between the two sounds in the
split. MIDI note #60 equals C4.

Layer radio button

When Layer mode is selected, the First/Lower program and Second/
Upper program will sound simultaneously.

Setup Layers
Because the First/Lower and Second/Upper sections
are essentially the same, their parameters are detailed
only once.

Channel

This parameter selects which MIDI channel for the layer
will be used by the synthesizer. Incoming MIDI data is
re-channelized to match this channel. The MIDI
Processor will only respond to incoming MIDI data on
the MIDI channel specified in the Preferences window (Mac OS, see
figure 6.3.3) or the Retro AS-1 control panel (Windows 95, see figure
5.6.3).

Bank

This parameter selects which Bank for the layer will be used by the
synthesizer. To use programs that are being modified in the Editor,
select Editor from this menu.

Program

This parameter selects which Program for the layer will be used by
the synthesizer. To use programs that are being modified in the Editor,
select Editor 1-16 from this menu. The numbers 1-16 indicate the
MIDI channel that the program is set to in the Editor global page.

Figure 6.5.2. The Setup Layer
parameters. The First/Lower and

Second/Upper parameters are
identical.
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Transpose

This parameter selects the transposition for the layer. Transposition
can be adjusted up or down two octaves in half-step intervals. Use
Transpose to shift the layer into a more usable range if desired. If
transpositions more than two octaves are required, modify the program
itself on the Editor global page.

Edit

This parameter automatically opens the selected
program in the Editor and switches the MIDI channel
value on the Editor global page to match the channel
specified by the MIDI Processor setup layer. The Edit
button makes it easy to modify sounds while
programming setups.

IMPORTANT! If Editor 1-16 is selected in the setup layer program
and you edit, save, and close that program in the Editor, to hear
those changes you must reselect the program in the setup layer to
reload the program from disk.

Comments Window
A text box is provided as a place to type your notes about the setup
document. Up to 255 characters can be entered or pasted into the
comment field. Comments are saved in the setup file. The Cut, Copy,
and Paste commands can be used.

6.6 Arpeggiator Parameters
An arpeggiator plays the notes of a chord monophonically (one at a
time) in sequence.

Arpeggiation Type Radio Buttons

Off

When the Off option is selected from the arpeggiator Type radio buttons,
no arpeggiation will occur.

Played

When the Played option is selected, incoming polyphonic MIDI data
will arpeggiated. If the Range menu is active when Played is selected.

Figure 6.5.2. The Comments
window

Figure 6.6.1 The Arpeggiator
Type buttons

Figure 6.6.2. The Chord menu
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Chord

When the Chord option is selected, a single incoming MIDI note will
be played as the root of a chord selected from the chord pull-down
menu (Figure 6.6.2). If more than one note is played when the chord
function is on, the Base menu determines which note of the incoming
chord will be used as the root of the chord function.

List

The arpeggiator list (Figure 6.6.3) is essentially a “riff
recorder.” When List is selected, notes in the arpeggiator
note list will be played. Incoming MIDI data will
determine the transposition of the notes in the list,
relative to the Root menu (Figure 6.6.3) selection. Each
MIDI note in the list is followed by a number in
parenthesis which indicates the MIDI velocity value of
the note. Notes are added to the list with the Add button
(Figure 6.4.3) and Record button (Figure 6.4.4).

NOTE: Notes in the list can be reordered by dragging
them with the mouse.

Root menu

The Root menu (Figure 6.6.3) is a transpose feature for the Chord
menu and arpeggiator List. It is active whenever Chord or List is selected
as the arpeggiator Type.

Because the Root menu and incoming MIDI notes both transpose the
arpeggiator list, “double transpositions” will occur when the Note
menu value is not C4 AND incoming MIDI is not C4.

List Record button

The Record button (Figure 6.6.4) allows step-entry of notes into the
arpeggiator list. Held MIDI notes are added to the arpeggiator list when
Record is pressed. To add notes to the list using this feature, play and
hold a note (or notes) with a MIDI controller, then press the Record
button and release the note(s). If new notes are played and Record is
pressed again, the new notes will be added to the existing notes.

Figure 6.6.3. The Arpeggiator
List. A velocity value of 0 creates

a rest.

Figure 6.6.4. The List Record
button.
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Add... button

The Add... button opens the Note window (see
figure 6.6.5), where new notes are added to the
arpeggiator list one at a time. In the Note window,
select a note from the pull-down menu, then select
a velocity with the Velocity slider. After pressing
OK the added note and its velocity will be displayed
in the arpeggiator list.

Delete button

The Delete button removes existing notes from the
arpeggiator list. The note that is selected
(highlighted) is the note that will be deleted.

Edit...

The Edit... button opens the Note window (Figure 6.6.5), allowing
the modification of pitch and velocity of existing notes in the
arpeggiator list. The note that is selected (highlighted) is the note
that will be edited. Alternately, you can double-click a note in the list
to open the Note window.

Other Arpeggiator Controls

Notes menu

The Notes menu (Figure 6.6.6) determines which sound (First/Lower
, Second/Upper) will be arpeggiated. The function of each menu
item is described on the next page.

First/Upper

Arpeggiation will occur on the First/Lower layer only.

Second/Upper

Arpeggiation will occur on the Second/Upper layer only.

Split

Arpeggiation will occur on both layers as a split, overriding the setup
mode setting. The sound switches back and forth between layers if
the arpeggiation crosses the split note.

Layer

Arpeggiation will occur on both layers simultaneously, overriding
the setup mode setting.

Figure 6.6.6. The Notes menu.

Figure 6.6.5. The Note window.
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Direction menu

This option selects the order in which the notes of a chord are played.

Trigger menu

Triggering the arpeggiator begins playing the arpeggiator notes. The
Trigger menu determines by what method the arpeggiator notes will
be activated. The function of each menu item is described below.

Manual

The arpeggiator will be triggered only when the Trigger button is
clicked.

Last Key

The arpeggiator retriggers each time a note is played.

Low Key

The arpeggiator retriggers each time the lowest note of a chord is
played. If a low note is held, upper notes can be added to the chord
without retriggering.

High Key

The arpeggiator retriggers each time the highest note of a chord is
played. If a high note is held, lower notes can be added to the chord
without retriggering.

Pedal

The arpeggiator retriggers each time the MIDI pedal defined in the
MIDI Processor Preferences window (see Figure 6.3.3) is pressed.

Base menu

The Base menu  (figure 6.6.9) selects which note of an incoming chord
will be used as the root of the arpeggiation when the Chord or List
feature is active. Because incoming notes transpose the Chord and
List features, which note of an incoming chord to be used as the root
note can be specified. The function of each menu item is described on
the next page.

Last

The last played note of the chord will determine the root.

Lowest

Figure 6.6.7. The Direction menu.

Figure 6.6.8. The Trigger menu.

Figure 6.6.9. The Base menu.
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The lowest note of the chord will determine the root.

Highest

The highest note of the chord will determine the root.

Range menu

This option allows the arpeggiator notes to extend beyond the played
notes. If 1 octave is selected, only the played notes (or notes in the
List and Chord functions) will sound. If more than 1 octave is selected,
first the played notes will sound, then the played notes will sound
again, transposed up by the number of octaves selected.

Division menu

The Division menu determines each arpeggiator note’s rhythmic value
as a division of the Tempo.

Trigger button

The Trigger button begins playback of notes in the arpeggiation list,
allowing arpeggiations to begin without incoming MIDI notes. If the
Trigger menu is set to Manual, only the trigger button will activate the
arpeggiator.

Stop button

Pressing this button stops the arpeggiator. The button is grayed out if
the arpeggiator is not active.

MIDI Sync checkbox

The arpeggiator will be synchronized to the tempo of incoming MIDI
beat clock events when this box is checked. Use the Division menu to
subdivide the incoming MIDI clock tempo.

Tempo slider

Determines the tempo of the arpeggiation in beats per minute. Use
the Division menu to subdivide the tempo.

The tempo cannot be manually adjusted when MIDI Sync is active. If
the MIDI Sync box is checked, the tempo slider is greyed out. However,
if MIDI Sync is checked and no MIDI clock is being received by the
synth engine, the tempo is determined by the tempo slider value.

Figure 6.6.11. The Division menu.

Figure 6.6.13. The Stop button.

Figure 6.6.14. The Tempo slider
and MIDI Sync checkbox.

Figure 6.6.10. The Range menu

Figure 6.6.12. The Trigger button.
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Chapter 7. Editor Reference
Chapter 7 Contents
7.1 Editor Overview
7.2 Editor Menus
7.3 Editor Main Page
7.4 Editor Modulation Page
7.5 Editor Effects Page
7.6 Editor Global Page

7.1 Editor Overview
The Retro AS-1 Editor is the main sound design application. The Editor
allows you to  create, edit, and save program files. All the voicing
parameters for a complete synthesizer “patch” are contained within a
program file. Multiple program windows can be open simultaneously;
the frontmost window (the one with grey lines in the title bar) is always
the active program. Voicing parameters are grouped into four pages:
Main (oscillators and filters), Modulation, Effects, and Global. Each
page contains dozens of related settings.

Figure 7.0. The Editor Main Page.
There are 4 pages of voicing

parameters.
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To edit programs in real-time using when using a MIDI controller or MIDI
application, the MIDI channel parameter on the Global page must match the
MIDI transmission channel of the incoming note data. This is the only
parameter in the Editor that is not saved within a program file. Programs
being modified in the Editor can be heard within the MIDI Processor,
Keyboard, and Mixer applications only if Editor is selected from those
application’s Bank and Program menus.

7.1.2 Key Editor Concepts
1. The primary function of the Editor is to create and modify synthesizer
program voicing parameters. It does not need to be open to use the synthesizer
for playing existing programs.

2. The MIDI channel of the program being edited is selected on the Global
page. This is the only parameter that is not saved with the program file.

3. To edit a program that is selected by the MIDI Processor, Mixer, or Keyboard,
first load the program into the Editor, then select ‘Editor’ from the Bank/
Program menus in those applications.

4. To hear the Global Effects settings that are in a program while it is loaded
into the Editor, select ‘Use From Editor’ in the Retro AS-1 control panel.

5. Files can be saved anywhere, but to be accessible from the MIDI Processor,
Keyboard, Mixer, or MIDI Bank/Program change commands, they must reside
in the Retro AS-1 Programs folder.

(Mac OS only) An alias to this folder with the exact name “Retro AS-1
Programs” must reside at root level of the System Folder.

6. Notes can be triggered with the computer keyboard space bar when the
Editor is active. This preference can be disabled if desired.

7.1.3 Parameter Editing Conventions
All of the Retro AS-1 components use a consistent interface design for ease
of use. The parameters of these components use a combination of menu
items, on/off switches, pull-down menus, and sliders to manipulate the
available settings.

Listed below are instructions for adjusting the various parameter types:

• Parameter switches such as oscillator on/off buttons and filter input
checkboxes are changed by clicking on them once with the mouse.

• Pull-down menu parameters such as waveform types are selected by click-
hold-dragging the menu item, then releasing the mouse on the desired
selection.
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• Parameter slider values can be manipulated in four different ways
(see Figure 7.1.1):

1. Click, hold, and drag the horizontal slider bar.
2.  Increment or decrement by a value of one by clicking at the

top or bottom of the slider.
3. Increment or decrement by a value of ten percent of the total

range by clicking on the vertical slider line, between the
horizontal slider bar and the end of the vertical slider range.

4.Option-click (Mac OS) or double-click (Windows 95) the slider
value to call up a text entry box. Input a number directly using
the number keys on your computer keyboard, then press Return
or Enter.

7.2. Editor Menu Items
This section explains the commands found in each of the five
menus.

File Menu
The File menu contains commands for controlling
management tasks such as loading and saving files.

Figure 7.2.1. The Editor File
menu.

Figure 7.1.1. Parameter Slider
“hot spots” for editing values.

Option – click (Mac OS) or
double-click (Windows 95) here

to bring up a text entry box. Press
Return after entering a value.

Click the slider name
to increment by one.

Click above slider bar
to increment by ten

percent.

Click, hold, and
drag the slider bar.

Click below slider bar to
decrement by ten percent.

Click the slider value to
decrement by one.
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New

The New command creates a new, untitled program file with the default
program settings. Use the New command when you want to create a
new default synthesizer program from scratch.

Note: You can create your own default settings using the Save As
‘New’ Template command in the File menu.

Open...

The Open command loads a previously saved program file from disk,
using the standard Open File dialog box. You can also open a saved
file by double-clicking its icon.

Close

The Close command closes the active program file. Alternately, you
can click the close box of the window title bar. If the file has been
modified since it was opened, you will be asked if you want to save
the changes. If you don’t want to overwrite the existing disk file, choose
the Save As... command instead.

Save

The Save command writes the active program file to disk, overwriting
the previously saved version of the file. If you don’t want to overwrite
the existing disk file, choose the Save As... command instead.

Save As...

The Save As command writes a new file to disk, leaving the original
file unchanged. You will have the choice to rename the file. The active
program window title will change to the new name after saving.

Save As ‘New’ Template

The Save As ‘New’ Template command allows you to create your own
default settings for new Editor programs. The settings in the active
window when this command is executed will be the same settings
created when “New...” is selected from the File menu.

To restore the factory template defaults, delete the Retro AS-1 Editor
preferences file inside the Preferences folder in the active System Folder
(Mac OS), or at the root level of the Retro AS-1 Folder (Windows 95).
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Revert

The Revert command reloads the last saved version of the file from
disk. All changes made to the file since the last Save command are
permanently lost. Revert is handy when you don’t like the most recent
series of modifications to your program since the last Save command.

Quit

The Quit command closes the Retro AS-1 Editor application. If any
program files that are open have been modified since saving, you will
be asked if you want to save those modifications.

If no other Retro AS-1 applications (MIDI Processor, Keyboard, Mixer,
MIDI driver) are open, quitting the Editor will also quit the synth
engine.

Edit Menu
The Edit menu contains several timesaving utility commands
for modifying programs. General program preferences are
found here also.

Undo

The Undo command will revert the program back to the state
it was in just before performing an edit function. Use Undo
when you don’t like the results of a parameter change.

Cut

The Cut command deletes selected data and stores it in the Clipboard
(a temporary storage buffer). The stored data can then be placed
elsewhere using the Paste command. Cut differs from the Copy
command in that the selected data is deleted.

Copy

The Copy command copies selected data and stores it in the Clipboard.
The copied data can then be placed elsewhere using the Paste
command.

Paste

The Paste command places the data from the Clipboard into the selected
data field.

Figure 7.2.2. The Edit menu
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NOTE: The Cut, Copy, and Paste commands work only for
Modulators on the Modulation page (figure 7.4.5), and Comments
on the Global page (figure 7.6.1).

Clear

The Clear command deletes selected data but does not place that data
in the Clipboard.

Select All

The Select All command selects all of the text in the Comments window
(Figure 7.6.1), in preparation for the Copy or Cut commands.

Randomize

The Randomize command randomly assigns a new value to every
slider parameter in the program. Randomize does not change the status
of menus or on/off buttons. Use Randomize when you want a different
sound NOW!

Preferences...
The Preferences command opens the Preferences window,
which contains several options for specifying general program
behavior. Preference settings are stored as a preference and
remain the same until they are modified.

‘New’ On Startup

If this option is checked, a new, untitled program file with
the default template settings is created when the Editor is
launched.

MIDI Channel

The MIDI channel that the active Editor program responds
to is determined by the MIDI Channel parameter on the Global
page. This preference parameter determines which MIDI
channel will be the default value when selecting a ‘New’
program from the File menu.

Envelope Editing radio buttons

This option allows you to reverse how Modulator envelope
parameter values are displayed. If the Rate/Time selection is
changed, the envelope modulator parameter values are
inverted. Figure 7.2.3. The Editor

Preferences window.
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Rate

When Rate is selected, a higher envelope parameter value means a greater rate. A
value of 100 will mean “fast rate of time” and a value of 0 will mean “slow rate of
time.”

Time

When Time is selected, a higher envelope parameter value means a greater time. A
value of 0 will mean “fast length of time” and 100 will mean “slow length of time.”

Graphical checkbox

Modulator envelopes can be displayed and modified using the graphical envelope
feature. When this box is checked, envelopes will be displayed graphically instead
of as sliders. The Rate/Time preference applies to the graphical envelopes.

Play With Spacebar checkbox

Play With Spacebar allows you to hear the current Editor program without having
to use a MIDI controller or the Retro AS-1 Keyboard application. When Play With
Spacebar is active (when the box is checked), pressing the space bar on the computer
keyboard will trigger the note selected from the Note pull-down menu. The MIDI
channel of the note transmitted to the engine by the spacebar is specified by the
MIDI Channel menu.

Page Menu
The Page menu allows navigation through the four pages of
parameters as an alternative to clicking on the window page tabs.
(Figure 7.2.5)

Main

Select Main from the Page menu to switch to the main (oscillators
and filters) parameter page.

Modulation

Select Modulation from the Page menu to switch to the modulation
parameter page.

Effects

Select Effects from the Page menu
to switch to the effects parameter
page.

Global

Select Global from the Page menu to switch to the global parameter page.

Figure 7.2.4. The Page menu.

Figure 7.2.5. The Page tabs in a
program window perform the

same function as the Page menu.
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Figure 7.2.6. The Editor
Synthesizer menu.

Synthesizer Menu
The Synthesizer menu contains several utility commands,
offering access to other key components of the Retro AS-1
package

All Notes Off

Selecting All Notes Off from the Synthesizer menu stops all Retro
AS-1 sounds from playing. It is a “MIDI panic button” which is
useful for silencing notes that are stuck on as a result of MIDI
controller faults or other problems.

Reset

Selecting Reset from the Synthesizer menu resets the synth engine
and forces all MIDI continuous controller values to be reset to zero.

Start Record To Disk...

The Record To Disk function writes the stereo output of the synthesizer
engine to your hard drive as an audio file. Whatever the synthesizer is
playing (notes, chords, riffs, arpeggiations, etc, on all MIDI channels,
including effects) is written directly to disk. Complete instructions for
Record To Disk are in Appendix G.

Stop Record To Disk

The Stop Record To Disk command ends the Record To Disk process.
This command will have no result unless the Record To Disk function
is active.

Control Panel...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Control Panel, where system-level configuration settings are specified.
For specific information about the control panel, refer to Chapter 5.

Status... (Mac OS only)

Selecting this item from the Synthesizer menu opens the Retro AS-1
Status window, for displaying polyphony and CPU usage. For specific
information about the Status window, refer to Chapter 5.

Keyboard...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Keyboard, for triggering notes without a MIDI controller. For specific
information about the Keyboard, refer to Chapter 8.
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MIDI Processor...

Selecting this item from the Synthesizer menu opens the Retro AS-1
MIDI Processor application, for programming splits, layers, and
arpeggiations. For specific information about the MIDI Processor, refer
to Chapter 6.

Mixer...

Selecting this item from the Synthesizer menu opens the
Retro AS-1 Mixer application, for setting up multi-timbral
operations. For specific information about the Mixer
application, refer to Chapter 9.

Windows Menu
The Windows menu allows you to switch between active
Editor programs. The number of items in the Windows
menu matches the number of open document files.
Selecting a document from the menu brings that
document to the front and makes it active.

(Mac OS only) The first 10 open programs can be selected by pressing
command 1-0. The number of simultaneously open program windows
is limited only by the application memory allocation in the Finder.

7.3 Main Page
The Main page (see figure 7.0) contains the oscillator and filter voicing
parameters for the synthesizer. Modulation parameters for the
oscillators and filters are located on the Modulation page.

Oscillator Overview
The oscillator is the primary building block in synthesis, the source
upon which all other synthesis functions act upon.

There are three oscillators available for each program. All oscillators
can be used simultaneously for a three-layer sound. Oscillators do not
have to be routed through a filter in order to be audible. An oscillator
can be used as a source for Synchronization (Sync), Frequency
Modulation emulation (FM), or Cutoff Modulation (CM) without being
routed through a filter.

Figure 7.2.7a. The Editor
Windows menu allows you to

switch between multiple
programs that are open in the

Editor.

Figure 7.2.7b. The Editor
Windows menu (Windows 95).
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There are nine waveform types available for each oscillator. Each
waveform has its own sound due to its unique harmonic overtone
structure. By using the Sync, Symmetry, and FM parameters, an (almost)
unlimited number of waveform harmonic variations can be created.
All available oscillator sliders are available as a modulation destination
for dynamic pitch and timbre changes over time.

In addition to the three audio-frequency oscillators, multiple low-
frequency oscillators (LFOs) can be used as modulation sources. See
the Modulation Page (section 7.4) for more information on LFOs.

For more information about synthesizer basics, see Appendix E.

Oscillator Parameters

Because oscillators 1, 2, and 3 are identical, their parameters are detailed
in this section only once. Refer to Figure 7.3.1 for this section.

Oscillator On/Off button

The oscillator On/Off button is represented by a speaker icon. When
the oscillator is off, the button is blue. When it is on, the button changes
to yellow.

Click the button once to toggle the on/off state of the oscillator. The
Configuration window will update to indicate the change.

IMPORTANT! Turning an oscillator on requires more processing power
from the CPU. Leave oscillators off unless you are actually using them
in a sound.

Figure 7.3.1. The oscillator
parameters.

Figure 7.3.2. The oscillator On/
Off button

On

Off
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Oscillator Keyboard Track button

When Keyboard Track is on, the oscillator pitch will “track” (play the
pitch of) the incoming MIDI note number. When Keyboard Track is
off, the oscillator will produce the same pitch regardless of the MIDI
note played. The base note of C4 (middle C) when Keyboard Track is
off can be modified with the Coarse and Fine tuning parameters.

Oscillator Menus
Each oscillator has three pull-down menus. Click, hold, drag, and
release on the desired menu item to change the selection.

Oscillator Type Menu

The Type menu selects the waveform shape for the oscillator. Waveform
variations can be created using the Symmetry parameter.

Figure 7.3.3 .The Oscillator
Type menu

Figure 7.3.2b .The Keyboard
Track button. Keyboard Track is
the oscillator “non-transpose”

option.

On

Off

Figure 7.3.4. The waveform types

White Noise Full bandwidth noise (all frequencies equal)

Pink Noise Upper frequencies attenuated by -3db per octave

Red Noise Upper frequencies attenuated by -6db per octave

Noise

TriangleSawtooth Pulse

Sine Sine Squared Glottal
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Sync Menu

Synchronization is a waveform reset function. It forces an oscillator to
trigger again at the beginning of its cycle each time the modulator (the
Sync menu selection, Figure 7.3.5) completes its cycle.

The Sync menu selects which oscillator or filter will be used as a
synchronization source. If a source oscillator is selected from the Sync
menu, the source oscillator must be enabled; however it does not
have to be routed through a filter. Each parameter of the Sync source
will have an effect on the carrier waveform.

FM Menu

Frequency Modulation (FM) emulation is used to modulate the
frequency of one oscillator (the carrier) with another oscillator or filter
(the modulator). Retro AS-1 takes FM emulation to the next level by
using FM in conjunction with subtractive synthesis (filtering).

The FM menu (Figure 7.3.5) selects the source modulator. If a source
oscillator is selected from the FM menu, the source oscillator must be
enabled. However, it does not have to be routed through a filter. Each
parameter of the FM source will have an effect on the waveform.

When a source is selected in the FM menu, the FM Amount parameter
must be increased above zero to have an effect.

IMPORTANT! Turning FM on requires more processing power from
the CPU. Leave FM off unless you are actually using it in a sound.

Figure 7.3.6. Waveform Sync
illustration. When the sync

source waveform crosses zero,
the destination waveform cycle is

forced to begin its cycle from
zero.

Sync Source
waveform (Sync
menu selection)

Resulting
waveform

Figure 7.3.5. The Sync and FM
menus. The source selections are

identical for both menus.
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Oscillator Sliders
Refer to Figure 7.3.1. for the oscillator slider descriptions.

Coarse

The Coarse parameter determines the frequency of the oscillator in
musical semitones (1 semitone = 1 half step = 100 cents). When the
Coarse value is zero, playing MIDI note number 60 will sound Middle
C (C4). If the value is 12, the pitch of the oscillator will increase by
one octave; –24 will decrease the pitch by two octaves; 7 will increase
the pitch by a perfect fifth, and so forth. There is an eight-octave (+/
–four octaves) range.

NOTE: To change the global tuning for the entire program (not just
one oscillator), use the Global Transpose parameter, located on the
Global Page.

Fine

The Fine parameter tunes the oscillator frequency between musical
semitones. The range is 100 cents (+/– 50 cents), or one quarter-step
sharp or flat. If you need to tune beyond this range, use the Coarse
parameter. Use the Fine parameter to “detune” oscillators for a chorus
type of effect.

Random

Random is designed to add “analog instability” to the oscillator. When
the value is set above zero, the oscillator will play out of tune by a
random amount each time a note is triggered.

The Random parameter determines the maximum amount of pitch
deviation. With a Random amount of 100, the maximum pitch deviation
is one semitone.

Symmetry

This parameter alters the shape of the waveform selected in the Type
menu. The Symmetry parameter allows continuous control of the
waveform shape, yet another new tool for creative sound design. For
example, Symmetry changes a Square waveform to a Pulse waveform
and all points between. A Sawtooth wave with a symmetry value of
100 becomes a triangle wave.

The Symmetry slider effects only the Sawtooth, Pulse, and Glottal
waveforms. It is unavailable when other waveforms are selected. See
Figure 7.3.7 below for an illustration of Symmetry control.
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Symmetry Amount

Symmetry Amount

Symmetry Amount

Figure 7.3.7. How Symmetry
affects waveform shape
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FM Amount

FM Amount determines the amount of frequency modulation emulation
to be applied to the oscillator. This parameter is unavailable when the
FM menu (Figure 7.3.5) is set to None.

Oscillator Volume

The Volume level sets the output level of the oscillator before it is
routed to the filter. Use the Volume parameter to set the relative volume
levels when multiple oscillators are active.

Enabled oscillator volumes are added at the filter input (Figure 7.3.11).
If multiple oscillators are enabled and their volumes are set high,
clipping distortion may occur. We allow this for your creative freedom.
If distortion is not wanted, reduce the oscillator volume when multiple
oscillators are used.

NOTE: To change the Global volume for the entire program (not just
one oscillator), use the Global volume parameter, located on the
Global page.

Filters Overview
Filters are another important building block in the synthesis process.
Filters work by removing harmonic content from a waveform, resulting
in a different sound. This process is known as subtractive synthesis.

Retro AS-1 has two programmable filters available per program. One,
two, or all three oscillators can be routed through one or both filters.
13 filter types are available for each filter. Each filter can accept input
from the other filter, allowing for serial or parallel filtering effects.
This can effectively double the available filter slope, for up to 48 decibels
(db) per octave of filter roll-off.

Filters can be overdriven for distortion, and be made to self-oscillate
with resonance. And all filter sliders are available as a modulation
destination for dynamic timbre changes over time. You will find many
new ways to create rich new sounds with the Retro AS-1 filters.

For more information about synthesizer basics, see Appendix E.
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Filter Parameters
Because filters 1 and 2 are identical, their parameters are detailed in
this section only once. Refer to Figure 7.3.8 for parameter descriptions.

Filter On/Off button

The Filter On/Off button is represented by a speaker icon. When the
filter is off, the button is blue. When it is on, the button changes to
yellow.

Click the button once to toggle the on/off state of the filter. The
Configuration window will update to indicate the change.

IMPORTANT! Turning a filter on requires more processing power
from the CPU. Leave filters off unless you are actually using them in
a sound.

Filter Type menu

Thirteen filter types are available. Each processes the waveform(s)
differently and will result in a different sound. Each filter type is
described below.

1 Pole Low Pass

This is the most basic filter type, and is the least CPU-intensive. It
attenuates frequencies above the cutoff frequency, with a filter slope
of 6db per octave. The Spread and Resonance parameters (see figure
7.3.7) are unavailable when this filter type is selected.

Figure 7.3.8. The Filter
parameters.

Figure 7.3.9. The Filter Type
menu.

Figure 7.3.8. The Filter On/Off
button.

On

Off
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2 Pole Low Pass

This filter type attenuates frequencies above the cutoff frequency, with
a filter slope of 12db per octave. The Resonance parameter is
unavailable when this filter type is selected. If you want resonance in
a 2-pole filter, use the State Variable Low Pass filter type.

4 Pole Low Pass Resonant

This filter type attenuates high frequencies above the cutoff frequency
with a filter slope of 24db per octave, with resonance (filter feedback).

1 Pole High Pass

This is the most basic filter type, and is the least CPU-intensive. It
attenuates frequencies below the cutoff frequency, with a filter slope
of 6db per octave. The Spread and Resonance parameters (see figure
7.3.7) are unavailable when this filter type is selected.

2 Pole High Pass

This filter type attenuates frequencies below the cutoff frequency, with
a filter slope of 12db per octave. The Resonance parameter is
unavailable when this filter type is selected. If you want resonance in
a 2-pole filter, use the State Variable High Pass filter type.

4 Pole High Pass Resonant

This filter type attenuates high frequencies below the cutoff frequency
with a filter slope of 24db per octave, with resonance (filter feedback).

The All Pass Filters

The All Pass filter types pass all frequencies equally with no attenuation.
With no resonance applied in an all pass filter, the sound is unaffected.
You may ask then, what’s the point? The point is, the resonance
parameter creates a frequency boost at the cutoff frequency. The
bandwidth of this emphasis peak is determined by the number of
poles in the filter. By adding resonance to an all pass filter, interesting
sonic variations are created.

1 Pole All Pass Resonant

The resonance parameter creates an emphasis boost at the cutoff
frequency with a 6db per octave bandwidth.

2 Pole All Pass Resonant

The resonance parameter creates an emphasis boost at the cutoff
frequency with a 12db per octave bandwidth.
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4 Pole All Pass Resonant

The resonance parameter creates an emphasis boost at the cutoff
frequency with a 24db per octave bandwidth.

State Variable LP (Low Pass)

This filter type attenuates frequencies above the cutoff frequency, with
a filter slope of 12db per octave. It is the similar to the 2-Pole Low Pass
type, and includes the Resonance parameter. The Spread parameter is
unavailable when this filter type is selected. If you want a 2-pole filter
but don’t need resonance, you can use the 2-Pole Low Pass type to
save on CPU processing.

State Variable BP (Band Pass)

This is a bandpass filter with a slope of 12db per octave. Frequencies
at the cutoff frequency are allowed to pass. Frequencies above and
below the cutoff frequency are attenuated. The Spread parameter is
unavailable when this filter type is selected.

The filter bandwidth is varied with the Resonance parameter. A lower
value of Resonance has a wider bandwidth; a higher value has a
narrower bandwidth.

State Variable BS (Band Stop)

This is a notch filter with a slope of 12db per octave.  Frequencies at
the cutoff frequency are attenuated. Frequencies above and below the
cutoff frequency are allowed to pass. The Spread parameter is
unavailable when this filter type is selected.

The filter bandwidth is varied with the Resonance parameter. A lower
value of Resonance has a wider bandwidth; a higher value has a
narrower bandwidth.

State Variable HP (High Pass)

This is a highpass filter with a slope of 12db per octave. Frequencies
above the cutoff frequency are allowed to pass. Frequencies below the
cutoff frequency are attenuated. The Spread parameter is unavailable
when this filter type is selected.

CM (Cutoff Modulation) Menu

This menu selects the source of filter cutoff frequency modulation
(“PolyMod”). When a source is selected in the CM menu, the CM
Amount parameter must be increased above zero to have an effect.

Figure 7.3.10. The CM menu.
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IMPORTANT! Turning CM on requires more processing power from
the CPU. Leave CM off unless you are actually using it in a sound.

Input source checkboxes

The filter input source checkboxes are used to select what signal(s)
will be routed into the filter for processing. One, two, or all three
oscillators can be routed through one or both filters.

Filter 1 output can be routed to Filter 2 input, or vice-versa, for serial
filtering effects. The result is like one very steep filter, effectively adding
the slope of the two filters together. Or, use 2 different filter types in
parallel for great special effects.

Filter Sliders
Refer to figure 7.3.8 for the Filter Slider descriptions.

Cutoff

The Cutoff parameter determines the frequency at which the filtering
will begin to take effect. In a lowpass filter, a higher value will result
in a brighter sound. The filter cutoff value is expressed in Hertz.

If changing this parameter value has no effect, there is probably a
modulation routing with filter cutoff as the destination. Lower the
filter cutoff modulation routing amount to make the initial cutoff value
more noticeable.

Spread

2 Pole and 4 Pole filters are simply 1 Pole filters cascaded in series,
normally with the same cutoff frequency. The Spread parameter varies
the cutoff frequencies of the cascaded filters. Increasing the Spread
value makes the filtering slope not as steep and not as smooth,
effectively introducing more “slop” in the filter for additional sonic
possibilities.

The Spread parameter is unavailable when 1 Pole or State Variable
filter types are selected.

CM Amount

Determines the amount of filter cutoff frequency modulation
(“PolyMod”)  applied to the filter. This parameter is unavailable if the
CM menu is set to None. A cutoff modulation source must be selected
with the CM pull-down menu.

Figure 7.3.11. The Filter input
source checkboxes.
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Figure 7.3.12. The
Configuration display.

Resonance

Resonance is filter feedback. It causes the filter output signal to be
routed back to the filter input. On all pass and state variable band
pass/band stop filter types, Resonance controls the filter bandwidth.
Increase the Resonance value for more filter feedback.

NOTE: Filter resonance becomes more noticeable as the Cutoff value
is lowered.

High Resonance values may cause self-oscillation, which can be useful
for chirping sounds or other special effects. When the Resonance and
Cutoff values are both very high, the oscillator(s) output level may
drop.

Resonance is not available in 1 and 2 pole low pass and high pass
filter types.

Overdrive

The Overdrive parameter is a gain stage before the filter input.
Increasing the Overdrive value adds clipping distortion to the filter
signal, resulting in an overdriven, distorted sound. Overdrive is great
for adding “bite” to a sound, which can help cut through a mix, or for
creating special effects.

Configuration Display
The Configuration Display is a graphic representation of the current
oscillator, filter, and insert effect signal path routings. It is for viewing
only; the icons and routings cannot be changed here. Use the oscillator
and filter on/off buttons and input checkboxes and insert effects
parameters to change the graphic display.
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7.4 Modulation Page

The Modulation page contains all of the parameters for program
modulations. Modulation sources, destinations, and amounts are all
defined on the Modulation page.

There are two main groups of parameters on the modulation page:
Routings and Modulators. The Routings parameters are used to define
modulation destinations and modulation amounts. The Modulators
parameters are used to define modulation sources.

For more information about synthesizer basics and modulation, see
Appendix E.

Routings Parameters
Modulation routings (figure 7.4.2) are the software “patchcords” used
to connect a modulation source to a modulation destination. To create
a modulation routing, first the source and destination is defined, then
the modulation amount is set. Modulation sources are defined by the
Modulators parameters (see figure 7.4.5).

Figure 7.4.1. The Modulation
page. Modulation destinations

and amounts are set on the left,
and modulation source

parameters are on the right.
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The number of modulation routings you can use in a program is limited
only by the CPU processing power that is available.

NOTE: For more information about CPU usage and polyphony, see
Chapter 5, Control Panel Reference.

Routings List

The Routings List displays all the
modulation routings currently
defined in a program, in the order
that they were created.

Each line item in the list indicates
how the modulation “patch” is
defined. For example, “Envelope 1
To Volume” means that Envelope
#1 is the modulator, and Volume
is the modulation destination.

To select a routing in the list, click
the routing name once. When a
routing is selected, the Source,
Destination, and Amount
parameters are visible and can be
modified. If the Source or
Destination values are changed,
the routing name is updated in the
list to reflect the new settings.

The order in which the items are
displayed has an effect on real-time
MIDI control via non-registered
parameter numbers. See Appendix
F for more information about real-
time MIDI control.

IMPORTANT! Each modulation routing requires additional processing
power from the CPU. Delete unused routings from the list to increase
available polyphony.

Routing Add Button

The Add button is used to create new modulation routings. To add a
routing, click the Add button once. The newly created routing will be
automatically selected, and the source, destination, and amount
parameters can be modified as desired.

Figure 7.4.2. The Routings
parameters. The list is in the

upper area, and the settings for
each routing is below.
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Routing Delete Button

The Delete button is used to remove existing
modulation routings. To delete a routing,
first select the routing you want to delete
from the list by clicking on it once, then
click the Delete button to remove the item
from the list. You can use the Undo
command if you accidentally delete a
routing and need to get it back.

Routing Source Menu

The Source pull-down menu is used to select
the modulation source for a routing. To edit
the source of a routing, first click on the
routing in the Routings List to select it, then
choose a new source from the pull-down
menu.

Items in the Source menu are created in the
Modulators section of the Modulation Page
(see figure 7.4.5). Once a Modulator is
created, that new Modulator then becomes
available as an item in the Source menu.

Some MIDI controller sources are “hard wired” and are always available
in the Source menu, even if there are no Modulators in the Modulator
list. The MIDI controllers that are always available for modulation
sources are: Note & Pitchbend, Velocity, Mono Aftertouch, Poly
Aftertouch, and Controllers A, B, C, and D.

Routing Destination Menu

The Destination pull-down menu is used to select the modulation
destination for a routing. To edit the destination of a routing, first click
on the routing in the list to select it, then choose a new destination
from the pull-down menu. Items displayed in the destination list are
determined by items in the Modulators list (figure 7.4.5).

Routing Amount Slider

The Amount slider (figure 7.4.2) is used to adjust the modulation
amount for a routing. To edit the amount of a routing, first click on the
routing in the list to select it, then modify the Amount parameter as
desired. The modulation Amount value range is +/– 100. Figure 7.4.3. The Routing

Destination menu. Destinations
are determined by items in the

Modulators list.

Figure 7.4.2. The Routing
Source menu. Sources are
determined by items in the

Modulators list.
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The Amount value is always added to the existing value of the modulation
destination. For example, if the initial filter cutoff value on the main page is set to
50 and a modulation routing destination is set to filter cutoff with an amount of
50, the resulting filter cutoff will be 100. If the initial filter cutoff value on the
main page is set to 75 and the modulation amount is set to -50, the resulting filter
cutoff would be 25.

Therefore, for a modulation routing to have any effect, the initial value of the
modulation destination must be less than its maximum possible setting for a positive
Amount value (or more than its minimum possible setting for a negative Amount
value).

IMPORTANT! To have any effect, the modulation destination initial value must
be decreased for positive modulation amounts, or increased for negative amounts.

The total resulting parameter value (initial setting plus modulation amount) can
never exceed the maximum possible initial value for a parameter. For example, if
the initial filter cutoff value on the main page is set to 50 and a modulation routing
destination is set to filter cutoff with an amount of 75, the resulting filter cutoff
would only be 100 (not 125) because 100 is the maximum possible setting for
filter cutoff.

IMPORTANT! You can never exceed the maximum possible setting for the
destination value, regardless of the modulation Amount value.

Modulators Parameters
Modulators are used to define sources for modulation routings. Once a modulator
is defined, it becomes available in the routings Source menu for assignment to a
modulation destination, and the modulator parameters become available in the
routings Destination menu.

The Modulators parameters are used to define envelope, low frequency oscillator
(LFO), ramp, and random modulation sources and their control values. MIDI
controllers (Note & Pitchbend, Velocity, Mono Aftertouch, Poly Aftertouch,
Controllers 1 & 2) are “hard wired” modulation sources and are always available
in the Routings Source menu without being defined as Modulators.

To create a modulation routing, first the modulator type and its trigger mode are
defined, then the associated modulator parameters are adjusted. The number of
modulation routings you can use in a program is limited only by the CPU processing
power that is available.

IMPORTANT! Each modulator requires additional processing power from the
CPU. Unused modulators should be deleted from the list to increase available
polyphony.
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Modulators List

The Modulators List displays
all the modulation sources
currently defined in a
program, in the order that
they were created. The order
in which the items are
displayed has no operational
relevance.

Each line item in the list
indicates a modulation
source. If the modulator is
assigned in a routing, its
destination is indicated in the
list. For example, “Filter 1
Cutoff Envelope 2” means
that Envelope #2 is defined as
a modulation source, and it
has been routed to the filter
1 cutoff parameter in the
Routings Editor. If the list says
only “Envelope 2” it means
the modulator has been
created, but it is not yet
assigned to a routing.

To select a modulator in the
list, click the modulator name
once. When a modulator is
selected, the Type/Trigger
menus and modulator
parameters are visible and
can be modified. If the Type or Trigger values are changed, the
modulator name is updated in the list to reflect the new settings.

Modulator Add Button

The Add button is used to create new modulation sources. To add a
modulator, click the Add button once. The newly created routing will
be automatically selected. Then modify the Type, Trigger, and the
associated modulator parameters as desired.

Figure 7.4.5. The Modulators
parameters. Items in the list are

available as sources for
modulation routings. Each list

item is a unique modulator with
its own set of parameters. Click a
modulator in the list to display

its parameter values.
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Modulator Delete Button

The Delete button is used to remove existing modulation sources. To
delete a modulator, first select the modulator you want to delete from
the list by clicking on it once. Then click the Delete button to remove
the item from the list. You can use the Undo command if you
accidentally delete a modulator and need to get it back.

Modulator Type Menu
The Modulator Type menu defines which type of modulation source
will be used. The available modulator types are Envelope, LFO,
Random, and Ramp.

When an item is selected in the modulator list, changing the Type
selection will update the modulator name. If the modulator is assigned
to a routing, its associated routing list item will also be updated.

The selected modulator type determines which parameters are available
for editing. Each modulator type and its associated parameters are
described in detail in this
section.

Envelope Modulator

Retro AS-1 uses standard 5-stage
envelopes (figure 7.4.8).
Envelopes can be viewed as
sliders or graphically, and values
can be displayed as Rate or
Time. The Graphical and Rate/
Time options are specified in the Editor Preferences window (figure
7.2.3). If the Rate/Time value is changed, the envelope modulator
values are inverted. Each stage parameter is described in detail on the
next page.

Figure 7.4.7a. The Envelope
modulator parameters displayed

as sliders.

Figure 7.4.6. The
modulator Type menu.

Figure 7.4.7b. The Envelope
modulator parameters displayed

graphically.
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Attack

The Attack parameter determines how long it takes for the envelope to reach its peak
value. The peak value is the maximum modulation Amount defined by a routing. If
the preference is set to Time, a lower value will have a faster attack. If set to Rate, a
higher value will have a faster attack.

Decay

The Decay parameter determines how long it takes for the envelope to reach the
sustain stage after completing the attack stage. If the preference is set to Time, a
lower value will have a faster decay. If set to Rate, a higher value will have a faster
decay.

Sustain Le vel

The Sustain Level determines the amount of modulation after the attack and decay
stages have completed their cycle. A lower value will have a lower modulation amount
during the sustain stage. A higher value will have a higher modulation amount during
the sustain stage.

Sustain Decay

The Sustain Decay parameter forces the normally flat sustain level to gradually go to
zero, even if the current note is not released. The Sustain Decay parameter determines
the slope of the sustain stage, or how long it takes for the sustain level to reach zero
after completing the attack and decay stages. If the preference is set to Time, a lower
value will have a faster sustain decay, and value of 100 causes the Sustain level to
remain flat with no slope. If set to Rate, a higher value will have a faster sustain
decay, and value of zero causes the Sustain level to remain flat with no slope.

Release

The Release parameter determines how long it takes for the envelope to reach a
modulation amount of zero after a note-off command is issued. If the preference is set
to Time, a lower value will have a faster release. If set to Rate, a higher value will
have a faster release.

Figure 7.4.8. The stages of an
Envelope modulator.
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Modifying Envelopes in Graphical Mode

When displayed graphically, envelope segment values can be modified by click-dragging the
segments or by entering a value in the text boxes. Envelopes are not drawn exactly to scale.
Extreme settings may display a shape that doesn’t look like it sounds.

These diagrams illustrate the graphical “hot spots” for modifying segment values. When you click
on the segment in the graphic display, the  cursor changes to red arrows to remind you which
direction to drag the mouse. It is helpful to watch the text values as you drag the segments.

To edit the attack value, click on
the attack segment and drag

horizontally.

To edit the decay value, click on
the decay segment and drag

horizontally.

To edit the sustain value, click on
the sustain segment and drag

vertically.

To edit the release value, click on
the release segment and drag

horizontally.

To edit the sustain decay value,
click on the point connecting the
sustain and release segments and

drag vertically.
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LFO Modulator

LF O Type

The LFO Type parameter
determines the waveform shape
for the LFO modulator. Choose
an LFO Type by clicking once on
the waveform’s associated radio
button.

LF O Delay

The LFO Delay parameter
determines how long it takes for
the LFO modulation amount
(determined in the Routings
Editor) to ramp up to full value. A lower value will make the LFO take
effect faster. A higher value will gradually increase the LFO effect.

LF O Speed

The LFO Speed parameter defines the frequency (speed) of the LFO.
Values are displayed in Hertz.

Random checkbox

Normally, an LFO begins from “zero,” at the beginning of its cycle
every time it is triggered. When Random is checked, the LFO does
not begin from zero, but instead from a random location in its cycle
each time it is triggered.

MIDI S ync checkbox

When MIDI Sync is checked, the LFO speed will be synchronized to
(determined by) incoming MIDI beat clock events. The Division menu
is then used to subdivide the beat if desired.

The Speed parameter is unavailable when MIDI Sync is checked.
However, if MIDI Sync is checked and no MIDI clock is being received
by the synth engine, the LFO speed is determined by the Speed slider
value.

Division menu

When MIDI Sync is active, LFO speed is determined by the incoming
MIDI clock tempo. This incoming tempo can be subdivided with the
Division menu.

To make an LFO faster relative to a set MIDI tempo, select a higher
subdivision value.

Figure 7.4.9. The LFO
modulator parameters.

Figure 7.4.9b. Activating MIDI
Sync enables the Division menu

and disables the Speed slider.

Figure 7.4.9c. The
Division menu.
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Random Modulator

The Random modulator is simply a noise generator.

Random Modulator Filter slider

The Random modulator Filter is a one-pole filter for the Random
modulator.

Ramp Modulator

The Ramp modulator is a slope generator. It creates a linear slope that
gradually increases the value of the modulation destination from zero
to the value set by the routing Amount parameter.

Ramp Delay slider

The Delay parameter determines the time it takes before the ramp
modulation will begin.

Ramp Speed slider

The Speed parameter determines the time it takes for the ramp
modulator to go from no modulation to the modulation value set by
the routing Amount parameter.

For example, if a ramp modulator is routed to filter 1 cutoff and the
initial filter 1 cutoff value is set to 50 on the main page, the ramp
Speed parameter would determine how long it takes for the cutoff
value to reach 50.

Modulator Trigger Menu
Each modulator type allows you to select the triggering method with
the Trigger menu. The Trigger menu determines how the modulator
will be implemented when multiple notes are triggered. Each Trigger
mode is described in detail below.

Multiple

When Multiple trigger mode is selected, every played note triggers the
modulator from the beginning of its cycle.

For example, let’s say an envelope with a very slow attack and decay
is routed to filter cutoff in multiple trigger mode. When a note is
triggered, the envelope cycle begins and the filter starts to open. When
the next note is triggered, the filter envelope starts again at “point
zero” regardless of the previous note.

Figure 7.4.10. The Random
modulator parameter.

Figure 7.4.11. The Ramp
modulator parameters.

Figure 7.4.12. The
modulator Trigger menu.
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Multiple trigger mode is often used in Polyphonic mode (global page
setting) so each note will have the exact same sound.

Single

When Single trigger mode is selected, if multiple notes are played
together the modulator does not trigger at the beginning of its cycle.
Instead, the modulator continues from where it was when the first
note was played. Single mode is effectively creates a “monophonic”
modulator for polyphonic notes.

For example, let’s say an envelope with a very slow attack and decay
is routed to filter cutoff in single trigger mode. When a note is triggered
and held, the envelope cycle begins and the filter starts to open. When
another note is added to the chord, the filter is still opening, using the
envelope from the first note. Only after all held notes are released (or
the modulator completes its cycle) will the modulator begin a new
cycle when a new note is played.

Single trigger mode is often used in Legato mode (global page setting)
for a smoother transition between notes.

Pedal Down

When Pedal Down trigger mode is selected, the modulator is triggered
when the pedal (footswitch) is pressed. The MIDI pedal number that
activates the trigger is defined in the Retro AS-1 control panel.

Pedal Up

When Pedal Up trigger mode is selected, the modulator is triggered
when the pedal (footswitch) is released. The MIDI pedal number that
activates the trigger is defined in the Retro AS-1 control panel.

Key Up

When Key Up trigger mode is selected, the modulator is triggered as
the note is released. To hear any effect, the amplitude and/or filter
envelope (if any) release parameter(s) must be increased above a zero
length of time.
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7.5 Effects Page

Effects Overview
Retro AS-1 includes
four effects
processors. Two
processors are insert
(serial) effects, and
two are global
(parallel) effects. The
two insert effects are
stored into the
program itself, and
always process the
program (if enabled)
regardless of any
other settings. Global
effects settings are
saved with the
program, but their
behavior is interactive
between the Editor
and the Mixer.

How the global effects respond between Editor and Mixer settings is
determined by the Global Effects parameters in the Retro AS-1 control
panel (see Chapter 5, figure 5.4.1). Each possible scenario is detailed
below.

Scenario 1. Global Effects Off, ‘Use From Editor’ unchecked

No global effects will be used by the synth. Settings in the Editor and
Mixer will have no effect. CPU processing requirements can be reduced
with this setting.

Scenario 2. Global Effects Off, ‘Use From Editor’ checked

Global effects will be heard only when the Editor is active. The global
effects parameters on the effects page in the active Editor program
determine the settings. Settings in the Mixer will have no effect.

Scenario 3. Fixed selected, ‘Use From Editor’ unchecked

The current global effects settings will be used. The current settings
reflect the state of the last used Mixer settings. If a Mixer file is opened,
the global effects settings from that file become the current effects
settings. In this scenario, the Mixer is the only place where global
effect changes will be heard in real time.

Figure 7.5.1. The Effects Page.
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Scenario 4. Fixed selected, ‘Use From Editor’ checked

The current global effects settings from the Mixer will be used unless
the Editor is active. In this scenario, when the Editor is open the global
effects settings on the effects page of the active Editor program are
used, overriding the settings in the Mixer. When the Editor is quit, the
global effects settings revert back to the current Mixer settings.

Scenario 5. Channel is selected, ‘Use From Editor’ unchecked

The global effects settings on the effects page of the current program
on the specified MIDI channel will be used. Settings in the Mixer and
Editor are not used even if those applications are open. In this scenario,
global effects settings are changed whenever the program on the
specified MIDI channel is changed.

Scenario 6. Channel is selected, ‘Use From Editor’ checked

The Global Effects settings on the effects page of the current program
on the specified MIDI channel will be used unless the Editor is open.
In this scenario, when the Editor is open the global effects settings on
the effects page of the active Editor program are used, overriding the
settings on the specified MIDI channel. When the Editor is quit, the
global effects settings revert back to the current program on the specified
MIDI channel.

Effects On/Off Button

The four effects each have its own on/off button. Each on/off button
is represented by a speaker icon. When the effect is off, the button is
blue. When it is on, the button changes to yellow. Click the button
once to toggle the on/off state of the effect.

IMPORTANT! Effects require significant processing power from the
CPU. Effects should be disabled when not required to increase
available polyphony.

The Insert Effect Parameters
The insert effects are in series; the insert effect 1 output always goes
to the insert effect 2 input. Both insert effect processors are identical.

Insert Effect menu

8 different insert effect types are available. The type of insert effect
that is selected from the Insert Effect menu determines which
parameters are available for editing. Each insert effect type and its
associated parameters are detailed in this section.

Figure 7.5.2. The Effects
On/Off button.

On

Off

The Insert Effect menu.
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Parametric EQ

The Parametric EQ insert effect is an equalizer (tone
control) for amplifying or attenuating any specific
frequency, with full control of the bandwidth.

Frequency

The Frequency parameter specifies the frequency that
will be amplified or attenuated. The range is from zero
to one-half the sample rate specified in the Retro AS-1
control panel.

Q

The Q parameter specifies the bandwidth of the equalizer. A high Q
value has a narrow bandwidth, meaning only frequencies close to the
Frequency parameter value will be affected. A low Q value has a wide
bandwidth, meaning the equalizer will effect a broader frequency
spectrum. A Q value of 2 has a bandwidth of 1 octave.

Gain

The Gain parameter specifies the amount of amplification or attenuation
that will be applied to the Frequency value. A positive value for Gain
will amplify (boost) the specified frequencies. A negative value will
attenuate (cut) the specified frequencies. The Gain range is +/– 12db.

Shelf EQ

The Shelf EQ insert effect is an equalizer
for amplifying or attenuating two specific
frequencies, without control of the
bandwidth. It is essentially a two-band
parametric EQ with fixed bandwidth.

Low

The Low parameter specifies the
frequency that will be amplified or
attenuated in the low frequency section
of the two-band equalizer. The Low
frequency range is from zero to one-half
the sample rate specified in the Retro AS-
1 control panel (the low and high bands
are actually identical).

Figure 7.5.4. The Shelf EQ
parameters.

Figure 7.5.3. The Parametric
EQ parameters.
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Low Gain

The Low Gain parameter specifies the amount of amplification or
attenuation that will be applied to the Low frequency value. A positive
value for Gain will amplify (boost) the specified frequencies. A negative
value will attenuate (cut) the specified frequencies. The Gain range is
+/– 12db.

High

The High parameter specifies the frequency that will be amplified or
attenuated in the high frequency section of the two-band equalizer.
The High frequency range is from zero to one-half the sample rate
specified in the Retro AS-1 control panel (the low and high bands are
actually identical).

High Gain

The High Gain parameter specifies the amount of amplification or
attenuation that will be applied to the High frequency value. A positive
value for Gain will amplify (boost) the specified frequencies. A negative
value will attenuate (cut) the specified frequencies. The Gain range is
+/– 12db.

Flange

The Flange insert effect is a very
short modulated delay line with
feedback. Flange produces a thick,
swirling, hollow-sounding effect.

Delay

Amount of time in milliseconds
before the delayed signal is heard.

Feedback

Amount of processed signal that is looped back to the input to be
processed again. A negative value inverts the phase of the feedback
signal.

Speed

The rate of pitch modulation expressed in Hertz (cycles per second).

Depth

The amount of pitch modulation.

Figure 7.5.5. The Flange
parameters.
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Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Chorus

The Chorus insert effect is a stereo
modulated delay line with
feedback. Chorus produces a
thicker, richer tone by turning one
sound into a “chorus” of sounds.

Delay

Amount of time in milliseconds
before the delayed signal is heard.

Feedback

Amount of processed signal that is looped back to the input to be
processed again. A negative value inverts the phase of the feedback
signal.

Speed

The rate of pitch modulation expressed in Hertz.

Depth

The amount of pitch modulation.

Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Phaser

Phaser is a popular “retro” effect
that produces filter phase
distortions, creating a swirling,
swooshy sound.

Delay

Amount of time in milliseconds
before the delayed signal is heard.

Figure 7.5.6. The Chorus
parameters.

Figure 7.5.7. The Phaser
parameters.
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Amount

Amount of phase distortion.

Speed

The rate of phase modulation expressed in Hertz.

Depth

The amount of phase modulation.

Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Insert Delay

Delay is a two-tap delay line with
feedback and independent control
of the tap delay times. Delay
produces an “echo canyon” effect.

Delay 1

Controls the time of the first delay
tap.

Feedback 1

Amount of tap 1 delay signal that
is looped back to the input to be
processed again. A negative value
inverts the phase of the feedback
signal.

Delay 2

Controls the time of the second delay tap.

Feedback 2

Amount of tap 2 delay signal that is looped back to the input to be
processed again. A negative value inverts the phase of the feedback
signal.

Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Figure 7.5.8. The Insert Delay
parameters.
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MIDI S ync checkbox

When MIDI Sync is checked, the delay times will be synchronized to
(determined by) incoming MIDI beat clock events. The Division menu
is then used to subdivide the beat if desired.

The delay parameters are unavailable when MIDI Sync is checked.
However, if MIDI Sync is checked and no MIDI clock is being received
by the synth engine, the delay times are determined by the delay slider
values.

IMPORTANT! (Mac OS only) Using MIDI Sync with OMS requires
the OMS IAC (Inter-Application Communication) Driver. See chapter
4 for details.

Division menu

When MIDI Sync is active, delay times are determined by the incoming
MIDI clock tempo. This incoming tempo can be subdivided with the
Division menu. The Division menus are unavailable when MIDI Sync
is not checked.

To make a delay time shorter relative to a set MIDI tempo, select a
higher subdivision value.

Overdrive

Overdrive produces a “soft
clipping” effect that results in a
saturated, compressed sound.
Technically, it distorts the higher-
amplitude portion of a signal.

Gain

Scales the signal before the
threshold parameter.

Threshold

Amount of signal that needs to be present before distortion is added.
A lower value will produce a more prominent effect.

Amount

Amount of Overdrive of the signal above the threshold.

Figure 7.5.9. The Overdrive
parameters.

The MIDI Sync Division
menu.
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Filter

Attenuates higher frequencies. A higher value will produce a brighter
sound.

Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Distortion

Distortion produces a “crossover
distortion” effect that results in a biting,
distorted sound. Technically, it distorts
the lower-amplitude portion of a signal.

Threshold

Amount of signal that needs to be
present before distortion is added. A
higher value will produce a more
prominent effect.

Hysteresis

Amount of distortion below the threshold. Technically, this is the
amount that the zero-crossings of the waveform are displaced.

Tone

Attenuates higher frequencies. A higher value will produce a brighter
sound.

Mix

Controls the dry-to-wet ratio (balance) of the direct unprocessed signal
and the wet processed signal.

Figure 7.5.10. The Distortion
parameters.
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The Global Effects
Global effects behavior is interactive between the Editor and Mixer
and is dependent upon the Retro AS-1 control panel settings. See the
beginning of section 7.5 for a complete explanation.

Global Effect menu

3 different global effect types are available. The type of global effect
that is selected from the Global Effect menu determines which
parameters are available for editing. Both global effects processors are
identical. Each global effect type and its associated parameters are
detailed in this section.

Delay

Delay is a true
stereo delay line
with feedback
and independent
control of the left
and right channel
delay times.
Delay produces
an “echo canyon”
effect.

Send

Controls the amount of dry signal that is sent to the delay for processing.
A higher value will have a more pronounced effect.

Delay 1

Controls the time of the left delay channel.

Feedback 1

Amount of delay 1 signal that is looped back to the left input to be
processed again. A negative value inverts the phase of the feedback
signal.

Delay 2

Controls the time of the right delay channel.

Feedback 2

Amount of delay 2 signal that is looped back to the right input to be
processed again. A negative value inverts the phase of the feedback
signal.

The Global Effect menu.

Figure 7.5.11. The Global Delay
parameters.
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Filter

Attenuates higher frequencies in the delay processor. A higher value
will produce a brighter sound.

MIDI S ync checkbox

When MIDI Sync is checked, the delay times will be synchronized to
(determined by) incoming MIDI beat clock events. The Division menu
is then used to subdivide the beat if desired.

The delay parameters are unavailable when MIDI Sync is checked.
However, if MIDI Sync is checked and no MIDI clock is being received
by the synth engine, the delay times are determined by the delay slider
values.

IMPORTANT! (Mac OS only) Using MIDI Sync with OMS requires
the OMS IAC (Inter-Application Communication) Driver. See chapter
4 for details.

Division menu

When MIDI Sync is active, delay times are determined by the incoming
MIDI clock tempo. This incoming tempo can be subdivided with the
Division menu.

To make a delay time shorter relative to a set MIDI tempo, select a
higher subdivision value.

Reflection

Reflection is a series
of multi-tap delay
processors that
produce a result
somewhere between
a delay line and a
reverb.

Send

Controls the amount of dry signal that is sent to the delays for
processing. A higher value will have a more pronounced effect.

Reflection Mode Radio Buttons

Choose from one of four different reflection types by clicking once on
its associated radio button.

The MIDI Sync
Division menu.

Figure 7.5.12. The Reflection
parameters.



C
hapter 7: Editor Reference

Retro AS-1 Manual

145

Sparse

Produces longer random delay times of lower density with a logarithmic
decay curve. Creates the impression of a larger ambient space.

Diffuse

Produces shorter random delay times of higher density with a
logarithmic decay curve. Creates the impression of a smaller ambient
space.

Random

Produces random density reflections with random delay times and no
decay curve. Creates the impression of an unnatural ambient space.

Reverse

Plays the reflection delays with a growing amplitude curve for special
effect.

Predelay

Amount of time before the first reflection is heard. Larger values give
the impression of a larger ambient environment.

Brightness

A high frequency attenuation filter. A higher value will result in a
brighter sound.

Length

Sets the delay times of the early reflections. Larger values give the
impression of a larger ambient environment.

Reverb

Reverbs add an
ambient quality to a
sound, giving the
impression that the
sound originates in
an acoustic
environment.

Figure 7.5.13. The Reverb
parameters.
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Send

Controls the amount of dry signal that is sent to the reverb for
processing. A higher value will have a more pronounced effect.

Reverb Mode Radio Buttons

Choose from one of four different reflection types by clicking once on
its associated radio button.

Room

Creates the impression of a small acoustical environment.

Chamber

Creates the impression of a medium-sized acoustical environment.

Small Hall

Creates the impression of a large-sized acoustical environment.

Large Hall

Creates the impression of a huge acoustical environment.

Predelay

Amount of time before the reverb signal is heard. Larger values give
the impression of a larger acoustical environment.

Brightness

A high frequency attenuation filter. A higher value will result in a
brighter reverb.

Decay

Controls the amount of time before the reverb “tail” cannot be heard.
Larger values give the impression of a larger acoustical environment.
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7.6 Global Page

The Global page contains parameters that affect the entire program.
Refer to Figure 7.6.1 for Global parameter descriptions.

Trigger Mode

The Trigger radio buttons determines how the synthesizer will respond
to multiple incoming MIDI notes. You can select from several different
triggering modes.

Polyphonic

Polyphonic trigger mode is the standard mode for playing multiple
MIDI notes (chords) simultaneously. In Polyphonic mode, the
maximum number of simultaneous notes that will sound is determined
by the Number Of Voices parameter on the Global page, but it can
never exceed the Number Of Voices setting in the Retro AS-1 control
panel.

Figure 7.6.1. The Global Page.
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Legato Last

When Legato Last is selected as the trigger mode only one note will
play at a time. The note that plays will always be the last note played,
regardless of any other held notes. This is the “classic” legato (mono)
mode.

Legato Low

When Legato Low is selected as the trigger mode only one note will
play at a time. The note that sounds will always be the lowest note
played, regardless of any other played notes. For example, if a low C is
triggered and held, any notes played above low C will not trigger.

Legato High

When Legato High is selected as the trigger mode only one note will
play at a time. The note that sounds will always be the highest note
played, regardless of any other played notes. For example, if a high C
is triggered and held, any notes played below high C will not trigger.

MIDI Channel

IMPORTANT! The MIDI Channel parameter is the only Editor
parameter that is not stored within the program file.

The MIDI Channel parameter determines which incoming MIDI channel
the program will respond to when loaded into the Editor. The MIDI
Channel setting allows multiple programs loaded in the Editor to play
on separate MIDI channels.

This feature enables real-time editing of the programs on different
MIDI channels when using the Retro AS-1 in multi-timbral mode. To
switch between open programs in the Editor, use the Windows menu.

If multiple programs open in the Editor are set to the same channel,
only the active (frontmost) program on that channel will be heard.

If multiple programs open in the Editor are set to the same channel
and a program on a different MIDI channel is the active program, the
frontmost window of the program sharing the same MIDI channel will
play.

The default MIDI Channel value for new programs is specified in the
Editor Preferences window.
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Number Of Voices

This parameter allows you to limit the number of notes in a particular
program. This can help performance on slower systems by eliminating
extraneous notes. For example, a lead program could be restricted to 1
or 2 notes if you know you will never play big chords with it. The
Number Of Voices setting in the Retro AS-1 control panel can never be
exceeded regardless of this setting.

NOTE: For more information about polyphony, see Chapter 5,  Retro
AS-1 control panel Reference.

Transpose

The Transpose parameter sets the overall tuning for the entire program
in musical semitone (half-step) increments. The displayed value
indicates the transposition interval in semitones. When the Transpose
value is zero, the note pitch is determined by the oscillator Coarse and
Fine tuning parameters.

Pan

The Pan parameter determines the left/right stereo positioning of the
program. This parameter will be overridden with a change in the MIDI
controller #10 value.

Volume

This Volume parameter is the global volume setting for the entire
program. Use this parameter to set the “master” volume, or to adjust
relative volumes between program files. This parameter will be
overridden with a MIDI controller #7 change.

Relative volumes between oscillators can be set using the oscillator
volume parameter on the Main page.

Portamento

Portamento (also known as Glissando or Glide) is a classic synthesizer
effect that moves the pitch of one played note smoothly and
continuously to the pitch of the next played note, much like the human
voice. In order for portamento to be active, the “new” note must be
played before the “old” note is released.

Portamento is only active in Legato trigger mode.
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Portamento Type

O f f

When Off is selected, there is no portamento effect.

Up

When Up is selected, only notes played above the previous note will
use portamento.

Down

When Down is selected, only notes played below the previous note
will use portamento.

Up & Down

When Up & Down is selected, the new note will always use portamento.

Fingered

If Fingered is checked, portamento will only be applied if a previous
note is held down. To always use portamento, regardless of whether a
note is currently playing or not, uncheck this box.

Up Slider

The Up slider value determines the portamento time (how long a new
note takes to move to its pitch) when Up or Up & Down is selected as
the portamento type. A value of zero will have no portamento effect.
A higher value specifies a longer time.

Down Slider

The Down slider value determines the portamento time (how long a
new note takes to move to its pitch) when Down or Up & Down is
selected as the portamento type. A value of zero will have no
portamento effect. A higher value specifies a longer time.

Comment Field

A text box is provided as a place to type your notes about the program.
Up to 255 characters can be entered or pasted into the comment field.
Comments are saved in the program file.

(Mac OS only) The Retro AS-1 Program Cleaner utility (inside the
Goodies folder) will automatically generate controller routing
information and append it to the text in the comment field.



C
hapter 8: Keyboard Reference

Retro AS-1 Manual

151

Chapter 8: Keyboard Reference
Chapter 8 Contents
8.1 Keyboard Overview
8.2 Key Keyboard Concepts
8.3 Keyboard Menus
8.4 Keyboard Parameters

8.1 Keyboard Overview

The Retro AS-1 Keyboard application is an on-screen utility for triggering
Retro AS-1 sounds without a MIDI controller or any other MIDI
hardware or software. The Keyboard allows you to trigger a 9-octave
range of individual notes and chords, change the active voice selection,
control note velocity values, and transmit controller information.

You can open the application in two ways: by choosing Keyboard...
from the Synthesizer menu within the Editor, MIDI Processor, or Mixer
applications, or by double-clicking the Retro AS-1 Keyboard application
icon. The application was installed at the root level of the Retro AS-1
Folder.

NOTE: If you don’t hear sound output from the Keyboard, refer to
Appendix C, Troubleshooting.

Figure 8.0. The Keyboard
window.
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8.2 Key Keyboard  Concepts
1. The Keyboard is becomes active as soon as it is launched. No other
AS-1 components need to be launched in order to play synthesizer
programs with the Keyboard.

2. To hear programs loaded in the Editor when using the Keyboard,
select Editor from the Bank and Program menus.

3. The Retro AS-1 Keyboard does not transmit to MIDI applications or
the MIDI out port(s).

4. The Retro AS-1 Keyboard does not receive MIDI data from MIDI
applications or the MIDI out port(s).

5. On Windows 95, launching Retro AS-1 Keyboard is the recommended
method for activating MIDI input because of its low RAM and CPU
requirements.

8.3 Keyboard Menus

File Menu
The File menu contains one item: Quit. Select Quit to close the Keyboard
application. Clicking the Close Box in the keyboard window will also
quit the application.

If no other applications are using the synthesizer engine (Editor, MIDI
Processor, Mixer, MIDI drivers) the synth engine will quit also.

Edit Menu
The Edit menu contains one item: Latch Mode. When Latch Mode is
enabled, notes triggered with the Keyboard will continue to play when
you release the mouse, as if you were still holding the note down. This
feature allows you to hold a note so you can switch to the Editor and
modify the program when you don’t have a MIDI controller connected.

A checkmark next to Latch Mode indicates the feature is active.

Synthesizer Menu
The Synthesizer menu contains several utility commands, offering
access to other key components of the Retro AS-1 package

Figure 8.3.1. The File menu.

Figure 8.3.2. The Edit menu.
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All Notes Off

Selecting All Notes Off from the Synthesizer menu stops all
Retro AS-1 sounds from playing. It is a “MIDI panic button”
which is useful for silencing notes that are stuck on as a result
of MIDI controller faults or other problems.

Reset

Selecting Reset from the Synthesizer menu resets the synth engine
and forces all MIDI continuous controller values to be reset to
zero.

Start Record To Disk...

The Record To Disk function writes the stereo output of the
synthesizer engine to your hard drive as an audio file. Whatever the
synthesizer is playing (notes, chords, riffs, arpeggiations, etc, on all
MIDI channels, including effects) is written directly to disk. Complete
instructions for Record To Disk are in Appendix G.

Stop Record To Disk

The Stop Record To Disk command ends the Record To Disk process.
This command will have no result unless the Record To Disk function
is active.

Control Panel...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Control Panel, where system-level configuration settings are specified.
For specific information about the control panel, refer to Chapter 5.

Status... (Mac OS only)

Selecting this item from the Synthesizer menu opens the Retro AS-1
Status window, for displaying polyphony and CPU usage. For specific
information about the Status window, refer to Chapter 5.

Mixer...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Mixer, for setting up multi-timbral operations. For specific information
about the Mixer, refer to Chapter 9.

Editor...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Editor application, for accessing program voicing parameters. For
specific information about the Editor application, refer to Chapter 7.

Figure 8.3.3. The Synthesizer
menu.
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MIDI Processor...

Selecting this item from the Synthesizer menu opens the Retro AS-1
MIDI Processor application, for programming splits, layers, and
arpeggiations. For specific information about the MIDI Processor, refer
to Chapter 6.

8.4 Keyboard Parameters
The Graphic Keyboard

Clicking a key with the mouse sends the corresponding MIDI pitch to
the synthesizer. You will hear the active program file as displayed in
the Bank/Program menus.

Where you click on the key determines the velocity value of the note.
Clicking towards the top (“rear”) of the key transmits a lower velocity
for the note; clicking towards the bottom (“front”) of the key transmits
a higher velocity value.

You can also trigger sounds with the computer’s QWERTY keyboard
(see figure 8.4.1). The C Major scale will be triggered by the bottom
row of keys beginning with the letter Z. The “black” notes are triggered
by the second row of keys. To extend beyond the one octave range of
the qwerty notes, use the Range function.

QWERTY
key Note

QWERTY
key Note

Z C G F#

S C# B G

X D H G#

D D# N A

C E J A#

V F M B

< C

Figure 8.4.1. The computer
keyboard will trigger these MIDI

note values.
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Channel menu

This parameter determines the MIDI channel of the Keyboard notes
transmitted to the synthesizer.

Range menu

This parameter allows you to extend the range of the Keyboard beyond
its visible 5-octaves by shifting the note values up and down in octaves.
You can shift the keys up or down +/– 2 octaves, allowing for a full
9-octave range.

Bank and Program menus

These parameters determine which program will be heard when using
the Keyboard. When changing these parameters, MIDI bank and
program change values are transmitted to the synthesizer on the MIDI
channel selected with the Channel pull-down menu.

NOTE: For information about Bank and Program organization, see
Appendix B, Working with Banks and Programs.

Bank menu

This menu determines the active bank. The sounds available in the
program menu are determined by the bank selection.

If the Editor is open the Editor bank becomes enabled, allowing you to
select the program(s) that are loaded into the Editor with the program
menu.

Program menu

This menu determines the active program. The sounds available in
the Program menu are determined by the bank selection.

To use programs that are being modified in the Editor, select Editor 1-
16 from this menu. The numbers 1-16 indicate the MIDI channel that
the program is set to in the Editor global page.

Chord menu

This parameter activates the Chord function. When a Chord is selected
from the pull-down menu, more than one note will be triggered when
a key is clicked on the on-screen or computer keyboards. Many chord
voicings are available. The notes of the chord will highlight on the
keyboard when played.

Figure 8.4.2. The Chord menu.
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NOTE: If the active program is in Legato (monophonic) mode, the
Chord function will have no effect. Legato mode is set on the Editor
global page.

Controller A, B, C, D sliders

These sliders transmit MIDI continuous controller information to the
synthesizer. The controller numbers used are determined by the
Controller preferences specified in the Retro AS-1 Control Panel.

NOTE: For information about controller assignments, see Chapter
5, Control Panel Reference.
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Chapter 9. Mixer Reference
Chapter 9 Contents
9.1 Mixer Overview
9.2 Key Mixer Concepts
9.3 Mixer Menus
9.4 Channel Strips
9.5 Master Section

9.1 Mixer Overview
The Retro AS-1 Mixer application is a software “audio console” used
to define the Bank and Program Selection, Volume, Pan, Mute, Solo,
and Global Effect settings of the Retro AS-1 synthesizer on each of the
16 MIDI channels during multi-timbral operation.

Mixer settings can be saved to disk as a file; Mixer files contain complete
settings for a unique multi-timbral setup. This “snapshot automation”
makes it very fast and easy to recall settings for a particular MIDI
song, for example.

Figure 9.0. The Mixer window.
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Each time a Mixer file is opened, it searches the Retro AS-1 folder to
load the banks and programs used by the file. It will still find the
correct banks and programs even if the bank/program hierarchy has
been modified. If the bank and/or program can’t be found (if it no
longer resides in the Retro AS-1 Programs folder), question marks will
be displayed instead of the bank/program name and no sound will
play on that MIDI channel until a new program is selected.

The Mixer constantly queries the synth engine and the display is
updated to reflect the current synthesizer settings for bank, program,
volume, pan, and global send information. For example, if you use
controller 7 to change the MIDI volume from within your sequencer
application, the volume slider for that channel in the Mixer will be
updated to reflect the new volume setting.

Because the Mixer is always asking the synth what the current settings
are, it requires CPU processing even if it is just idle in the background,
unlike the other Retro AS-1 applications. Since many sequencers and
other MIDI applications have there own methods of transmitting
volume, pan, and other controller information, you may find it more
CPU efficient to use those features instead of the Mixer.

Using the Mixer with the Editor
The Retro AS-1 Editor can be open and active at the same time as the
Mixer; you can modify programs with the Editor while the multi-timbral
settings are being modified by the Mixer. To hear programs that are
currently loaded in the Editor while using the Mixer, select Editor
from the Bank and Program pull-down menus when the Editor is open.
The voice being modified by the Editor is determined by the MIDI
channel specified on the Editor Global page.

Global Effects with the Mixer
Global Effects parameters can be edited from within the Mixer
and saved with a Mixer file. The next time that Mixer file is
opened, the current Global Effects settings will be updated to
the stored settings. If Global Effects are modified in the Mixer
and the active file is closed, the current settings stay in RAM
and remain current until a different Mixer file is opened. When
the synth engine is closed, the current Global Effects settings
are written to a Preference file to be used when the synth is reactivated.

Global Effects behavior is interactive between the Mixer and Editor.
How the Global Effects respond is defined by the Retro AS-1 Control
Panel settings. Each possible scenario is detailed on the next page.

Figure . Global Effects settings in
the Retro AS-1 control panel.

These parameters determine the
behavior of the Global Effects

processors in the Mixer.
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Scenario 1. Global Effects Off, ‘Use From Editor’ unchecked

No global effects will be used by the synth. Settings in the Editor and
Mixer will have no effect. CPU processing requirements can be reduced
with this setting.

Scenario 2. Global Effects Off, ‘Use From Editor’ checked

Global effects will be heard only when the Editor is active. The global
effects parameters on the effects page in the active Editor program
determine the settings. Settings in the Mixer will have no effect.

Scenario 3. Fixed selected, ‘Use From Editor’ unchecked

The current global effects settings will be used. The current settings
reflect the state of the last used Mixer settings. If a Mixer file is opened,
the global effects settings from that file become the current effects
settings. In this scenario, the Mixer is the only place where global
effect changes will be heard in real time.

Scenario 4. Fixed selected, ‘Use From Editor’ checked

The current global effects settings from the Mixer will be used unless
the Editor is active. In this scenario, when the Editor is open the global
effects settings on the effects page of the active Editor program are
used, overriding the settings in the Mixer. When the Editor is quit, the
global effects settings revert back to the current Mixer settings.

Scenario 5. Channel is selected, ‘Use From Editor’ unchecked

The global effects settings on the effects page of the current program
on the specified MIDI channel will be used. Settings in the Mixer and
Editor are not used even if those applications are open. In this scenario,
global effects settings are changed whenever the program on the
specified MIDI channel is changed.

Scenario 6. Channel is selected, ‘Use From Editor’ checked

The Global Effects settings on the effects page of the current program
on the specified MIDI channel will be used unless the Editor is open.
In this scenario, when the Editor is open the global effects settings on
the effects page of the active Editor program are used, overriding the
settings on the specified MIDI channel. When the Editor is quit, the
global effects settings revert back to the current program on the specified
MIDI channel.
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9.2 Key Mixer Concepts
1. The Mixer communicates only with the synth engine. It does not
transmit or receive MIDI data to/from other MIDI sources.

2. Global Effects can be modified within the Mixer only when the
effects mode is set to ‘Fixed’ in the Retro AS-1 control panel.

3. To hear programs loaded in the Editor when using the Mixer, select
Editor from the Bank and Program menus in the Mixer.

4. The Mixer parameters reflect the current MIDI state of the synthesizer,
even if changes are made from an external source. Because this feature
requires CPU processing even in the background, quit the Mixer when
CPU resources are limited.

9.3 Mixer Menus

File Menu
The File menu contains commands for controlling management tasks
such as loading and saving files.

New

The New command creates a new, untitled mix. Use the New command
when you want to create a new mix from scratch.

Open...

The Open command loads a previously saved Mixer file from disk,
using the Mac OS standard Open file dialog box. You can also open a
saved file by double-clicking its icon in the Mac OS Finder.

Close

The Close command closes the active Mixer document. Alternately,
you can click the close box at the left of the window title bar. If the file
has been modified since it was opened, you will be asked if you want
to save the changes. If you don’t want to overwrite the existing disk
file, choose the Save As... command instead.

Save

The Save command writes the active Mixer file to disk, overwriting
the previously saved version of the file. If you don’t want to overwrite
the existing disk file, choose the Save As... command instead.

Figure 9.3.1. The File menu.
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Save As...

The Save As command writes a new file to disk, leaving the original
file unchanged. You will have the choice to rename the file. The active
document window title will change to the new name after saving.

Quit

The Quit command closes the Retro AS-1 Mixer application. If any
Mixer files that are open have been modified since saving, you will be
asked if you want to save those modifications.

Edit Menu

Global Effect 1...

Choosing Global Effect 1 opens the parameter window (figures
9.5.3, 9.5.4, and 9.5.5) for global effect processor 1. This is the
same as pressing the Edit button in the Returns area of the Mixer
window (see figure 9.5.1).

Global Effect 2...

Choosing Global Effect 2 opens the parameter window (figures 9.5.3,
9.5.4, and 9.5.5) for global effect processor 2. This is the same as
pressing the Edit button in the Returns area of the Mixer window (see
figure 9.5.1).

NOTE: For an explanation of each specific effect parameter, refer to
Chapter 7, Editor Reference, section 7.5.

Preferences...

Choosing Preferences opens the Mixer
Preferences window, for specifying general
options within the Mixer. Select the
preferred options by clicking its associated
radio button or checkbox. The settings are
retained until they are modified.

NOTE: See section 9.1 of this chapter for
more information about global effects
behavior.

Figure 9.3.2. The Edit menu.

Figure 9.3.3. The Preferences
window.
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Use default settings

All MIDI channels will be initialized to default values when the Mixer
is launched. Volume and global effect sends will be set to maximum,
and Pan will be set to center on all MIDI channels, regardless of current
synth engine settings.

Use current synth settings

When the Mixer is launched, the synth engine is queried and current
synth settings for each MIDI channel are used.

Warn about missing banks and programs

If a Mixer file is opened and a bank or program used by the file is no
longer installed in the Retro AS-1 Programs folder, the Mixer will display
a warning dialog if this option is checked.

Warn about effect editing control

Global Effects can be modified in the Mixer only when the Retro AS-1
control panel effect setting is set to ‘Fixed.’ When this option is checked,
if the control panel is not set to Fixed, a reminder dialog will appear.

Synthesizer Menu
The Synthesizer menu contains several utility commands, offering
access to other key components of the Retro AS-1 package

All Notes Off

Selecting All Notes Off from the Synthesizer menu stops all
Retro AS-1 sounds from playing. It is a “MIDI panic button”
which is useful for silencing notes that are stuck on as a result
of MIDI controller faults or other problems.

Reset

Selecting Reset from the Synthesizer menu resets the synth engine
and forces all MIDI continuous controller values to be reset to
zero.

Start Record To Disk...

The Record To Disk function writes the stereo output of the synthesizer
engine to your hard drive as an audio file. Whatever the synthesizer is
playing (notes, chords, riffs, arpeggiations, etc, on all MIDI channels,
including effects) is written directly to disk. Complete instructions for
Record To Disk are in Appendix G.

Figure 9.3.4. The Synthesizer
menu.
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Stop Record To Disk

The Stop Record To Disk command ends the Record To Disk process.
This command will have no result unless the Record To Disk function
is active.

Control Panel...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Control Panel, where system-level configuration settings are specified.
For specific information about the control panel, refer to Chapter 5.

Status... (Mac OS only)

Selecting this item from the Synthesizer menu opens the Retro AS-1
Status window, for displaying polyphony and CPU usage. For specific
information about the Status window, refer to Chapter 5.

Keyboard...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Keyboard, for triggering sounds without a MIDI controller. For specific
information about the Mixer, refer to Chapter 8.

Editor...

Selecting this item from the Synthesizer menu opens the Retro AS-1
Editor application, for accessing program voicing parameters. For
specific information about the Editor application, refer to Chapter 7.

MIDI Processor...

Selecting this item from the Synthesizer menu opens the Retro AS-1
MIDI Processor application, for programming splits, layers, and
arpeggiations. For specific information about the MIDI Processor, refer
to Chapter 6.

9.4 Channel Strips
The Mixer contains 16 channel strips; each strip controls the parameters
for a different MIDI channel. 10 channel strips are visible at a time. To
view the rest of the strips, use the standard scroll bars at the bottom of
the Mixer window. Because each of the 16 strips is identical, their
parameters are described only once.
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Bank and Program menus

These parameters determine which program will be heard on the MIDI
channel. When changing these parameters, MIDI bank and program
change values are transmitted to the synthesizer on the MIDI channel
of the strip.

NOTE: For information about Bank and Program organization, see
Appendix B, Working with Banks and Programs.

Bank menu

This menu determines the active bank for the MIDI channel. The sounds
available in the program menu are determined by the bank selection.

If the Editor is open the Editor bank becomes enabled, allowing you to
select the program(s) that are loaded into the Editor with the program
menu.

Program menu

This menu determines the active program for the MIDI channel. The
sounds available in the Program menu are determined by the bank
selection.

To hear programs that are being modified in the Editor, select Editor 1-
16 from this menu. The numbers 1-16 indicate the MIDI channel that
the program is set to on the Editor global page.

Global Slider 1

Determines the send level to global effect processor 1 for the MIDI
channel. For this parameter to have any effect, the FX button must be
on for the channel, the global 1 effect master on/off button must be
on, and the global 1 return value must be increased above zero.

Global Slider 2

Determines the send level to global effects processor 2 for the MIDI
channel. For this parameter to have any effect, the FX button must be
on for the channel, the global 2 effect master on/off button must be
on, and the global 2 return value must be increased above zero.

NOTE: See section 9.1 of this chapter for more information about
global effects behavior.

Figure 9.4.1. The Mixer Channel
Strip. Each strip contains the
controls for a different MIDI

channel.
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Pan Slider

Determines the left/right stereo positioning for the MIDI channel. A
value of 64 will center the sound in the stereo field.

Volume Slider

Determines the output level for the MIDI channel. Volume settings in
the Mixer attenuate volumes set in the program by the Editor on the
global page. This is not a gain stage.

Mute Button

Turns off the output of the MIDI channel so no sound is heard. The
channel is muted when the button is green.

Solo Button

Mutes all channels whose Solo function is not active. Useful for
auditioning a single MIDI channel during multi-timbral operation. The
channel is in solo mode when the button is green.

FX Button

Activates global effect processing for the MIDI channel. For this
parameter to have any effect, the global effect master on/off button
must be on and the send and return level(s) must be increased above
zero. The channel effects are ‘on’ when the button is green.

Level Meter

Gives a visual indication when a sound is playing on the MIDI channel
and what the relative volume of the signal is.

9.5 Master Section

Global Effects Controls
The Global Effects setting in the Retro AS-1 control panel must be set
to ‘Fixed’ to modify the global effects from within the Mixer.

See section 9.1 of this chapter for more information about global
effects behavior.

Because Global Effects 1 and 2 are identical, their controls are detailed
only once.



C
hapter 9: M

ixer Reference

Retro AS-1 Manual

166

NOTE: For an explanation of each specific effect parameter, refer to
Chapter 7, Editor Reference, section 7.5.

Effect Type menu

Determines the type of effect for the Global processor. The available
choices are Delay, Reflections, and Reverb.

Edit Effect button

Opens the parameter windows (figures 9.5.3-5) for the Global Effects
processor. Choosing Global Effect... from the Edit menu performs the
same function.

Master FX On/Off button

Enables the effect processor. The effect is ‘on’ when the button is
green.

Effect Amount Slider

Determines the return level for the global effect processor. For this
parameter to have any effect, the Channel and Master FX button must
be ‘on’ and the global send for a given MIDI channel must be increased
above zero.

Global Level Meter

Gives a visual indication of the effects level for the global effect
processor.

Master Volume Sliders

Determines the overall output level of the synthesizer. The left and
right channels of the stereo output can be adjusted independently.

Master Level Meters

Gives a visual indication of the stereo output level of the synthesizer. Figure 9.5.1. The Master section.

Figure 9.5.2. The Global Effect
Type menu.
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Figure 9.5.3. The global Delay
parameters window.

Figure 9.5.3. The global
Reflections parameters window.

Figure 9.5.3. The global Reverb
parameters window.

NOTE: For an explanation of each
specific parameter, refer to section
7.5 in chapter 7, Editor Reference.
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Program Overview
Retro AS-1 programs are created and modified in the Retro AS-1 Editor
application. Each program is a separate file document and contains all
the voicing parameters for a single sound. Programs that reside inside
the Retro AS-1 Programs folder can be selected from within the Retro
AS-1 MIDI Processor, Keyboard, and Mixer applications or with MIDI
bank and program change commands.

Bank Overview
Retro AS-1 programs are grouped into banks. A bank is a collection of
programs. Banks allow you to arrange related programs together for
quick access when selecting voices with MIDI bank and program change
commands or from within the Retro AS-1 MIDI Processor, Keyboard,
and Mixer applications.

Because the bank and program groupings are completely user-
programmable, you can choose whatever grouping method best suits
your working style. For example, you could put your bass sounds in
one bank, your lead sounds in another bank, and so forth. Or, you
could group all the programs for a particular song into a bank.

Hierarchy Overview
Programs are arranged into banks in the Finder (Mac OS) or My
Computer/Windows Explorer (Windows 95). Arranging programs into
banks is a simple process. The alphabetical order of the programs and
bank folders within the Retro AS-1 Programs folder determines the
bank and program hierarchy. So, to create custom banks, simply create
the desired folder hierarchy within the Retro AS-1 Programs folder.
Give the folders the bank names you want to use, then put the program
files you want in the bank into those folders. That’s it!

NOTE: The 128 programs at the root level of the Retro AS-1
Programs folder are exact duplicates of the ‘Best of Retro AS-1’
bank. You may find it useful to delete these programs at the root
level. You can then replace them with your favorite factory or custom
programs, so they will be grouped in the same bank and accessed
easily without bank change commands.

Appendix A: Working with Banks and Programs
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Mac OS Specifics

The Retro AS-1 Programs folder is placed inside
Retro AS-1 Folder by the Retro AS-1 Installer.
Program files that are not inside the Retro AS-1
Programs folder can reside anywhere; they can be
opened, heard, and modified from within the Editor.
However, they will not be recognized by the Retro
AS-1 MIDI Processor, Keyboard, and Mixer
applications or with MIDI bank and program
change commands.

Because banks and programs are arranged
alphabetically, you will find it easier to work with
the bank and program hierarchy if you view the
Retro AS-1 Programs folder by name. To view the
folder by name, open the Retro AS-1 Programs folder
window, then select ‘by Name’ (System 7) or ‘as
List’ (OS 8) from the View menu in the Finder.
Here’s a “power tip” to quickly view the entire folder
hierarchy: Select all folders in the window
(Command + A), then press Command + Option
+ Right Arrow to open the entire hierarchy of a
folder. Press Command + Option + Left Arrow to
collapse the view.

Retro AS-1 fully supports the file and folder alias
feature of the Mac OS. You can use aliases for any
program file or bank folder. You can have aliases
point to programs or banks inside the Retro AS-1
Programs folder, or you can do the opposite by
having aliases inside the Retro AS-1 Programs folder
point to programs or banks that reside elsewhere.

IMPORTANT! To allow the MIDI Processor,
Keyboard, Mixer, and MIDI Bank/Program change
commands to select banks and programs, an alias
to the Retro AS-1 Programs folder (or the actual
folder itself) with the exact name ‘Retro AS-1
Programs’ must reside at the root level of the active
System Folder. An alias to the Retro AS-1 Programs
folder was placed at the root level of the active
System Folder during installation. If the alias is moved
or renamed there will be no sound output from
the synthesizer unless using the Editor.

Figure A1. The Retro AS-1
Programs folder in Mac OS. The
bank and program hierarchy is
arranged by alphabetical order.
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Windows 95 Specifics

The Retro AS-1 Programs folder is
placed at the root level of the
Windows directory by the Retro AS-
1 Installer. The name of this special
folder is RetroAS1. Program files
that are not inside the Retro AS-1
Programs folder can reside
anywhere; they can be opened,
heard, and modified from within
the Editor. However, they will not
be recognized by the Retro AS-1
MIDI Processor, Keyboard, and
Mixer applications or with MIDI
bank and program change
commands.

Because banks and programs are
arranged alphabetically, you will
find it easier to work with the bank
and program hierarchy if you view
the Retro AS-1 Programs folder by
name. To view the folder by name,
navigate to the Retro AS-1
Programs folder window using My
Computer or Windows Explorer.
Then click Name column to sort the
list by name. If you are currently
viewing by icon, click the list icon
first.

IMPORTANT! Only programs in the Retro AS-1 Programs folder are
recognized by the MIDI Processor, Keyboard, Mixer, and MIDI Bank/
Program change commands. The Retro AS-1 Programs folder with
the exact name ‘RetroAS1’ must reside at the root level of the active
Windows directory. If the folder is moved or renamed there will be
no sound output from the synthesizer unless using the Editor.

Selecting banks and programs via MIDI
The numbering scheme for MIDI program change commands is the
alphabetical order of the programs within a bank. The first alphabetical
program in a bank is MIDI program number 0, the second program is
MIDI program 1, and so forth.

Figure A1. The Retro AS-1
Programs folder in Windows 95.
The bank and program hierarchy
is arranged by alphabetical order.
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Programs at the root level of the Retro AS-1 Programs folder (not in a
bank subfolder) are considered to be in MIDI bank number 0. The
first bank subfolder (in alphabetical order) is MIDI bank number 1,
the second bank subfolder is MIDI bank 2, and so forth.

Although there are only 128 MIDI program changes available (0-127),
by arranging programs into banks you can access more than 128
programs using MIDI bank change commands. Up to 16,384 banks
are supported, allowing selection of 2,097,152 (!!!) different programs
via MIDI.

When creating your bank/program hierarchy, each bank folder should
have no more than 128 program files contained within it. Following
this constraint allows all the programs within the bank to be selected
with MIDI bank and program change commands.

The required MIDI commands
To select programs via MIDI

Send a MIDI program change value between 0 and 127. If no bank
change command is sent before the program change command,
programs within bank 0 will be selected.

To select banks via MIDI

For bank numbers 0 through 127, send controller 0 with a value of 0,
then controller 32 with a value between 0 and 127, with zero being
the root level, 1 being the first bank subfolder, and so forth. Follow the
bank change command with a program change command.

NOTE: We refer to the first program in a bank as MIDI program
number 0 and the first bank as MIDI bank number 0 because these
are the actual MIDI commands used. Many controllers use a
numbering scheme of 1-128 but they are actually transmitting “zero
based” commands.
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Appendix B: Optimizing Performance

Optimizing Overview
Because there is no dedicated hardware to perform certain tasks, the
computer's CPU must handle all synth routines. Therefore, the available
polyphony is dependent upon CPU type, clock and bus speed, voice
complexity, and other applications that may be running simultaneously.
CPU processing resources can be reserved or limited in the Retro AS-
1 control panel, and polyphony can be restricted for use on slower
systems.

Depending upon the speed of your computer, your polyphony
requirements, and other MIDI applications you may be running, the
synthesizer system parameters may need to be “tweaked” to optimize
performance. The Retro AS-1 control panel Configuration parameters
are the primary settings that affect Retro AS-1 performance.

The main cause of CPU overload occurs when too many notes are
played. When the CPU is overloaded, the sound output will stutter or
cut out altogether. To eliminate this problem the Number of Voices,
Maximum CPU %, Sample Rate, and Buffer Length settings must be
optimized for use with your particular environment. These settings
are all interdependent and experimentation is sometimes required to
find the “sweet spot” that works best in your environment.

Performance Variables
There are several parameters within Retro AS-1 and the computer that
will affect CPU performance and polyphony.

NOTE: Chapter 5 contains detailed descriptions of all the Retro AS-
1 control panel parameters.

Retro AS-1 Variables
• Retro AS-1 Control Panel Maximum CPU %: Increase the value

to increase polyphony. How high you can go depends on your
CPU speed and other applications you are running concurrently.
If you are using Retro AS-1 “stand-alone” without other
applications, you can crank it up to 60%. You can’t go to 100%
because the operating software needs some CPU also.

• Retro AS-1 Control Panel Sample Rate: Decrease the value to
increase polyphony. Sometimes you don’t need or want the
crisp highs that a higher sample rate provides. 22050Hz is
perfectly adequate for many applications. You can go down to
8000Hz.
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IMPORTANT! (Mac OS only) Make sure the sample rate set in the
Retro AS-1 control panel matches the Sound Manager setting.
Otherwise, additional processing will be required by the Sound
Manager for sample rate conversions.

• Retro AS-1 Control Panel Buffer Length: Increase the value to
increase polyphony. This parameter can affect the note-on to
sound-out response time (latency). If you are not playing the
synth “live” (for example, you are using a sequencer and the
notes are already input), you could increase this value.

IMPORTANT! The Sample Rate and Buffer Length settings affect
not only the frequency response and latency, but also the resolution
of the voicing parameters. Changing the Sample Rate and Buffer
Length settings can affect the sound of a program. For best results,
voice your programs with the same Sample Rate/Buffer Length
settings that you intend to use them with.

• Retro AS-1 Editor Programs: Turn off unnecessary parameters
to increase polyphony. Oscillators, filters, modulation routings,
and effects all require CPU processing. Always disable unused
oscillators, filters, and effects in a program. Delete modulation
routings and modulators if they are not necessary for the sound.
Set the FM & CM menus to None if the FM/CM Amount is
zero.

Mac OS Variables

There are several factors within the Macintosh operating system that
require CPU processing and may affect performance as well.

• Virtual Memory: Virtual Memory and similar memory allocation
utilities usually degrades performance in many applications,
and can cripple Retro AS-1. We strongly recommend you turn
off VM in the Memory control panel and reboot. The synth
engine itself requires about 6mb of available system RAM to
launch.

• AppleTalk: Turn off AppleTalk in the Chooser unless you need
to be actively on a network. The ‘Warn about AppleTalk’
checkbox in the Retro AS-1 control panel is useful as a reminder
when AppleTalk is on.

• Control Panels and Extensions: Many system components use
background CPU processing. Disable unnecessary Control
Panels and Extensions using the Extensions Manager control
panel or 3rd party utility and reboot. The only absolutely
required extensions for Retro AS-1 in system 7.6.1 or higher is
Shared Library Manager and Shared Library Manager PPC.
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• Retro AS-1/Sound Manager sample rate conflict: Additional CPU
processing is required by the Sound Manager for sample rate
conversions if the Sound Manager setting doesn’t match the
Retro AS-1 setting. Chapter 2 explains how to set the Sound
Manager sample rate.

• Hardware: Buy a faster computer. Ya, easy for us to say...
Windows 95 Variables

There are several factors within the Windows 95 operating system
that require CPU processing and may affect performance as well.

• System extensions: Many system components (such as system
monitors) use background CPU processing. Tiny icons at the
right end of the Taskbar sometimes represent active system-
level items. Disable unnecessary system extensions and reboot.

• Microsoft PLUS! for Windows 95: This system add-on for
Windows 95 WILL degrade Retro AS-1 performance, including
inducing noise, clicks, and pops. We strongly recommend de-
installing Microsoft PLUS! if using Retro AS-1.

• Hardware: Buy a faster computer. Ya, easy for us to say...
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Appendix C: Troubleshooting
Sound Problems
Symptom: No sound output.

Cause: Monitoring system problem.

Fix: Check connections and monitor system volume.

Cause: Sound Manager output level muted or set to zero.

Fix: Increase the Sound Out level in the Sound or Monitors and Sound control panel. See chapter
2 for details.

Cause: Synth engine can’t load sound programs.

Fix: Place the Retro AS-1 Programs folder or its alias with exact name ‘Retro AS-1 Programs’ at
root level of System Folder, or reinstall factory sounds with the Retro AS-1 Installer.

Cause: MIDI Input problem.

Fix: Check MIDI connections and controller settings. Verify Port menu setting within the Retro AS-
1 MIDI Input applications. Very synth engine is functioning by using the Retro AS-1 Keyboard
application.

Symptom: Poor sound quality.

Cause: The Sample Rate setting in the Retro AS-1 control panel is set too low.

Fix: Increase the Sample Rate setting. See Chapter 5 for details.

Cause: The Buffer Length setting in the Retro AS-1 control panel is set too high.

Fix: Decrease the Buffer Length setting. See Chapter 5 for details.

Cause: The Sample Rate setting in the Sound Manager control panel is set too low.

Fix: Increase the Sound Manager sample rate setting. See Chapter 2 for details.

Cause: The Sound Out level in the Sound or Monitors and Sound control panel is not set to
maximum.

Fix: Increase the Sound Manager output level. See Chapter 2 for details.

Cause: Poor quality monitoring system.

Fix: Use good quality headphones or amplifier/speaker combination.
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Symptom: Sound output is choppy, stutters, and/or cuts out.

Cause: CPU is overloaded by requesting too many notes.

Fix: Play less notes and/or modify the configuration settings in the Retro AS-1 control
panel. See Chapter 5 for details.

MIDI & Input Problems
Symptom: ‘Port is in use by another application’ window when launching the
Serial/OMS/FreeMIDI Input applications.

Cause: It’s really true...

Fix: Select a different serial port or quit the application(s) using the requested port.
Sometimes it’s not obvious what is using the port. Fax and modem software, AppleTalk,
OMS, and FreeMIDI are the most common culprits. Often, merely turning off the software
is not enough to release the port(s); you may need to disable its associated extensions
and reboot. Disabling AppleTalk does not release the printer port; you need to “unload”
AppleTalk by rebooting the system after it is disabled.

Symptom: ‘This Macintosh does not have the hardware required to support the
Serial DMA driver’ window when launching Retro AS-1 Serial Input.

Cause: The Serial (Built-in) library file is not in your Extensions folder.

Fix: This is the Mac OS Serial DMA support file. Install/enable the file and reboot.

Cause: Your Mac OS system does support direct memory access to the serial port(s).

Fix: Use OMS or FreeMIDI in conjunction with Retro AS-1 OMS/FreeMIDI Input and
Retro AS-1 OMS/FreeMIDI Drivers. See Chapter 4 for more information.

Symptom: Poor “live play” response time (latency).

Cause: Virtual Memory is on.

Fix: Turn of Virtual Memory in the Memory control panel and reboot.

Cause: Buffer Length setting is too high.

Fix: Decrease the Buffer Length setting. See Chapter 5 for details.

Symptom: Can’t select Retro AS-1 as destination in OMS/FreeMIDI applica-
tions.

Cause: The Retro AS-1 OMS/FreeMIDI Drivers have not been configured.

Fix: Configure the Retro AS-1 MIDI Drivers using the instructions in Chapter 4.
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Symptom: Double note triggers; flanged/chorused sound with effects off.

Cause: The Retro AS-1 OMS or Retro AS-1 FreeMIDI Input applications are open at the
same time as an OMS/FreeMIDI application.

Fix: Retro AS-1 OMS/FreeMIDI Input are used ONLY when OMS/FreeMIDI applications
are NOT open. Quit the MIDI application(s) or use the MIDI application’s “Play Through”
feature to trigger the synth instead.

Polyphony Problems
Symptom: Suddenly performance is poorer than previously experienced.

Cause: Another application is hogging the CPU.

Fix: Increase the CPU % setting in the Retro AS-1 control panel and restart the synth.
See Chapter 5 for more information.

Symptom: MIDI applications are sluggish (poor timing, slow screen redraws,
etc.) when Retro AS-1 is active.

Cause: Retro AS-1 is hogging the CPU.

Fix: Decrease the CPU % setting in the Retro AS-1 control panel and restart the synth.
See Chapter 5 for more information.

Symptom: There is simply not enough polyphony.

Cause: Retro AS-1 is complex, CPU-hungry software.

Fix: Optimize system configuration settings and program voicing parameters. See
Appendix B for more information.

Retro AS-1 Application Problems
Symptom: ‘Can’t connect to synthesizer’ when launching Retro AS-1 applica-
tions.

Cause: Not enough available RAM. There must be enough free RAM for Retro AS-1
application(s) and the synthesizer engine. The synth engine itself requires approximately
6 MB RAM.

Fix: Quit unused applications and/or reduce system size by eliminating unnecessary
components. If it appears you have plenty of memory available, your RAM may be
fragmented. Reboot to defragment RAM.
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Symptom: Changing a parameter in the Editor has no effect.

Cause: The parameter is being controlled by a modulator.

Fix: Decrease the modulation routing amount for the destination. Here’s an example. If
the filter 1 cutoff parameter on the main page has no effect, go to the modulation page.
A modulation routing probably has Filter 1 cutoff as a destination. Select the routing in
the list then lower the value of the modulation Amount slider.

Symptom: The Global Effects don’t sound or behave erratically.

Cause: The Global Effects settings in the Retro AS-1 control panel aren’t configured the
way you want.

Fix: Change the Global Effects setting in the control panel. See Chapter 5 for details.

Symptom: Can’t control a modulation routing “initial amount” when using a
continuous controller assigned to that modulator’s destination amount.

Cause: A continuous controller’s range is between zero and the destination amount.

Fix: Add another modulation routing.

Symptom: Can’t hear sounds being modified in the Editor when using the MIDI
Processor, Keyboard or Mixer.

Cause: The Processor, Keyboard and Mixer load sounds from disk but the Editor sound
is in RAM.

Fix: Select Editor from the Bank and Program pull down menus in the Retro AS-1
applications.

Symptom: MIDI program change commands select the wrong sounds when the
MIDI Processor is active.

Cause: When the MIDI Processor is active, program change commands select Setups
instead of programs.

Fix: Quit the MIDI Processor or disable the “MIDI Program Change Selects Setup” option
in the MIDI Processor Preferences window.
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Appendix D: Using Digidesign Direct IO
This appendix applies to the Mac OS only. It explains how Retro AS-1
works with Digidesign’s Direct IO v2.1 software interface.

Overview
Direct IO is Digidesign’s software interface that allows third-party
developers (such as BitHeadz) to develop drivers for accessing
Digidesign audio hardware. Retro AS-1 output is normally sent to a
disk file or the Sound Manager, where it is processed to match the
Sound/Monitors and Sound control panels settings then sent to the
audio outputs. Using the Direct IO settings in the Retro AS-1 control
panel, the Sound Manager can be bypassed altogether if a Digidesign
audio card is installed.

Note: any digital audio card can be used for Retro AS-1 output if
the card is supplied with a Sound Manager driver.

One advantage of using Direct IO is separate Retro AS-1 MIDI channels
can be routed to individual audio outputs!

Components Required for Direct IO support
1. Digidesign PCI digital audio card (Nubus is not supported)
2. Digisystem INIT extension version 3.3 or higher
3. Retro AS-1 version 1.11 or higher

Configuring Retro AS-1 for use with Direct IO
1. Verify the Digidesign hardware is

working correctly before configuring
Retro AS-1. Consult the documentation
that came with the hardware.

2. Open the Retro AS-1 control panel.

3. Select Direct IO from the Audio Output
pull-down menu.
The Direct IO menu and Setup button appear.
If Direct IO is grey and unavailable for
selection, verify the audio card and
Digisystem Init version 3.3 or higher are
properly installed.

Figure D1. After selecting Direct
IO in the Retro AS-1 control

panel, the Direct IO parameters
appear.
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4. Click the Direct IO Setup...
button.
The Digidesign Hardware Setup
dialog appears.

5. Confirm your hardware
settings (modify if necessary),
then click Done.

6. Select Stereo or Individual
mode from the Direct IO
menu.
See details in the ne xt section.

7. Close the Retro AS-1 control
panel, saving the new
settings.
Retro AS-1 is now configured to bypass the Sound Manager and
use the Digidesign hardware for output instead.

How It Works
Retro AS-1 has two modes of operation when used with Direct IO:
Stereo and Individual. The mode used is determined by the Direct IO
Stereo/Individual menu in the Retro AS-1 control panel. Each mode is
described below.

Stereo Mode

When Stereo mode is selected, the Retro AS-1 stereo output is sent to
all stereo pairs, including digital outputs, simultaneously. On
Audiomedia III cards, the analog and digital outputs carry the same
signal. On 8-channel audio interfaces, outputs 1+2, 3+4, 5+6, 7+8,
and the digital outs act as stereo pairs. They all carry the same signal.

Using stereo mode maintains the ability to use MIDI Pan commands
per MIDI channel and the stereo Global Effects processors.

Individual Mode

When Individual mode is selected, Retro AS-1
MIDI channels are "hard wired" to the
corresponding Digidesign audio outputs. For
example, if you have an 8-channel audio
interface, Retro AS-1 MIDI channel 1 output is
sent to audio output 1; MIDI channel 2 is sent to
audio output 2, and so forth.

Figure D3. The Direct IO
Hardware Setup window.

Figure D4. When Individual
mode selected, each MIDI

channel is routed to a separate
audio output.
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When using Individual mode with an Audiomedia III card, the analog
outputs correspond to MIDI channels 1 and 2; the digital outputs
correspond to MIDI channels 3 and 4.

When using Individual mode with an 8-channel audio interface, the
analog outputs correspond to MIDI channels 1 through 8; the AES/
EBU digital outputs also correspond to MIDI channels 1 through 8. If
you have an 882 or similar audio interface that has only 2 channels of
SP/DIF digital output, MIDI channels 1+2 are sent to the digital output.

When using individual mode, only MIDI channels 1-8 are supported.
Channels 9-16 will have no output. Additionally, the stereo Global
Effects processors cannot be heard in individual mode. This is due to
architectural limitations. When in individual mode, we recommend
disabling the Global Effects processors in the Retro AS-1 control panel
to conserve CPU processing.

Another Important Note

“Live play” response time (latency) may actually be greater when using
Direct IO. This is because the note-on to sound-out latency is partially
determined by the buffer length, which is (in simple terms) how often
Retro AS-1 sound is passed to the output. The buffer length is variable
in the Sound Manager, and the Buffer Length setting in the Retro AS-
1 control panel can be set to as little as 32, meaning that the synth
output is passed to the Sound Manager every 32 samples (smaller
buffer length = less latency). However, Digidesign has a locked buffer
length value in Direct IO that is fixed at 512 samples. As of this writing,
Digisystem Init version 3.4 is in testing. Version 3.4 has a buffer length
of 256, effectively halving the latency. Check Digidesign’s web site at
www.digidesign.com for the latest versions of their software.

http://www.digidesign.com/
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Appendix E: Analog Synthesis Demystified
This appendix explains some analog synthesis basics. It is intended for people just
getting started with synthesizers and electronic music.

Concepts
The humble beginnings of analog synthesis began with huge systems consisting of
dozens of various components. Each component “module” performed a different
electronic function (such as oscillator, filter, amplifier, etc.) and had a signal input and
output (“I/O”) jack. Using dozens of individual signal cables, the synthesist would
manually connect (“patch”) multiple modules together then tweak the module settings
to produce a particular audio result. Thus modular analog synthesis was born. To this
day, a modern synthesizer program is still referred to as a patch.

While the quality and variety of sounds these systems could produce was truly mind-
boggling, they were not embraced by the typical musician because they were expensive,
non-portable, and it was difficult to coax a usable sound out of them without an advanced
knowledge of audio acoustics theory.

Then Bob Moog realized that if he selected the most common modules, “hard wired”
the most common signal routings, and put it all in a rugged, portable enclosure with a
voltage controller that acted like a piano keyboard, musicians would be able to bring
electronic music to the masses. Thus the MiniMoog was born.

These early machines all relied on a process called subtractive synthesis. Since those
times, synthesis has evolved to include many types of sound creation and manipulation
including additive, frequency modulation (“FM”), sample playback (“wavetable”),
physical modeling, granular, various combinations thereof, and more.

Subtractive synthesis came to be known as “analog” synthesis because the signals in
the modules used analog (as opposed to digital) electrical components. Retro AS-1 uses
analog synthesis as its model for sound creation. The following sections provide some
details about this process.

The Building Blocks
Explanation of signal flow in the subtractive synthesis model is more easily digested if
broken down into explanations of the basic modular components.

Oscillators
The primary building block of analog synthesis is the oscillator. An oscillator is the only
part of the process that actually generates a sound. The purpose of all the other modules
is to modify the signal from the oscillator.
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Retro AS-1 produces five primary waveforms shapes: sawtooth, pulse, triangle, sine,
and noise. However, an extremely wide range of waveform shape variations can be
generated. The Symmetry control modifies the basic shape. By modulating an oscillator
with itself or another oscillator using Sync (forcing a waveform to begin its cycle
prematurely) and FM emulation (modulating the frequency of a waveform with a different
frequency), more complex shapes can be generated. Each waveform has its own sound
due to its unique harmonic overtone structure.

Retro AS-1 allows up to three oscillators to be used per program. Each can have its own
shape, modulation(s), filter routings, etc.

Filters
Filters are a major building block in synthesis, and arguably affect the sound quality
more than any other process. Filters work by removing (subtracting) harmonic content
from a waveform, resulting in a different shape and therefore a different sound. This is
how subtractive synthesis got its name.

There are lots of different filter types, and each creates a different tone (“timbre“).
Although the filter types behave differently, they all share two characteristics called the
filter cutoff frequency and slope.

Slope determines how “steep” a filter is, or in other words, how much harmonic content
is removed in relation to the cutoff frequency. The cutoff frequency is the point in the
frequency spectrum where filtering begins to take affect. In a lowpass filter, frequencies
above the cutoff frequency are “rolled off” at a rate determined by the slope. A higher
cutoff frequency will provide a brighter sound because higher frequencies are allowed
to pass. The terms 1 Pole, 2 Pole, and 4 Pole are referring to different filter slopes.

Some filter types have resonance, where the filter output is routed back to the filter
input. This changes the shape of the frequency response curve, and therefore the resulting
waveform output. Resonance is what enables the whistling, chirpy quality common in
so many analog programs.

Retro AS-1 provides seven filter types to enable a wide range of sonic possibilities. Up to
two filters can be used per program. One, two, or all three oscillators can be routed
through one or both filters. Each filter can accept input from the other filter, allowing for
serial or parallel filtering effects. This can effectively double the available filter slope,
for up to 48 decibels (db) per octave of filter roll-off. Our filters can be overdriven for
distortion, and be made to self-oscillate with resonance. And all filter controls are available
as a modulation destination for dynamic timbre changes over time. You will find many
new ways to create rich new textures with the Retro AS-1 filters.

Modulation
Modulation is the “juice” of creative sound design in synthesis. Modulation is what
makes a static, unchanging sound come to life by modifying the timbre and amplitude
(volume) of a sound dynamically over time or with MIDI performance controls such as
the Mod wheel or aftertouch.
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Modulation begins with a modulation source. A modulation source can be a low frequency
oscillator (“LFO”), contour control (“envelope”), MIDI controllers such as velocity, mod
wheel, aftertouch, and breath control, or even another parameter’s output such as an
oscillator or filter.

After choosing a modulation source, a modulation destination is selected. A modulation
destination can be almost any other parameter, such as volume, filter cutoff, oscillator
pitch, or whatever. This process completes the modulation routing (“patch”) that connects
the source to the destination.

The modulation routing will not have any effect until the modulation amount is set. The
modulation amount determines just how much modulation will take place. For example:
In a routing with LFO to pitch, a small modulation amount produces a bit of vibrato
with a range close to the original pitch. A large modulation amount produces wild pitch
sweeps that could range over an octave or more.

Modulation Amount Interaction

Modulation amounts are a bit more complicated (or flexible, depending on your
perspective!). How a modulation amount responds depends upon the initial parameter
setting. The modulation amount value is in most cases summed (added) to the existing
value of the modulation destination.

Here is an example. In Retro AS-1, let’s say the filter 1 cutoff value on the Editor main
page is set to 50 (this is known as the “initial amount”). If a modulation routing destination
is set to filter 1 cutoff with a modulation amount of 50, the resulting filter cutoff would
be 100 (initial amount of 50 + destination amount of 50 = 100). If the initial filter
cutoff amount on the main page is set to 75 and the modulation amount is set to -50, the
resulting filter cutoff would be 25 (75–50=25). Therefore, for a modulation routing to
have any effect, the initial amount of the modulation destination (in this example the
filter 1 cutoff value on the main page) must be less than its maximum possible setting
(100) for a positive modulation amount value. Conversely, the initial amount of the
modulation destination must be more than its minimum possible setting (0) for a negative
modulation amount value.

The total resulting parameter value (initial amount plus modulation amount) can never
exceed the maximum possible initial amount for a parameter. For example, if the initial
filter 1 cutoff amount on the main page is set to 50 and a modulation routing destination
is set to filter 1 cutoff with an amount of 75, the resulting filter 1 cutoff value would only
be 100 (not 125) because 100 is the maximum possible setting for filter 1 cutoff.

Modulation Recapitulation

To make modulation happen there must be:

1. A modulation source.
2. A modulation destination.
3. A modulation amount.
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The modulation rules:

1. The initial amount of the modulation destination must be less than its maximum
possible setting for a positive modulation amount, or more than its minimum possible
setting for a negative modulation amount.

2. The total parameter amount (initial amount plus modulation amount) can never
exceed the maximum possible initial amount for the parameter.

In Retro AS-1, we call modulation sources Modulators, and they are created and modified
in the Modulators section on the right hand side of the Editor modulation page.
Modulation destinations and amounts are set in the Routings section on the left hand
side of the Editor modulation page.

Retro AS-1 allows extremely powerful and flexible modulations. You can have one
modulator go to multiple destinations, one destination can have multiple modulators,
and a modulator can modulate another modulators’ amount. The number of modulators
and routings is limited only by CPU processing capability.

Effects
Effects processing can have a profound result on a sound, often becoming critical to the
character of the program. In the early years, effects were limited to signal routing and
filtering tricks. With today’s fancy computers, complex equalizers and time-based effects
such as delay and reverb have become the norm.

Retro AS-1 features four effects processors. The two monophonic insert processors are
placed in series (one after the other) after the filter but before the output. Each program
can have two different serial effects active, and if the synth is used multi-timbrally
(different programs on different MIDI channels concurrently), each program maintains
its own settings.

The two Global processors are placed in parallel at the stereo mixer. If the synth is used
multi-timbrally, the parallel effects process all the programs on different MIDI channels
with the same effect settings. This is how effects processors are typically used with a
mixing console. In Retro AS-1, the global effects processors are true stereo, with stereo
inputs and outputs.

Output
Finally, the synthesizer signals output signals are summed by a mixer and sent to the
output. In Retro AS-1, the stereo output is routed to the Sound Manager, Direct IO (Mac
OS only), or a disk file.

The Sound Manager is the component of the Mac OS that controls the audio output
hardware. The Sound Manager delivers the digital signal to the digital-to-analog converters
(“DAC”) then to the audio output jack, where you connect your audio inputs such as
headphones or a stereo system.
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Direct IO is a software “middleman” system made by Digidesign (a manufacturer of
digital audio hardware and software) that allows third-party software companies (such
as BitHeadz) to communicate with Digidesign hardware. With a Digidesign digital audio
card and Direct IO, the Sound Manager is bypassed altogether, and the higher-fidelity
analog and digital outputs of the audio card are used instead.

Using Record To Disk, the synthesizer output goes straight to a disk file in the Audio
Interchange File Format, which can then be used for audio CD’s or loaded into digital
audio and multimedia applications for additional processing without ever being converted
to the analog domain.

Hang In There!

Synthesis is complex and can be complicated at first. However, the reward of mastering
the fundamental concepts is the ability to create a desired sound by knowing what
controls to tweak instead of just trial and error. You can learn a lot by experimentation
and examining the settings of the factory programs.

A synthesizer is unique for its ability to manifest sounds that can create a powerful
mood with just one note. We hope Retro AS-1 will help you define your own sonic
signature!
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Appendix F: MIDI Implementation

I. The Official MIDI Implementation Chart

Product Name: Retro AS-1 by BitHeadz, Inc. Version 1.10 Date: 6/12/98

FUNCTION TRANSMITTED RECOGNIZED REMARKS

Basic Channel
Default

Changed
X
X

1-16
1-16

Always in Mode 3
(Omni Off, Poly)

Mode
Default

Messages
Altered

X
X

N/A

Mode 3
X
X

Note Number
True Voice

X
N/A

0-127
0-127

Velocity
Note On
Note Off

X
X

O
X

Aftertouch
Key's (poly)

Channel (mono)
X
X

O
O

Pitch Bend X O

Control Change X O Full listing in this section

Program Change
True Number

X
N/A

O
0-127

MIDI Bank Change
Commands are supported

System Exclusive X O Full listing in this section

System Common
Song Position

Song Select
Tune Request

X
X
X

X
X
X

System Realtime
Clock

Commands
X
X

O
X

Delay FX, LFO, &
arppegiator times can

sync to MIDI Clock

Aux Messages

Local On/Off
All Notes Off

Active Sensing
System Reset

X
X
X
X

X
O
X
O

Also All Sound Off,
Controller 120

Notes:

O=Yes
X=No
N/A=Not
Applicable

BitHeadz SysEx
ID Number:

278 (Decimal)
0120 (Hex)

Full control of all voicing
parameters via MIDI Non-

Registered Parameter
Numbers ("NRPN's")
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0 bank select high
6 data entry high
7 volume
10 pan
16 Controller A
17 Controller B
18 Controller C
19 Controller D
20 mute
21 solo
32 bank select low
38 data entry low
64 sustain pedal
70 osc 1 volume
71 osc 2 volume
72 osc 3 volume
73 filter 1 cutoff
74 filter 1 resonance
75 filter 2 cutoff
76 filter 2 resonance
77 envelope 1 attack
78 envelope 1 dec ay
79 envelope 1 release

II. Supported MIDI Control Numbers
Advanced MIDI knowledge is not required to use the MIDI Controller implementation; this is a
“decimal situation.” There are no fancy tricks here, just basic controller commands that are
implemented in most modern MIDI controllers and software.

Example MIDI Control commands
• First, send the controller number of the parameter you want to change.

• Second, send the controller value. That’s it!

Two Real-World Examples
Change Master Volume
• Send controller number 7 with value of 0-127. Done!

Change Oscillator 1 Volume
• Send controller number 70 with value of 0-127. Done!

The MIDI Controllers
Value Parameter

85 open sound in Editor
91 effects 1 depth
92 effects 2 depth
96 data increment
97 data decrement
98 non-registered parameter lsb
99 non-registered parameter msb
120 all sound off
121 reset controllers
123 all notes off

Assignable Controllers A/B/C/D
1 modulation wheel
2 breath control
4 foot con trol
11 expression controller

Assignable Pedal
64 sustain pedal
65 portamento on/off
66 sostenuto
67 soft pedal
68 legato footswitch
69 hold 2

NOTES :
1. Assignments for Controllers A/B/C/D and Pedal
are set in the Retro AS-1 control panel.
2. For Pedal controller numbers 64 through 69, a
value of 0-64 = off. A value of 65-127 = on.
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III. System Exclusive Commands
Master Volume ($F0 $7F $00 $04 $01 $VL $VH $F7)
Master Balance ($F0 $7F $00 $04 $02 $VL $VH $F7)
Master Global 1 ($F0 $00 $01 $20 $00 $00 $00 $VL $VH $F7)
Master Global 2 ($F0 $00 $01 $20 $00 $00 $01 $VL $VH $F7)
Master Left ($F0 $00 $01 $20 $00 $01 $00 $VL $VH $F7)
Master Right ($F0 $00 $01 $20 $00 $01 $01 $VL $VH $f7)

VL = Value Low (lsb)
VH = Value High (msb)

IV. Non-Registered Parameter Numbers (“NRPNs”)
This is the serious “low level” MIDI section. If you can understand and implement NRPNs,
consider yourself graduated with Honors from DSEMH, the Distinquished School of Electronic
Music Hacks!

We chose to implement extensive MIDI control with NRPNs as opposed to MIDI System Exclu-
sive because NRPN commands are MIDI channel-specific. Using NRPNs enable you to control
the programs on each separate MIDI channel simultaneously.

Notes about NRPN control
• Parameter number selections are divided into two 7-bit controller values, msb and lsb.
NRPN Controller 99 value is the PARAMETER NUMBER MSB.
NRPN Controller 98 value is the PARAMETER NUMBER LSB.

• Parameter value selections are divided into two 7-bit controller values, msb and lsb.
NRPN Controller 06 value is the PARAMETER VALUE MSB.
NRPN Controller 38 value is the PARAMETER VALUE LSB.

• On/Off parameters are controlled as value 0 ($00 $00)= Off,and value 1 ($00 $01)= On
Examples: Oscillator and Filter On/Off buttons.

• Pop-up menus and radio buttons with more than one value are controlled as value 0 ($00
$00) = 0, value 1($00 $01) = 1, and so forth.
Examples: Waveform shapes, filter types, modulator types, etc.

• Slider values can be positive, or positive and negative in the case of modulation routing
amounts.
Positive slider values range from 0 ($00 $00) to 100 ($7F $7F).
Bipolar slider values range from -100 ($00 $00) to100 ($7F $7F); a zero value is ($40 $00).
($40)=64 decimal
NOTE: User interface values range from -100 to 100. The synth engine internally uses floating
point values from –1.0 to +1.0
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NRPNs, continued

Example MIDI Byte Command Strings
4 MIDI command strings of 3 bytes each are required.
First, send the “parameter number” hex commands:
($B0 $63 $PH) Controller 99 (nrpn msb), then parameter number msb
($B0 $62 $PL) Controller 98 (nrpn lsb), then parameter number lsb
Then, send the “parameter value” hex commands:
($B0 $06 $VH) Controller 6 (data slider msb), then parameter value msb
($B0 $26 $VL) Controller 38 (data slider lsb), then parameter value lsb

Some definitions
hex = hexadecimal
PH = parameter high (msb) in hex
VH = value high  (msb) in hex
PL = parameter low (lsb) in hex
VL = value low (lsb) in hex
($B0 $63) = controller 99 (nrpn msb) in hex
($B0 $62) = controller 98(nrpn lsb) in hex
($B0 $06) = controller 6 (data slider msb) in hex
($B0 $26) = controller 38 (data lsb) in hex
msb = most significant bit
lsb = least significant bit
($B0 $63 $00) = standard hex nomenclature for 3 bytes (Leave out $ in the actual byte trans-
mission)

Some “Real-World” NRPN Examples

SET FILTER 1 RESONANCE TO 50
In Hex:
($B0 $63 $00) Controller 99 (nrpn msb), then Filter 1 Resonance msb (from Table 1)
($B0 $62 $2C) Controller 98 (nrpn lsb), then Filter 1 Resonance lsb (from Table 1)
($B0 $06 $40) Controller 6 (data slider msb), then msb of value 64
($B0 $26 $00) Controller 38 (data slider lsb), then lsb of value 0

In decimal:
First, send controller 99, value=0 (the nrpn msb from Table 1)
Next, send controller 98, value=44 (the nrpn lsb from Table 1)
Next, send controller 6,  value=64 (the value msb)
Next, send controller 38, value=0 (the value lsb)
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CHANGE OSCILLATOR THREE WAVEFORM TO PULSE
In Hex:
($B0 $63 $00) Controller 99 (nrpn msb), then Oscillator 3 Type msb from Table 1
($B0 $62 $19) Controller 98 (nrpn lsb), then Oscillator 3 Type lsb from Table 1
($B0 $06 $00) Controller 6 (data slider msb), then msb of value 2 from Table 2
($B0 $26 $02) Controller 38 (data slider lsb), then lsb of value 2 from Table 2

In decimal:
First, send controller 99, value=0 (the nrpn msb) from Table 1
Next, send controller 98, value=25 (the nrpn lsb) from Table 1
Next, send controller 6, value=0 (the value from Table 2 msb)
Next, send controller 38, value=2 (the value from Table 2 lsb)

CHANGE MODULATION ROUTING #4 AMOUNT TO -75
In Hex:
($B0 $63 $18) Controller 99 (nrpn msb), then Routing Amount msb from Table 13
($B0 $62 $3C) Controller 98 (nrpn lsb), then Routing Amount lsb from Table 1
($B0 $06 $10) Controller 6 (data slider msb), then msb of value -75
($B0 $26 $00) Controller 38 (data slider lsb), then lsb of value -75

In decimal:
First, send controller 99, value=24 (the nrpn msb) from Table 13
Next, send controller 98, value=60 (the nrpn lsb) from Table 1
Next, send controller 6, value=16 (the value msb)
Next, send controller 38, value=0 (the value lsb)

The NRPN Tables
The NRPN reference tables begin on the next page. The first column is the parameter number
or value in decimal. The second column (in parenthesis) contains the msb and lsb of the pa-
rameter or value in decimal. The third column (in paranthesis, with dollar sign) contains the
msb and lsb parameter or value number in hexadecimal. The fourth column is the name of the
parameter or value.
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TABLE 1
PARAMETER NUMBER VALUES

00 (000 000) ($00 $00) None
 -
[OSCILLATORS]
01 (000 001) ($00 $01) Osc 1 Enable, 0=off, 1=on
02 (000 002) ($00 $02) Osc 1 Keyboard Track, 0=off, 1=on
03 (000 003) ($00 $03) Osc 1 Type, value from Table 2
04 (000 004) ($00 $04) Osc 1 Sync Source, value from Table 3
05 (000 005) ($00 $05) Osc 1 FM Source, value from Table 3
06 (000 006) ($00 $06) Osc 1 Coarse Tune
07 (000 007) ($00 $07) Osc 1 Fine Tune
08 (000 008) ($00 $08) Osc 1 Random
09 (000 009) ($00 $09) Osc 1 Symmetry
10 (000 010) ($00 $0A) Osc 1 FM Amount
11 (000 011) ($00 $0B) Osc 1 Volume
 -
12 (000 012) ($00 $0C) Osc 2 Enable, 0=off, 1=on
13 (000 013) ($00 $0D) Osc 2 Keyboard Track, 0=off, 1=on
14 (000 014) ($00 $0E) Osc 2 Type, value from Table 2
15 (000 015) ($00 $0F) Osc 2 Sync Source, value from Table 3
16 (000 016) ($00 $10) Osc 2 FM Source, value from Table 3
17 (000 017) ($00 $11) Osc 2 Coarse Tune
18 (000 018) ($00 $12) Osc 2 Fine Tune
19 (000 019) ($00 $13) Osc 2 Random
20 (000 020) ($00 $14) Osc 2 Symmetry
21 (000 021) ($00 $15) Osc 2 FM Amount
22 (000 022) ($00 $16) Osc 2 Volume
 -
23 (000 023) ($00 $17) Osc 3 Enable, 0=off, 1=on
24 (000 024) ($00 $18) Osc 3 Keyboard Track, 0=off, 1=on
25 (000 025) ($00 $19) Osc 3 Type, value from Table 2
26 (000 026) ($00 $1A) Osc 3 Sync Source, value from Table 3
27 (000 027) ($00 $1B) Osc 3 FM Source, value from Table 3
28 (000 028) ($00 $1C) Osc 3 Coarse Tune
29 (000 029) ($00 $1D) Osc 3 Fine Tune
30 (000 030) ($00 $1E) Osc 3 Random
31 (000 031) ($00 $1F) Osc 3 Symmetry
32 (000 032) ($00 $20) Osc 3 FM Amount
33 (000 033) ($00 $21) Osc 3 Volume

[FILTERS]
Note: Depending on Filter Type selection, some parameters will
not be active.

34 (000 034) ($00 $22) Filter 1 Enable, 0=off, 1=on
35 (000 035) ($00 $23) Filter 1 Type, value from Table 4
36 (000 036) ($00 $24) Filter 1 CM Source, value from Table 3
37 (000 037) ($00 $25) Filter 1 Input Osc 1, 0=off, 1=on
38 (000 038) ($00 $26) Filter 1 Input Osc 2, 0=off, 1=on
39 (000 039) ($00 $27) Filter 1 Input Osc 3, 0=off, 1=on
40 (000 040) ($00 $28) Filter 1 Input Filter 2, 0=off, 1=on
41 (000 041) ($00 $29) Filter 1 Cutoff
42 (000 042) ($00 $2A) Filter 1 Spread

43 (000 043) ($00 $2B) Filter 1 CM Amount
44 (000 044) ($00 $2C) Filter 1 Resonance
45 (000 045) ($00 $2D) Filter 1 Overdrive
-
46 (000 046) ($00 $2E) Filter 2 Enable, 0=off, 1=on
47 (000 047) ($00 $2F) Filter 2 Type, value from Table 4
48 (000 048) ($00 $30) Filter 2 CM Source, value from Table 3
49 (000 049) ($00 $31) Filter 2 Input Osc 1, 0=off, 1=on
50 (000 050) ($00 $32) Filter 2 Input Osc 2, 0=off, 1=on
51 (000 051) ($00 $33) Filter 2 Input Osc 3, 0=off, 1=on
52 (000 052) ($00 $34) Filter 2 Input Filter 1, 0=off, 1=on
53 (000 053) ($00 $35) Filter 2 Cutoff
54 (000 054) ($00 $36) Filter 2 Spread
55 (000 055) ($00 $37) Filter 2 CM Amount
56 (000 056) ($00 $38) Filter 2 Resonance
57 (000 057) ($00 $39) Filter 2 Overdrive
 -
[ROUTINGS]
58 (XXX 058)($XX $3A)Routing Source,

XX = index from Table 13, value from Table 14
59 (XXX 059)($XX $3B)Routing Destination,

XX = index from Table 13, value from Table 15
60 (XXX 060)($XX $3C)Routing Amount,

XX = index from Table 13, value -100 to 100

[MODULATORS]
61 (XXX 061) ($XX $3D)Modulator Trigger,

XX = index from Table 13, value from Table 5
 -
62 (XXX 062)($XX $3E) Envelope Attack,

XX = index from Table 13
63 (XXX 063)($XX $3F) Envelope Decay,

XX = index from Table 13
64 (XXX 064)($XX $40) Envelope Sustain Level,

XX = index from Table 13
65 (XXX 065)($XX $41) Envelope Sustain Decay,

XX = index from Table 13
66 (XXX 066)($XX $42) Envelope Release,

XX = index from Table 13
 -
67 (XXX 067)($XX $43) LFO Type,

XX = index from Table 13, value from Table 6
68 (XXX 068)($XX $44) LFO Random,

XX = index from Table 13
69 (XXX 069)($XX $45) LFO Delay, XX = index from Table 13
70 (XXX 070) ($XX $46) LFO Speed, XX = index from Table 13
71 (XXX 071) ($XX $47) LFO Sync, XX = index from Table 13
72 (XXX 072)($XX $48) LFO Division,

XX = index from Table 13, value from Table 16
 -
73 (XXX 073)($XX $49) Random Filter,

XX = index from Table 13
 -
74 (XXX 074)($XX $4A)Ramp Delay,

XX = index from Table 13
75 (XXX 075)($XX $4B)Ramp Speed,

XX = index from Table 13
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[INSERT EFFECTS]
76 (000 076) ($00 $4C) Insert 1 Enable, 0=off, 1=on
 -
77 (000 077) ($00 $4D) Parametric EQ 1 Frequency
78 (000 078) ($00 $4E) Parametric EQ 1 Q
79 (000 079) ($00 $4F) Parametric EQ 1 Gain
 -
80 (000 080) ($00 $50) Shelf EQ 1 Low Frequency
81 (000 081) ($00 $51) Shelf EQ 1 Low Gain
82 (000 082) ($00 $52) Shelf EQ 1 High Frequency
83 (000 083) ($00 $53) Shelf EQ 1 High Gain
 -
84 (000 084) ($00 $54) Flange 1 Delay
85 (000 085) ($00 $55) Flange 1 Feedback
86 (000 086) ($00 $56) Flange 1 Speed
87 (000 087) ($00 $57) Flange 1 Depth
88 (000 088) ($00 $58) Flange 1 Mix
 -
89 (000 089) ($00 $59) Chorus 1 Delay
90 (000 090) ($00 $5A) Chorus 1 Feedback
91 (000 091) ($00 $5B) Chorus 1 Speed
92 (000 092) ($00 $5C) Chorus 1 Depth
93 (000 093) ($00 $5D) Chorus 1 Mix
 -
94 (000 094) ($00 $5E) Phaser 1 Delay
95 (000 095) ($00 $5F) Phaser 1 Amount
96 (000 096) ($00 $60) Phaser 1 Speed
97 (000 097) ($00 $61) Phaser 1 Depth
98 (000 098) ($00 $62) Phaser 1 Mix
 -
99 (000 099) ($00 $63) Insert Delay 1 Delay 1
100 (000 100) ($00 $64) Insert Delay 1 Division 1,

value from Table 16
101 (000 101) ($00 $65) Insert Delay 1 Feedback 1
102 (000 102) ($00 $66) Insert Delay 1 Delay 2
103 (000 103) ($00 $67) Insert Delay 1 Division 2,

value from Table 16
104 (000 104) ($00 $68) Insert Delay 1 Feedback 2
105 (000 105) ($00 $69) Insert Delay 1 Mix
106 (000 106) ($00 $6A) Insert Delay 1 MIDI Sync,

0=off, 1=on
 -
107 (000 107) ($00 $6B) Overdrive 1 Gain
108 (000 108) ($00 $6C) Overdrive 1 Threshold
109 (000 109) ($00 $6D) Overdrive 1 Amount
110 (000 110) ($00 $6E) Overdrive 1 Filter
111 (000 111) ($00 $6F) Overdrive 1 Mix
 -
112 (000 112) ($00 $70) Distortion 1 Threshold
113 (000 113) ($00 $71) Distortion 1 Hysterisis
114 (000 114) ($00 $72) Distortion 1 Tone
115 (000 115) ($00 $73) Distortion 1 Mix
 -
116 (000 116) ($00 $74) Insert 2 Enable, 0=off, 1=on
 -
117 (000 117) ($00 $75) Parametric EQ 2 Frequency

118 (000 118) ($00 $76) Parametric EQ 2 Q
119 (000 119) ($00 $77) Parametric EQ 2 Gain
 -
120 (000 120) ($00 $78) Shelf EQ 2 Low Frequency
121 (000 121) ($00 $79) Shelf EQ 2 Low Gain
122 (000 122) ($00 $7A) Shelf EQ 2 High Frequency
123 (000 123) ($00 $7B) Shelf EQ 2 High Gain
 -
124 (000 124) ($00 $7C) Flange 2 Delay
125 (000 125) ($00 $7D) Flange 2 Feedback
126 (000 126) ($00 $7E) Flange 2 Speed
127 (000 127) ($00 $7F) Flange 2 Depth
128 (001 000) ($01 $00) Flange 2 Mix
 -
129 (001 001) ($01 $01) Chorus 2 Delay
130 (001 002) ($01 $02) Chorus 2 Feedback
131 (001 003) ($01 $03) Chorus 2 Speed
132 (001 004) ($01 $04) Chorus 2 Depth
133 (001 005) ($01 $05) Chorus 2 Mix
  -
134 (001 006) ($01 $06) Phaser 2 Delay
135 (001 007) ($01 $07) Phaser 2 Amount
136 (001 008) ($01 $08) Phaser 2 Speed
137 (001 009) ($01 $09) Phaser 2 Depth
138 (001 010) ($01 $0A) Phaser 2 Mix
 -
139 (001 011) ($01 $0B) Insert Delay 2 Delay 1
140 (001 012) ($01 $0C) Insert Delay 2 Division 1,

value from Table 16
141 (001 013) ($01 $0D) Insert Delay 2 Feedback 1
142 (001 014) ($01 $0E) Insert Delay 2 Delay 2
143 (001 015) ($01 $0F) Insert Delay 2 Division 2,

value from Table 16
144 (001 016) ($01 $10) Insert Delay 2 Feedback 2
145 (001 017) ($01 $11) Insert Delay 2 Mix
146 (001 018) ($01 $12) Insert Delay 2 MIDI Sync,

0=off, 1=on
 -
147 (001 019) ($01 $13) Overdrive 2 Gain
148 (001 020) ($01 $14) Overdrive 2 Threshold
149 (001 021) ($01 $15) Overdrive 2 Amount
150 (001 022) ($01 $16) Overdrive 2 Filter
151 (001 023) ($01 $17) Overdrive 2 Mix
 -
152 (001 024) ($01 $18) Distortion 2 Threshold
153 (001 025) ($01 $19) Distortion 2 Hysterisis
154 (001 026) ($01 $1A) Distortion 2 Tone
155 (001 027) ($01 $1B) Distortion 2 Mix
 -
[GLOBAL EFFECTS]
156 (001 028) ($01 $1C) Global 1 Enable, 0=off, 1=on
157 (001 029) ($01 $1D) Global 1 Send
 -
158 (001 030) ($01 $1E) Global Delay 1 Delay 1
159 (001 031) ($01 $1F) Global Delay 1 Division 1
160 (001 032) ($01 $20) Global Delay 1 Feedback 1
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161 (001 033) ($01 $21) Global Delay 1 Delay 2
162 (001 034) ($01 $22) Global Delay 1 Division 2
163 (001 035) ($01 $23) Global Delay 1 Feedback 2
164 (001 036) ($01 $24) Global Delay 1 Filter
165 (001 037) ($01 $25) Global Delay 1 MIDI Sync,

0=off, 1=on
 -
166 (001 038) ($01 $26) Reflection 1 Type, value from Table 7
167 (001 039) ($01 $27) Reflection 1 Predelay
168 (001 040) ($01 $28) Reflection 1 Brightness
169 (001 041) ($01 $29) Reflection 1 Length
 -
170 (001 042) ($01 $2A) Reverb 1 Type, value from Table 8
171 (001 043) ($01 $2B) Reverb 1 Predelay
172 (001 044) ($01 $2C) Reverb 1 Brightness
173 (001 045) ($01 $2D) Reverb 1 Decay
 -
174 (001 046) ($01 $2E) Global 2 Enabled, 0=off, 1=on
175 (001 047) ($01 $2F) Global 2 Send
 -
176 (001 048) ($01 $30) Global Delay 2 Delay 1
177 (001 049) ($01 $31) Global Delay 2 Division 1
178 (001 050) ($01 $32) Global Delay 2 Feedback 1
179 (001 051) ($01 $33) Global Delay 2 Delay 2
180 (001 052) ($01 $34) Global Delay 2 Division 2
181 (001 053) ($01 $35) Global Delay 2 Feedback 2
182 (001 054) ($01 $36) Global Delay 2 Filter
183 (001 055) ($01 $37) Global Delay 2 MIDI Sync,

0=off, 1=on
 -
184 (001 056) ($01 $38) Reflection 2 Type, value from Table 7
185 (001 057) ($01 $39) Reflection 2 Predelay
186 (001 058) ($01 $3A) Reflection 2 Brightness
187 (001 059) ($01 $3B) Reflection 2 Length
 -
188 (001 060) ($01 $3C) Reverb 2 Type, value from Table 8
189 (001 061) ($01 $3D) Reverb 2 Predelay
190 (001 062) ($01 $3E) Reverb 2 Brightness
191 (001 063) ($01 $3F) Reverb 2 Decay
 -
[GLOBALS]
192 (001 064) ($01 $40) Voice Trigger, value from Table 9
193 (001 065) ($01 $41) Number Of Voices,

value from Table 10
194 (001 066) ($01 $42) Pitchbend Range
195 (001 067) ($01 $43) Transpose, value from Table 11
196 (001 068) ($01 $44) Pan
197 (001 069) ($01 $45) Volume
198 (001 070) ($01 $46) Portamento Type, value from Table 12
199 (001 071) ($01 $47) Portamento Fingered, 0=off, 1=on
200 (001 072) ($01 $48) Portamento Up
201 (001 073) ($01 $49) Portamento Down

TABLE 2
Waveform menu values
0 (000 000) ($00 $00) Sawtooth
1 (000 001) ($00 $01) Triangle
2 (000 002) ($00 $02) Pulse
3 (000 003) ($00 $03) Sine
4 (000 004) ($00 $04) Sine Squared
5 (000 005) ($00 $05) Glottal
6 (000 006) ($00 $06) White Noise
7 (000 007) ($00 $07) Pink Noise
8 (000 008) ($00 $08) Red Noise

TABLE 3
Sync, FM, & CM menu values
0 (000 000) ($00 $00) None
1 (000 001) ($00 $01) Osc 1
2 (000 002) ($00 $02) Osc 2
3 (000 003) ($00 $03) Osc 3
4 (000 004) ($00 $04) Filter 1 In
5 (000 005) ($00 $05) Filter 1 Out
6 (000 006) ($00 $06) Filter 2 In
7 (000 007) ($00 $07) Filter 2 Out

TABLE 4
Filter Type menu values
0 (000 000) ($00 $00) 1 Pole LP
1 (000 001) ($00 $01) 2 Pole LP
2 (000 002) ($00 $02) 4 Pole LP Resonant
3 (000 003) ($00 $03) 1 Pole HP
4 (000 004) ($00 $04) 2 Pole HP
5 (000 005) ($00 $05) 4 Pole HP Resonant
6 (000 006) ($00 $06) 1 Pole AP Resonant
7 (000 007) ($00 $07) 2 Pole AP Resonant
8 (000 008) ($00 $08) 4 Pole AP Resonant
9 (000 009) ($00 $09) State Variable LP
10 (000 010) ($00 $0A) State Variable BP
11 (000 011) ($00 $0B) State Variable BS
12 (000 012) ($00 $0C) State Variable HP

TABLE 5
Trigger menu values
0 (000 000) ($00 $00) Multiple
1 (000 001) ($00 $01) Single
2 (000 002) ($00 $02) Pedal Down
3 (000 003) ($00 $03) Pedal Up
4 (000 004) ($00 $04) Key Up
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TABLE 6
LFO Type menu values
0 (000 000) ($00 $00) Sine
1 (000 001) ($00 $01) Triangle
2 (000 002) ($00 $02) Square
3 (000 003) ($00 $03) Sawtooth Up
4 (000 004) ($00 $04) Sawtooth Down
5 (000 005) ($00 $05) Random

TABLE 7
Reflection Type values
0 (000 000) ($00 $00) Sparse
1 (000 001) ($00 $01) Diffuse
2 (000 002) ($00 $02) Random
3 (000 003) ($00 $03) Reverse

TABLE 8
Reverb Type values
0 (000 000) ($00 $00) Room
1 (000 001) ($00 $01) Chamber
2 (000 002) ($00 $02) Small Hall
3 (000 003) ($00 $03) Large Hall

TABLE 9
Trigger Mode values
0 (000 000) ($00 $00) Polyphonic
1 (000 001) ($00 $01) Legato Last
2 (000 002) ($00 $02) Legato Low
3 (000 003) ($00 $03) Legato High

TABLE 10
Number of Voices value
0 (000 000) ($00 $00) Unlimited
1 (000 001) ($00 $01) 1
2 (000 002) ($00 $02) 2
3 (000 003) ($00 $03) 3
4 (000 004) ($00 $04) 4
5 (000 005) ($00 $05) 5
6 (000 006) ($00 $06) 6
7 (000 007) ($00 $07) 7
8 (000 008) ($00 $08) 8

TABLE 11
Transpose Range values
-12 (063 116) ($3F $74) -12
-11 (063 117) ($3F $75) -11
-10 (063 118) ($3F $76) -10
-9 (063 119) ($3F $77) -9
-8 (063 120) ($3F $78) -8
-7 (063 121) ($3F $79) -7
-6 (063 122) ($3F $7A) -6
-5 (063 123) ($3F $7B) -5
-4 (063 124) ($3F $7C) -4
-3 (063 125) ($3F $7D) -3
-2 (063 126) ($3F $7E) -2
-1 (063 127) ($3F $7F) -1
0 (064 000) ($40 $00) 0 (None)
1 (064 001) ($40 $01) 1
2 (064 002) ($40 $02) 2
3 (064 003) ($40 $03) 3
4 (064 004) ($40 $04) 4
5 (064 005) ($40 $05) 5
6 (064 006) ($40 $06) 6
7 (064 007) ($40 $07) 7
8 (064 008) ($40 $08) 8
9 (064 009) ($40 $05) 9
10 (064 010) ($40 $06) 10
11 (064 011) ($40 $07) 11
12 (064 012) ($40 $08) 12

TABLE 12
Portamento values
0 (000 000) ($00 $00) Off
1 (000 001) ($00 $01) Up
2 (000 002) ($00 $02) Down
3 (000 003) ($00 $03) Up & Down

TABLE 13
Modulation Routings List and Modulators
List selections
0=first item in list, 1=second list item, etc. This is an offset to
the MSB of the parameter. The first 16 Routings are supported.

INDEX (XXX) ($XX)
0 (000) ($00)
1 (008) ($08)
2 (016) ($10)
3 (024) ($18)
4 (032) ($20)
5 (040) ($28)
6 (048) ($30)
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7 (056) ($38)
8 (064) ($40)
9 (072) ($48)
10 (080) ($50)
11 (088) ($58)
12 (096) ($60)
13 (104) ($68)
14 (112) ($70)
15 (120) ($78)

TABLE 14
Modulation Routing Source values
0 (000 000) ($00 $00) Note
1 (000 001) ($00 $01) Velocity
2 (000 002) ($00 $02) Mono Pressure
3 (000 003) ($00 $03) Poly Pressure
4 (000 004) ($00 $04) Controller A
5 (000 005) ($00 $05) Controller B
6 (000 006) ($00 $06) Controller C
7 (000 007) ($00 $07) Controller D
8 (000 008) ($00 $08) Modulator 1
9 (000 009) ($00 $09) Modulator 2
10 (000 010) ($00 $0A) Modulator 3
11 (000 011) ($00 $0B) Modulator 4
12 (000 012) ($00 $0C) Modulator 5
13 (000 013) ($00 $0B) Modulator 6
14 (000 014) ($00 $0E) Modulator 7
15 (000 015) ($00 $0F) Modulator 8

TABLE 15
Modulation Routing Destinations
0 (000 000) ($00 $00) Pitch
1 (000 001) ($00 $01) Volume
2 (000 002) ($00 $02) Pan
100 (000 100) ($00 $64) Oscillator 1 Frequency
101 (000 101) ($00 $65) Oscillator 1 Random
102 (000 102) ($00 $66) Oscillator 1 Symmetry
103 (000 103) ($00 $67) Oscillator 1 FM Amount
104 (000 104) ($00 $68) Oscillator 1 Volume
105 (000 105) ($00 $69) Oscillator 2 Frequency
106 (000 106) ($00 $6A) Oscillator 2 Random
107 (000 107) ($00 $6B) Oscillator 2 Symmetry
108 (000 108) ($00 $6C) Oscillator 2 FM Amount
109 (000 109) ($00 $6D) Oscillator 2 Volume
110 (000 110) ($00 $6E) Oscillator 3 Frequency
111 (000 111) ($00 $6F) Oscillator 3 Random
112 (000 112) ($00 $70) Oscillator 3 Symmetry
113 (000 113) ($00 $71) Oscillator 3 FM Amount
114 (000 114) ($00 $72) Oscillator 3 Volume
200 (001 072) ($01 $48) Filter 1 Cutoff
201 (001 073) ($01 $49) Filter 1 Spread
202 (001 074) ($01 $4A) Filter 1 CM Amount

203 (001 075) ($01 $4B) Filter 1 Resonance
204 (001 076) ($01 $4C) Filter 1 Overdrive
205 (001 077) ($01 $4D) Filter 2 Cutoff
206 (001 078) ($01 $4E) Filter 2 Spread
207 (001 079) ($01 $4F) Filter 2 CM Amount
208 (001 080) ($01 $50) Filter 2 Resonance
209 (001 081) ($01 $51) Filter 2 Overdrive
300 (002 044) ($02 $2C) Modulator 1 Amount
301 (002 045) ($02 $2D) Modulator 1 Parameter 1
302 (002 046) ($02 $2E) Modulator 1 Parameter 2
303 (002 047) ($02 $2F) Modulator 1 Parameter 3
304 (002 048) ($02 $30) Modulator 2 Amount
305 (002 049) ($02 $31) Modulator 2 Parameter 1
306 (002 050) ($02 $32) Modulator 2 Parameter 2
307 (002 051) ($02 $33) Modulator 2 Parameter 3
308 (002 052) ($02 $34) Modulator 3 Amount
309 (002 053) ($02 $35) Modulator 3 Parameter 1
310 (002 054) ($02 $36) Modulator 3 Parameter 2
311 (002 055) ($02 $37) Modulator 3 Parameter 3
312 (002 056) ($02 $38) Modulator 4 Amount
313 (002 057) ($02 $39) Modulator 4 Parameter 1
314 (002 058) ($02 $3A) Modulator 4 Parameter 2
315 (002 059) ($02 $3B) Modulator 4 Parameter 3
316 (002 060) ($02 $3C) Modulator 5 Amount
317 (002 061) ($02 $3D) Modulator 5 Parameter 1
318 (002 062) ($02 $3E) Modulator 5 Parameter 2
319 (002 063) ($02 $3F) Modulator 5 Parameter 3
320 (002 064) ($02 $40) Modulator 6 Amount
321 (002 065) ($02 $41) Modulator 6 Parameter 1
322 (002 066) ($02 $42) Modulator 6 Parameter 2
323 (002 067) ($02 $43) Modulator 6 Parameter 3
324 (002 068) ($02 $44) Modulator 7 Amount
325 (002 069) ($02 $45) Modulator 7 Parameter 1
326 (002 070) ($02 $46) Modulator 7 Parameter 2
327 (002 071) ($02 $47) Modulator 7 Parameter 3
328 (002 072) ($02 $48) Modulator 8 Amount
329 (002 073) ($02 $49) Modulator 8 Parameter 1
330 (002 074) ($02 $4A) Modulator 8 Parameter 2
331 (002 075) ($02 $4B) Modulator 8 Parameter 3
400 (003 016) ($03 $10) Global 1 Send
401 (003 017) ($03 $11) Global 2 Send

TABLE 16
Time Division Table (MIDI Sync)
0 (000 000) ($00 $00) Whole
1 (000 001) ($00 $01) Half
2 (000 002) ($00 $02) Quarter
3 (000 003) ($00 $03) Eighth
4 (000 004) ($00 $04) Eighth Triplet
5 (000 005) ($00 $05) Sixteenth
6 (000 006) ($00 $06) Sixteenth Triplet
7 (000 007) ($00 $07) ThirtySecond
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Appendix G: Record To Disk

Record To Disk Overview
Retro AS-1 contains a powerful multimedia feature: Record To
Disk. The Record To Disk function writes the stereo output of
the synthesizer to your hard drive as an audio file. Whatever
the synthesizer engine is playing (notes, chords, riffs,
arpeggiations, etc, on all MIDI channels, including effects) is
written to disk. The audio file can then be opened in any audio
application that supports AIFF (Audio Interchange File Format-
Mac OS) or .WAV (Windows 95), common file formats used in
digital audio applications.

This feature is convenient when you want to use your synthesizer
creations “stand-alone” in other digital audio applications without
having to use the Retro AS-1 synthesizer engine at the same time.
Another advantage is there are no digital-to-analog conversions
involved in getting the audio file onto your disk, allowing for the highest
possible fidelity for Audio Compact Disks or multimedia CD-Roms.

The sample rate of the audio file is determined by the Sample Rate
parameter in the Retro AS-1 control panel configuration settings (see
chapter 5.2). For example, if the control panel is set to a sample rate of
44100, then the resolution of the audio file will be 44.1kHz. The file
always records in stereo. In Windows 95, the bit depth of the audio
file is 16 bits; in Mac OS, the bit depth (8, 16, or 24 bit) is specified by
the Record To Disk Size parameter in the Retro AS-1 control panel I/O
settings (see chapter 5.5).

Using Record To
Disk
To use the Record To Disk
feature, select Start Record
To Disk... from the
Synthesizer menu from
within the Editor, MIDI
Processor, Mixer, or
Keyboard applications. A
standard Save File dialog
will appear (figure G2).
Type a name for the file
and select a destination
location.

Figure G1. Record To Disk is
accessed from the Synthesizer

menu in the Editor, MIDI
Processor, Mixer, and Keyboard

applications.

Figure G2. The Record To Disk
save file dialog, where you type a
name and select a destination for

the audio file.
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After clicking Save, the audio file starts continuously writing to disk.
All synthesizer output, including silence, is written to disk in a linear
fashion until the Stop Record To Disk command is executed.

(Mac OS only) The Apple Menu icon will flash with the
Retro AS-1 icon (figure G3), indicating Record To Disk is
active.

To end the Record To Disk process, select the Stop Record To Disk
command from the Synthesizer menu. This command will be
unavailable unless the Record To Disk function is active.

IMPORTANT! Digital audio files can be extremely large. 16-bit stereo
audio files at a  44.1kHz sample rate will require 10 megabytes of
disk space per minute. Make sure you have enough disk space for
the file or you may get a “Disk full” error.

Previewing the Audio File
The audio file is now on hard disk (figure G4) and can be opened and
played in any digital audio application that supports AIFF (Mac OS) or
.WAV (Windows 95).

(Mac OS only) Retro AS-1 AIFF files are saved with the SimpleSound
creator code which allows you to hear the audio file without 3rd-party
digital audio applications. SimpleSound (figure G5) is a stock
component of the Mac OS that allows you to play and record AIFF
files. So, to quickly hear the Retro AS-1 audio file, just double-click
the file icon to launch SimpleSound. Then, select Play from the Sound
menu (figure G7) within the SimpleSound application to hear the file.
Make sure ‘CD Quality’ is selected from the Sound menu if you are
auditioning a high resolution file.

Figure G6. The SimpleSound file information window.

Figure G7. (Mac OS) The
SimpleSound Play menu. Make

sure CD Quality is selected when
auditioning high resolution files.

Figure G3. The Retro AS-1 icon
blinks in the Apple Menu when
Record To Disk is active (Mac OS

only).

Figure G5. The SimpleSound
application icon. SimpleSound is
installed in the Apple Menu by

the Mac OS.

Figure G4. (Mac OS) The output
of Record To Disk is a digital

audio file with the SimpleSound
icon.
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Appendix H: QuickTime™ Driver
This appendix applies to the Mac OS only. It explains how to install,
configure, and use the Retro AS-1 QuickTime™ Driver.

QuickTime Driver Overview
QuickTime movies can contain a variety of multimedia formats such
as video, graphics, text, sound (digital audio files), and MIDI tracks.
When a QuickTime movie contains MIDI tracks (called music tracks
in QuickTime language), the wavetable-based software music
synthesizer built in to QuickTime (the QuickTime Musical Instruments
extension) will play the music tracks.

The QuickTime architecture allows third-party developers (such as
BitHeadz) to develop alternate software synthesizers for use by
QuickTime that are activated by installing QuickTime drivers. Once
the Retro AS-1 QuickTime Driver is properly installed (instructions
below), QuickTime can be configured to use the Retro AS-1 synthesizer
engine to play music tracks instead of, or in conjunction with,
QuickTime Musical Instruments.

The Retro AS-1 QuickTime Driver allows you to play Retro AS-1
programs via MIDI with MoviePlayer and other applications that
playback QuickTime movies. Using the Retro AS-1 QuickTime driver
offers these benefits:

• QuickTime movies can play the great sounds of Retro AS-1 by
themselves or in conjunction with QuickTime Musical
Instruments.

• Using MIDI instead of digital audio files keeps your movies
smaller.

• You can play Retro AS-1 MIDI sequences using MoviePlayer
which is smaller, simpler, and less of a CPU hog than the high-
end sequencers like Performer and Vision. Great for demos.

• QuickTime and MoviePlayer are free, downloadable at
www.apple.com/quicktime.

System Requirements
• Retro AS-1 version 1.02 or higher
• QuickTime version 3.0 or higher

http://www.apple.com/quicktime
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Installing the driver
To install the driver, drag the Retro AS-1 QuickTime Driver
extension (located inside the Goodies folder) onto the closed active
System Folder icon. The driver will be automatically placed into
the Extensions folder. You will need to reboot in order for
QuickTime to recognize the driver installation.

Configuring the QuickTIme driver
Retro AS-1 version 1.02 and QuickTime 3.0 must already be properly
installed and configured before proceeding.

NOTE: QuickTime continuously issues launch and quit commands
to alternate synthesizers during configuration and use. For this reason,
we recommend launching the Retro AS-1 synthesizer engine before
and during use of the Retro AS-1 QuickTime Driver. To launch the
synthesizer, open any of the Retro AS-1 applications such as Retro
AS-1 Status (inside the Retro AS-1 Utilities folder). This will keep the
Retro AS-1 engine open, saving time during configuration and use
of the Retro AS-1 QuickTime driver.

Configuring the QuickTime™ Settings control panel
1. Open the QuickTime

Settings control panel.

2. Select Music from the pull
down menu.

3. Click the Edit List... button.
The QuickTime Synthesizer
window appears, with one line
item showing the QuickTime
Music Synthesizer.

Figure H1. The QuickTime
Driver is installed into the

Extensions folder.

Figure H2. The QuickTime
Settings control panel Music

menu.
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4. Click the Add button in the
QuickTime Synthesizer
window.
A new line item appears. The new
line item Synthesizer pull-down
menu says “(No Synthesizer).”

5. Select "Retro AS-1" from the
new line item Synthesizer
pull-down menu.

6. Click OK to close the
QuickTime Synthesizer window.
The Retro AS-1 QuickTime Driver is now properly configured.

The QuickTime™ Settings control panel Music window should now
appear as shown in figure H4. We recommend leaving QuickTime
Music Synthesizer selected as the default music synthesizer so all
QuickTime movies with MIDI tracks will play correctly. In this case,
only movies with MIDI tracks specifically assigned to Retro AS-1
programs will use the Retro AS-1 engine.

Figure H3. The QuickTime
Settings control panel Edit

Synthesizers window.

Figure H4. The QuickTime driver
properly installed and

configured.
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Using the QuickTime Driver
When QuickTime 3.0, the Retro AS-1 synthesizer, and the Retro AS-1
QuickTime Driver are all installed and configured correctly, QuickTime
movies that have MIDI tracks assigned to Retro AS-1 Programs will
use the Retro AS-1 engine for playback.

For the movie to sound as created by the author, the Retro AS-1
Programs used by the movie must be installed on the playback system.
If the QuickTime movie using Retro AS-1 tracks plays on a system
different than the one that created it, the correct programs may or
may not play, depending on the following conditions. The QuickTime
driver searches for Retro AS-1 programs by name. If the program name
is not found (if it is not installed in the Retro AS-1 Programs folder), it
loads the program number. If there is no program at that number
location, it loads program zero, bank zero.

If you want Retro AS-1 sounds in your QuickTime movie but cannot
rely on the destination system to have Retro AS-1 and its QuickTime
Driver installed and configured, use the Retro AS-1 Record To Disk
function to produce AIFF files of the synthesizer output then import
these digital audio files into your QuickTime movie instead of using
MIDI.

Unless the Retro AS-1 engine is already in use by a Retro AS-1
application, each time a QuickTime movie is played containing MIDI
tracks assigned to Retro AS-1 programs, the Retro AS-1 engine is
launched. There will be a delay while the engine launches before sound
is heard. When the movie is closed, the engine is quit. Again, for this
reason we recommend forcing the engine to remain open by launching
a Retro AS-1 application such as Retro AS-1 Status before and during
use of the QuickTime application.

Assigning Retro AS-1 Programs in MoviePlayer
QuickTime 3.0 includes MoviePlayer, an application that plays
QuickTime movies. MoviePlayer allows you to playback QuickTime
movies that have MIDI tracks assigned to Retro AS-1 programs. You
cannot modify MIDI track instrument assignments using the free version
of QuickTime 3.0, but you can play movies that already have Retro
AS-1 assignments. The QuickTIme 3.0 "Pro" upgrade ($29.99 from
Apple at http://www.apple.com/quicktime) allows you modify the
MIDI track instrument assignments and select Retro AS-1 programs
from within MoviePlayer.
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To view or modify instrument assign-
ments within MoviePlayer:

1. Open a QuickTime file containing
MIDI tracks in MoviePlayer.
You can open Standard MIDI Files in
MoviePlayer using the Import... command
in the MoviePlayer File menu.

2. Select "Get Info" (Command-I) from
the Movie menu.
The movie Info window appears.

3. Select "Music Track" from the pull-
down menu at the upper left of the
Info window.

4. Select "Instruments" from the pull-
down menu at the upper right of the
Info window.

5. The current
instrument
assignments for
the movie are
now visible.
Each item in the list
corresponds to a
unique MIDI channel
(figure H5).

6. Double-click and
instrument name
to open the
instrument
assignment
window for the
MIDI channel.

Figure H5. The MoviePlayer movie information window,
with music track instruments displayed.

Figure H6. The MoviePlayer
instrument assignment

window.
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7. Select an instrument for the part.
The "Category" and "Instrument" menus correspond to Retro AS-1
Banks and Programs. The items available for selection from these
menus depends on the state of the Retro AS-1 Programs folder when
the Retro AS-1 engine was launched. You can hear the sound by
clicking on the mini keyboard at the bottom of the window.

8. Click OK to close the instrument assignment window.
The track will reflect the change the next time you start the movie.

9. Select Preload from the pull-down
menu at the upper right of the Info
window.

Preload and Cache Hint optimize playback
on small files. Both boxes should be
checked if your movie contains only MIDI
tracks.

10.Remember to save the changes to
your movie if desired.

Done! The QuickTime movie will now use
Retro AS-1 for the MIDI tracks assigned
to it.

Apple has more detailed information about MoviePlayer and QuickTime
online at www.apple.com/quicktime/information/macmovieplayer.

Figure H7. Make sure the Preload
option is checked for MIDI-based

movies.

http://www.apple.com/quicktime/information/macmovieplayer
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Appendix I: OMS Names
This appendix applies to the Mac OS platform only. It explains how to setup
OMS applications to view Retro AS-1 programs by name.

About Retro AS-1 OMS Names
Retro AS-1 OMS Names is a utility application that assists you in viewing Retro
AS-1 Programs by name within OMS applications. The application is located
inside the Goodies folder. After running the utility, a text file containing the
current state of the Retro AS-1 Programs folder, both banks and programs, is
generated. The text file can then be pasted into a Patch Names list within an
OMS application.

How To Use It
To use Retro AS-1 OMS Names, double-click the application icon. The Retro AS-
1 Programs folder is evaluated and a text file is generated with the bank and
programs names. The file is placed in the same folder as the Retro AS-1 OMS
Names application.

Open the text file, select all, and copy. The names can then be pasted into an
OMS Patch Names document that have the banks defined. We have provided a
Retro AS-1 OMS Patch Names document that contains the factory banks and
programs. If new banks are added or original banks are deleted, the banks
within this Names document will have to be manually updated by pasting the
newly generated names text into the document from within the OMS application.

OMS patch name documents require carriage returns for each of the 128 programs
in a bank, even if the bank contains less than 128 programs. Retro AS-1 OMS
Names automatically generates these carriage returns in the correct places. If
you open the output file in SimpleText (by double-clicking the document), you
will not be able to see all the programs in all the banks. This is due to a bug in
SimpleText, which will not scroll below the empty carriage returns. However,
the text you can't see in SimpleText is actually in the file. If you select all and
copy, then paste into an OMS names document, all the data will be inserted. If
you open the OMS Names output file in a different word processor, you will see
all the data.

The OMS Patch Names are static, not dynamic, meaning the names or the bank/
program ordering is not updated when the Retro AS-1 Programs folder changes.
Therefore, the utility should be used each time the naming hierarchy of the
Retro AS-1 Programs folder changes. We hope to implement support for the
OMS Names Manager in a future version in order to fully support dynamic
name changes.
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Step by Step Instructions

To install Retro AS-1 factory names into Vision:
1. Install and configure the Retro AS-1 OMS Driver.

Follow the instructions in chapter 2 of this manual.

2. From within the Vision/StudioVision application,
select Names from the Windows menu.
The Patch Names from OMS window (figur e I3) appears.
(The Retro AS-1 Patch Name Document will not be
displayed until after step 6.)

3. Select Retro AS-1 icon.
Single-click the Retro AS-1 icon to select it..

4. Select Subscribe... from the Names menu.
 See figure I.2 .A standar d Open File dialog appears.

5. Navigate to the factory Retro AS-1 OMS Patch
Names file (figure I.1).
The Retro AS-1 Installer placed it in the OMS folder in the
Goodies folder, inside the Retro AS-1 Folder. You can move
it to any location.

6. Select the Retro AS-1 OMS Patch Names file and
click Subscribe.
The Retro AS-1 names list now contains the factory program names.

7. Close the Patch Names from OMS window.
Done! Retro AS-1 factory programs can now be viewed by name
from within Vision (figure I.7).

Figure I.3. The Patch Names from
OMS window correctly

configured with the Retro AS-1
factory names file.

Figure I.2. The Names menu
within Vision.

Figure I.1. The Retro AS-1 factory
patch names file for OMS.
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To update program names when the bank hierarchy
has NOT CHANGED:
1. Install the factory OMS names file into

Vision.
Follow the instructions fr om the previous
section.

2. Run the Retro AS-1 OMS Names
application.
A new text file containing the current bank/
program names is generated.

3. Open the newly generated Retro AS-1
OMS Names Text file.
It is placed in the same folder as the Retro AS-1 OMS Names
application. If you open it with SimpleText, you will not see the entire
contents of the file, but the data is there. This is a bug in SimpleText.

4. Select All, then copy the contents of the file.
The data is copied to the Clipboard.

5. From within the Vision/StudioVision application,
select Names from the Windows menu.
The Patch Names from OMS window (figur e I.3) appears.

6. Double-click the Retro AS-1 OMS Patch Names
icon.
The Retro AS-1 OMS Patch Names window appears
(figur e I.4).

7. Select Paste Patch Names from the Patches menu
(figure I.5).
The contents of the Clipboard is pasted into the R etro AS-
1 Names window, replacing the previous names .

8. Close the Retro AS-1 Names window and save the
changes.

9. Close the Patch Names from OMS window..
Done! Retro AS-1 custom programs can now be viewed by name
from within Vision (figure I.7)

Figure I.4. The Retro AS-1 OMS
Patch Names window appears

when you double click the AS-1
icon in the Patch Names from

OMS window.

Figure I.5. The Patches menu is
visible when a device patch list is

open.
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To create a custom OMS Names file from scratch:
1. Run the Retro AS-1 OMS Names application.

A new text file containing the current bank/program names is
generated.

2. Count how many sub-folders are in your Retro AS-1
Programs Folder.
This is the number of installed banks. You will need this number later.

3. From within the Vision/StudioVision application, select
Names from the Windows menu.
The Patch Names from OMS window appears (figure I.3).

4. Double-click the Patch Name column in the Retro AS-1 row.
The Retro AS-1 OMS Patch Names window appears (figure I.4).

5. From the Names menu, add a new bank to the Names
document using Controller
0=0 and Controller 32=0.
See figure I.6.

6. Highlight the FIRST entry
after "default" and then
select DELETE BANK.
Now the 0/0/0 Bank should be
the only one showing.

7. Close and save this new
OMS Patch file.

8. Open the newly generated
Retro AS-1 OMS Names
Text file.
It is placed in the same folder
as the Retro AS-1 OMS Names
application. If y ou open it with
SimpleText, you will not see the
entire contents of the file, but
the data is there. This is a bug in
SimpleText.

9. Select All, then copy the contents of the file.
The data is copied to the Clipboard.

Figure I.6. The Add Bank
window.
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10.From within the Vision/StudioVision application, select
Names from the Windows menu.
The Patch Names from OMS window appears (figure I.3).

11.Double-click the Retro AS-1 OMS Patch Names icon.
The Retro AS-1 OMS Patch Names window appears (figure I.4).

12.Add Banks to the list (Names menu) using Ctl 0=0 and Ctl
32=1 through X, where X is the number of bank subfolders
you counted in step 2.
If you counted 11 subfolders, you will need to create 12 Banks
because the root level is also a bank (Bank 0).

13.Select Paste Patch Names from the Patches menu (figure
I.5).
The contents of the Clipboard is pasted into the R etro AS-1 OMS
Patch Names window (figur e I.5).

14.Close the Retro AS-1 Names window and save the changes.

15.Close the Patch Names from OMS window..
Done! Retro AS-1 custom banks and programs can now be viewed
by name from within Vision (figure I.7).

Figure I.7. The result of
configuring OMS Names: You can

view Retro AS-1 programs by
name within OMS applications.
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To create an OMS Name List for Steinberg Cubase:
1. Run the Retro AS-1 OMS Names application.

A new text file containing the current bank/program names is
generated.

2. Count how many sub-folders are in your Retro AS-1
Programs Folder.
This is the number of installed banks. You will need this number later.

3. From within Cubase, select Options>Setup OMS>OMS
Patch Names....
The OMS Patch Names window appears.

4. Double-click the Patch Name column in the Retro AS-1 row.
The Retro AS-1 names window appears.

5. From the Names menu, add a new bank to the Names
document using Controller 0=0 and Controller 32=0.

6. Highlight the FIRST entry after "default" and then select
DELETE BANK.
Now the 0/0/0 Bank should be the only one showing.

7. Close and save this new OMS Patch file.

8. Open the newly generated Retro AS-1 OMS Names Text file.
It is placed in the same folder as the Retro AS-1 OMS Names
application. If you open it with SimpleText, you will not see the entire
contents of the file, but the data is there. This is a bug in SimpleText.

9. Select All, then copy the contents of the file.
The data is copied to the Clipboard.

10.From within the Vision/StudioVision application, select
Names from the Windows menu.
The Patch Names from OMS window appears.

11.Double-click the Retro AS-1 OMS Patch Names icon.
The Retro AS-1 names window appears.

12.Add Banks to the list (Names menu) using Ctl 0=0 and Ctl
32=1 through X, where X is the number of bank subfolders
you counted in step 2.
If you counted 11 subfolders, you will need to create 12 Banks
because the root level is also a bank (Bank 0).
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13.Select Paste Patch Names from the Names menu.
The contents of the Clipboard is pasted into the R etro AS-1 Names
window.

14.Close the Retro AS-1 Names window and save the changes.

15.Close the Patch Names from OMS window..
Done! Retro AS-1 custom banks and programs can now be viewed
by name from within Cubase b y selecting Retro AS-1 as an
instrument and choosing Open Up Patch.



Index

Retro AS-1 Manual

212

IndexIndexIndexIndexIndex
SymbolsSymbolsSymbolsSymbolsSymbols

1 Pole All Pass Resonant  120
1 Pole High Pass  120
1 Pole Low Pass  119
2 Pole All Pass Resonant  120
2 Pole High Pass  120
2 Pole Low Pass  120
4 Pole All Pass Resonant  121
4 Pole High Pass Resonant  120
4 Pole Low Pass Resonant  120

AAAAA

Acrobat Reader  14
Activating MIDI Input  39
Add Button  125, 128
Add... button  97, 101
AIFF  197
Alert Volume  27
All Notes Off  95, 111, 153, 162
Amount  140, 141
Amount Slider  126, 166
Analog Synthesis Demystified  182
André Rocke  7
AppleTalk  53, 87
Application Problems  177
Arpeggiation Type Radio Buttons  99
Arpeggiator Parameters  99
Attack  130
audio file  197
Audio Hardware Setup  21
Audio Output menu  86
Auditioning Sounds  37

BBBBB

Bank  98
Bank menu  155, 164
Bank Overview  168
Banks and Programs  168
banks via MIDI  171
Base menu  102
Basic Editor Operations  42
Before You Install  30
BitHeadz  20
Bookmarks  14

Brightness  145, 146
Buffer Length  82
Building Blocks  182
Bypass  93

CCCCC

Cakewalk  74
Can’t connect to synthesizer  177
Chamber  146
Channel  98
Channel menu  155
Channel Strips  163
Chord  100
Chord menu  155
Chorus  139
Clear  93, 109
clipping  35
Close  91, 107, 160
CM (Cutoff Modulation) Menu  121
CM Amount  122
Coarse  116
Comment Field  150
Comments Window  99
Components  18
Concepts  16, 51, 80, 182
Configuration Display  123
Configuration settings  81
Configuring OMS MIDI applications  58
Configuring the Device Driver  70
Configuring the FreeMIDI Driver  63
Configuring the OMS Driver  56
Configuring the QuickTIme driver  200
Control Panel  19, 95, 111, 153, 163
Control Panel Concepts  80
Control Panel Overview  79
Control Panel Reference  79
Controller A, B, C, D menu  83
Controller A, B, C, D sliders  156
Controllers A, B, C, D overview  83
Controllers Settings  83
Conventions  48, 105
Copy  92, 108
CPU overload  172
Credits  7
Cross-Platform Manual  13
Cubase  59, 77
Cubase Sync Setup  62
Cut  92, 108
Cutoff  122

CLICK ANY INDEX ITEM TO JUMP DIRECTLY TO THAT PAGE



Index

Retro AS-1 Manual

213

DDDDD

David Sumich  7
Decay  130, 146
Default MIDI Input menu  86
deinstall  23, 32
Delay  138, 139, 140, 143
Delete Button  126, 129
Delete button  97, 101
Depth  138, 139, 140
Destination Menu  126
Device Driver  19, 69, 70
Diffuse  145
Digidesign Direct IO  179
Direct IO  179
Direct MIDI Input  87
Direction menu  102
DirectSound  30
DirectX  30
Distortion  142
distortion  35
Division menu  103, 132, 141, 144
DMA  54
Double note triggers  177
DSP  8

EEEEE

Earl Sondreal  7
Edit  99, 101
Edit Effect button  166
Edit Menu  92, 108, 152, 161
Editing Conventions  48, 105
Editing Programs  45
Editing radio buttons  109
Editor  42, 96, 153, 163
Editor Application  18
Editor Concepts  105
Editor Effects Page  135
Editor Global Page  147
Editor Menu Items  106
Editor Overview  104
Editor Preferences  129
Editor Reference  104
Effect Amount Slider  166
Effect menu  136, 143
Effect Parameters  136
Effect Type menu  166
Effects  110, 143, 185
Effects Controls  165
Effects On/Off Button  136

Effects Overview  135
Effects Page  135
Effects with the Mixer  158
Engine  19
Envelope Editing radio buttons  109
Envelope Modulator  129
envelope segment  131
Envelopes in Graphical Mode  131
EQ  137
External MIDI input (Mac OS)  52
External MIDI input (Windows)  67

FFFFF

Features  9
Feedback  138, 139, 140, 143
Fernando Martinez  7
File Menu  106, 152, 160
File menu  91
Filter  142, 144
Filter On/Off button  119
Filter Parameters  119
Filter Sliders  122
Filter Type menu  119
Filters  183
Filters Overview  118
Fine  116
Fingered  150
First/Upper  101
Flange  138
FM Amount  118
FM Menu  115
footswitch  134
FreeMIDI Driver  63
FreeMIDI Input  19, 54
FreeMIDI Overview  55
Frequency  137
FX Button  165
FX On/Off button  166

GGGGG

Gain  137, 138, 141
Global  110
Global Effect  161
Global Effect menu  143
Global Effects  143
Global Effects Controls  165
Global Effects don’t sound  178
Global Effects Settings  85
Global Effects with the Mixer  158
Global Level Meter  166

CLICK ANY INDEX ITEM TO JUMP DIRECTLY TO THAT PAGE



Index

Retro AS-1 Manual

214

Global Page  147
Global Slider  164
Graphic Keyboard  154
Graphical checkbox  110
Graphical Mode  131
graphically  129
graphics  14

HHHHH

Hierarchy Overview  168
High  138
High Gain  138
High Key  102
Highest  103
Hysteresis  142

IIIII

IAC Driver  60
Important Synthesizer Information  36
Individual Mode  180
Input Problems  176
Input source checkboxes  122
Input/Output Settings  86
Insert Delay  140
Insert Effect menu  136
Insert Effect Parameters  136
Installation and Setup  21
Introduction  8

KKKKK

Key Concepts  16
Key Up  134
Keyboard  95, 111, 154, 163
Keyboard  Concepts  152
Keyboard Application  18
Keyboard Menus  152
Keyboard Overview  151
Keyboard Parameters  154
Keyboard Reference  151

LLLLL

Large Hall  146
Last  102
Last Key  102
Latch  93
latency  82, 176, 181
Launch Retro AS-1 Status  87
Layer  101
Layer radio button  98

Legato  134
Legato High  148
Legato Last  148
Legato Low  148
Length  145
Level Meter  165, 166
Level Meters  166
LFO Delay  132
LFO Modulator  132
LFO Speed  132
LFO Type  132
List  100, 125, 128
List Record button  100
Low  137
Low Gain  138
Low Key  102
Lowest  102

MMMMM

Mac OS Installation  22
Mac OS Setup  25
Mac OS versus Windows 95  15
Main  110
Main Page  112
Manual  13, 102
Manual Conventions  12
Manual Organization  11
Master FX On/Off button  166
Master Level Meters  166
Master Section  165
Master Volume Sliders  166
Maximum CPU %  81
MIDI  17, 50, 199
MIDI & Input Problems  176
MIDI applications  58
MIDI Channel  88, 93, 109, 148
MIDI Channel menu  110
MIDI Clock Sync via OMS  60
MIDI commands  171
MIDI Concepts  51
MIDI Control examples  188
MIDI Control Numbers  188
MIDI Flow  52, 67
MIDI Hardware Setup  22
MIDI Implementation  187
MIDI Implementation Chart  187
MIDI Input  15, 39
MIDI input (Mac OS)  52
MIDI input (Windows)  67
MIDI Input menu  86

CLICK ANY INDEX ITEM TO JUMP DIRECTLY TO THAT PAGE



Index

Retro AS-1 Manual

215

MIDI Input Port  68
MIDI Mapper  69
MIDI Overview  50
MIDI Processor  112, 154, 163
MIDI Processor Application  18
MIDI Processor Concepts  90
MIDI Processor Files  90
MIDI Processor Menus  91
MIDI Processor Overview  89
MIDI Processor Reference  89
MIDI Processor Settings  88
MIDI Processor Setups  89
MIDI Program Change Selects Setup  88, 94
MIDI slider  35
MIDI Software Integration (Mac OS)  55
MIDI Software Integration (Windows)  69
MIDI Sync checkbox  103, 132, 141, 144
Mix  139, 140, 142
Mixer  96, 112, 153
Mixer Application  18
Mixer Concepts  160
Mixer Files  16
Mixer Menus  160
Mixer Overview  157
Mixer Reference  157
Mixer with the Editor  158
Mode radio buttons  97
Modifying Envelopes in Graphical Mode  131
Modulation  110, 183
modulation amount  126
modulation destination  124
Modulation Page  124
Modulation routings  124
modulation source  124
Modulator Add Button  128
Modulator Delete Button  129
Modulator Trigger Menu  133
Modulator Type Menu  129
Modulators  127
Modulators List  128
Modulators Parameters  127
Monitors & Sound control panel  27
monophonic  134
MoviePlayer  199
multimedia  199
Multimedia Control Panel  69
Multiple  133
Mute Button  165

NNNNN

New  91, 107, 160
New On Startup  93, 109
No sound output  175
Non-Registered Parameter Numbers  189
not enough polyphony  177
Note pull-down menu  110
Notes menu  101
NRPN control  189
NRPN examples  190
NRPN Tables  191
Number Of Voices  81, 149

OOOOO

Off  99
OMS  Overview  55
OMS applications  205
OMS Driver  56
OMS IAC Driver  60
OMS Input  19, 54
OMS MIDI applications  58
OMS Names  205
OMS Patch Names  206
On/Off Button  136
Opcode Vision/StudioVision  58
Open  91, 107, 160
Optimizing Overview  172
Optimizing Performance  172
Oscillator Keyboard Track button  114
Oscillator On/Off button  113
Oscillator Overview  112
Oscillator Parameters  113
Oscillator Sliders  116
Oscillator Type Menu  114
Oscillator Volume  118
Oscillators  182
Output  15, 17, 185
Overdrive  123, 141

PPPPP

Package Contents  11
Page Menu  110
Pan  149
Pan Slider  165
Parameter Editing Conventions  48, 105
Parameter slider  48
Parametric EQ  137
password  23
Paste  93, 108



Index

Retro AS-1 Manual

216

patchcords  124
Pedal  102
Pedal Down  134
Pedal menu  84, 94
Pedal Up  134
Performance  79, 172
performance is poor  177
Performance Variables  172
Phaser  139
Play With Spacebar  94, 110
Played  99
Polyphonic  147
Polyphony  17
Polyphony Problems  177
Poor “live play” response time  176
Poor sound quality  175
Port is in use by another application  176
Port menu  55
Portable Document Format  14
Portamento  149
Portamento Type  150
Predelay  145, 146
Preferences  93, 109, 129, 161
Problems  175
Program  98
Program Files  16
Program menu  155, 164
Program Overview  168
Programs  19
programs via MIDI  171

QQQQQ

Q  137
Quick Start  36
QuickTime Driver Overview  199
QuickTime™ Driver  199
Quit  92, 108, 161
QWERTY  154

RRRRR

Ramp Delay  133
Ramp Modulator  133
Ramp Speed  133
Random  116, 145
Random checkbox  132
Random Modulator  133
Random Modulator Filter  133
Randomize  109
Range menu  103, 155
Rate  110, 129

Real-World Examples  74
Record button  100
Record To Disk  197
Record To Disk Overview  197
Reflection  144
Reflection Mode  144
Release  130
Rename... button  97
Reset  95, 111, 153, 162
resolution  26
Resonance  123
Retro AS-1 Application Problems  177
Retro AS-1 Control Panel  19
Retro AS-1 Device Driver  70
Retro AS-1 Engine  19
Retro AS-1 FreeMIDI Input  54
Retro AS-1 Keyboard  151
Retro AS-1 OMS & FreeMIDI drivers  19
Retro AS-1 OMS Input  54
Retro AS-1 OMS Names  205
Retro AS-1 OMS Patch Names  206
Retro AS-1 Programs  19
Retro AS-1 Programs folder  168
Retro AS-1 QuickTime Driver  199
Retro AS-1 Serial Input  53
Retro AS-1 Status  18, 87
Retro AS-1 Variables  172
Retro AS-1 Windows Device Driver  19
Reverb  145
Reverb Mode  146
Reverse  145
Revert  92, 108
Room  146
Root menu  100
Routing Add Button  125
Routing Amount Slider  126
Routing Delete Button  126
Routing Destination Menu  126
Routing Source Menu  126
Routings  125
Routings List  125
Routings Parameters  124

SSSSS

Sample Rate  81
Save  91, 107, 160
Save As  91, 107, 161
Save As ‘New’ Template  91, 107
Screenshots  13
Second/Upper  101



Index

Retro AS-1 Manual

217

Select All  109
Selecting banks and programs via MIDI  170
Send  143, 144, 146
Serial DMA  54
Serial DMA driver  176
Serial Input  19, 53
Setting up MIDI Clock Sync via OMS  60
Setup  21
Setup Files  16
Setup Layers  98
Setup List  96
Setup List Parameters  96
Shelf EQ  137
Single  134
Single Mode  97
slider  48, 106
slider values  106
Sliders  116, 122
sliders  129
Small Hall  146
Software Components  18
software components  33
Software Credits  7
Software Installer  31
Software Integration (Mac OS)  55
Solo Button  165
Sound control panel  25
Sound Manager  25
Sound output is choppy  176
Sound Output Quality  28
Sound Problems  175
Source Menu  126
Sparse  145
Special Thanks  7
Speed  138, 139, 140
Split  101
Split Mode  98
Split Note menu  98
Split/Layer Parameters  97
Spread  122
Stand-Alone Operation  68
Start Record To Disk  95, 111, 153, 162
State Variable BP (Band Pass)  121
State Variable BS (Band Stop)  121
State Variable HP (High Pass)  121
State Variable LP (Low Pass)  121
Status  18, 95, 111, 153, 163
Steinberg Cubase  59
Stereo Mode  180
Steve O’Connell  7
Stop button  103

Stop Record To Disk  95, 111, 153, 163
StudioVision  58
StudioVision Sync Setup  60
Suggested System Enhancements  11
Sustain Decay  130
Sustain Level  130
Symmetry  116
Sync checkbox  103, 132
Sync Menu  115
Sync Setup  60
Synthesis Demystified  182
Synthesizer  16
Synthesizer Information  36
Synthesizer Menu  95, 152, 162
System Alert  29
System Exclusive Commands  189
System Performance  79
System Requirements  10

TTTTT

Tempo slider  103
Theo Byassee  7
Threshold  141, 142
Time  110, 129
Tone  142
Transpose  99, 149
Trigger button  103
Trigger Menu  133
Trigger menu  102
Trigger Mode  147
Troubleshooting  175
Type Menu  129

UUUUU

Undo  92, 108
Uninstall  23
Up & Down  150
Use current synth settings  162
Use default settings  162
Use Direct MIDI Input  87
User Interface  15
Using Record To Disk  197
Using the Mixer with the Editor  158
Using the QuickTime Driver  202

VVVVV

velocity  154
Virtual Memory  176
Vision  58
Vision Sync Setup  60



Index

Retro AS-1 Manual

218

Volume  149
Volume Control  34
Volume Slider  165
Volume Sliders  166
Volumes in Windows 95  34

WWWWW

Warn About AppleTalk  87
Warn about effect editing control  162
Warn about missing banks and programs  162
WAV  197
Welcome!  8
Where to go  49
Will Puckett  7
Windows 95 Installation  30
Windows 95 Setup  34
Windows Device Driver  19
Windows Menu  96, 112
Windows MIDI Mapper  69
Working with Banks and Programs  168
Working with MIDI  50



Index

Retro AS-1 Manual

219


	Cover Page
	Table Of Contents
	Credits
	Ch 1. Introduction
	1.1 Welcome!
	1.2 Features
	1.3 System Requirements
	1.4 Manual Organization
	1.5 Manual Conventions
	1.6 Mac OS versus Windows 95
	1.7 Key Concepts
	1.8 Software Components
	1.9 Who is BitHeadz?

	Ch 2. Installation & Setup
	2.1 Audio & MIDI Setup
	2.2 Mac OS Installation
	2.3 Mac OS Setup
	2.4 Windows 95 Installation
	2.5 Windows 95 Setup

	Ch 3. Quick Start
	3.1 Auditioning Sounds with the Keyboard
	3.2 Activating MIDI Input
	Mac OS
	Windows 95

	3.3 Basic Editor Operations
	3.4 Basic MIDI Processor Operations
	3.5 Parameter Editing Conventions

	Ch 4. Working With MIDI
	4.1 MIDI Overview
	4.1.1 Key MIDI Concepts

	4.2 External MIDI Input (Mac OS)
	4.3 MIDI Software Integration (Mac OS)
	4.4 Configuring the OMS Driver
	4.4.1 Configuring OMS MIDI applications

	4.5 Configuring the FreeMIDI Driver
	4.6 External MIDI Input (Windows)
	4.7 MIDI Software Integration (Windows)
	4.8 Configuring the Device Driver (Windows)

	Reference Section
	Ch 5. Control Panel Reference
	5.1 Control Panel Overview
	5.1.1 System Performance
	5.1.2 Key Control Panel Concepts

	5.2 Configuration Settings
	5.3 Controllers Settings
	5.4 Global Effects Settings
	5.5 Input/Output Settings
	5.6 Miscellaneous Settings

	Ch 6. MIDI Processor Reference
	6.1 MIDI Processor Overview
	6.2 Key MIDI Processor Concepts
	6.3 MIDI Processor Menus
	6.4 Setup List Parameters
	6.5 Split/Layer Parameters
	6.6 Arpeggiator Parameters

	Ch 7. Editor Reference
	7.1 Editor Overview
	7.1.2 Key Editor Concepts
	7.1.3 Parameter Editing Conventions

	7.2 Editor Menus
	7.3 Main Page
	Oscillator Parameters
	Filter Parameters

	7.4 Modulation Page
	Routings Parameters
	Modulators Parameters

	7.5 Effects Page
	Effects Overview
	Insert Effects Parameters
	Global Effects Parameters

	7.6 Global Page

	Ch 8. Keyboard Reference
	8.1 Keyboard Overview
	8.2 Key Keyboard Concepts
	8.3 Keyboard Menus
	8.4 Keyboard Parameters

	Ch 9. Mixer Reference
	9.1 Mixer Overview
	9.2 Key Mixer Concepts
	9.3 Mixer Menus
	9.4 Channel Strips
	9.5 Master Section


	Appendices
	A. Working with Banks and Programs
	B. Optimizing Performance
	C. Troubleshooting
	D. Using Digidesign Direct IO
	E. Analog Synthesis Demystified
	F. MIDI Implementation
	I. The Official MIDI Implementation Chart 
	II. Supported MIDI Control Numbers 
	III. System Exclusive Commands 
	IV. Non-Registered Parameter Numbers (“NRPNs”) 

	G. Record To Disk
	H. QuickTime™ Driver
	I. OMS Names

	Index
	Symbols
	1 Pole All Pass Resonant  
	1 Pole High Pass  
	1 Pole Low Pass  
	2 Pole All Pass Resonant  
	2 Pole High Pass  
	2 Pole Low Pass  
	4 Pole All Pass Resonant  
	4 Pole High Pass Resonant  
	4 Pole Low Pass Resonant  

	A
	Acrobat Reader  
	Activating MIDI Input  
	Add Button  
	Add... button  
	AIFF  
	Alert Volume  
	All Notes Off  
	Amount  
	Amount Slider  
	Analog Synthesis Demystified  
	André Rocke  
	AppleTalk  
	Application Problems  
	Arpeggiation Type Radio Buttons  
	Arpeggiator Parameters  
	Attack  
	audio file  
	Audio Hardware Setup  
	Audio Output menu  
	Auditioning Sounds  

	B
	Bank  
	Bank menu  
	Bank Overview  
	Banks and Programs  
	banks via MIDI  
	Base menu  
	Basic Editor Operations  
	Before You Install  
	BitHeadz  
	Bookmarks  
	Brightness  
	Buffer Length  
	Building Blocks  
	Bypass  

	C
	Cakewalk  
	Can’t connect to synthesizer  
	Chamber  
	Channel  
	Channel menu  
	Channel Strips  
	Chord  
	Chord menu  
	Chorus  
	Clear  
	clipping  
	Close  
	CM (Cutoff Modulation) Menu  
	CM Amount  
	Coarse  
	Comment Field  
	Comments Window  
	Components  
	Concepts  
	Configuration Display  
	Configuration settings  
	Configuring OMS MIDI applications  
	Configuring the Device Driver  
	Configuring the FreeMIDI Driver  
	Configuring the OMS Driver  
	Configuring the QuickTIme driver  
	Control Panel  
	Control Panel Concepts  
	Control Panel Overview  
	Control Panel Reference  
	Controller A, B, C, D menu  
	Controller A, B, C, D sliders  
	Controllers A, B, C, D overview  
	Controllers Settings  
	Conventions  
	Copy  
	CPU overload  
	Credits  
	Cross-Platform Manual  
	Cubase  
	Cubase Sync Setup  
	Cut  
	Cutoff  

	D
	David Sumich  
	Decay  
	Default MIDI Input menu  
	deinstall  
	Delay  
	Delete Button  
	Delete button  
	Depth  
	Destination Menu  
	Device Driver  
	Diffuse  
	Digidesign Direct IO  
	Direct IO  
	Direct MIDI Input  
	Direction menu  
	DirectSound  
	DirectX  
	Distortion  
	distortion  
	Division menu  
	DMA  
	Double note triggers  
	DSP  

	E
	Earl Sondreal  
	Edit  
	Edit Effect button  
	Edit Menu  
	Editing Conventions  
	Editing Programs  
	Editing radio buttons  
	Editor  
	Editor Application  
	Editor Concepts  
	Editor Effects Page  
	Editor Global Page  
	Editor Menu Items  
	Editor Overview  
	Editor Preferences  
	Editor Reference  
	Effect Amount Slider  
	Effect menu  
	Effect Parameters  
	Effect Type menu  
	Effects  
	Effects Controls  
	Effects On/Off Button  
	Effects Overview  
	Effects Page  
	Effects with the Mixer  
	Engine  
	Envelope Editing radio buttons  
	Envelope Modulator  
	envelope segment  
	Envelopes in Graphical Mode  
	EQ  
	External MIDI input (Mac OS)  
	External MIDI input (Windows)  

	F
	Features  
	Feedback  
	Fernando Martinez  
	File Menu  
	File menu  
	Filter  
	Filter On/Off button  
	Filter Parameters  
	Filter Sliders  
	Filter Type menu  
	Filters  
	Filters Overview  
	Fine  
	Fingered  
	First/Upper  
	Flange  
	FM Amount  
	FM Menu  
	footswitch  
	FreeMIDI Driver  
	FreeMIDI Input  
	FreeMIDI Overview  
	Frequency  
	FX Button  
	FX On/Off button  

	G
	Gain  
	Global  
	Global Effect  
	Global Effect menu  
	Global Effects  
	Global Effects Controls  
	Global Effects don’t sound  
	Global Effects Settings  
	Global Effects with the Mixer  
	Global Level Meter  
	Global Page  
	Global Slider  
	Graphic Keyboard  
	Graphical checkbox  
	Graphical Mode  
	graphically  
	graphics  

	H
	Hierarchy Overview  
	High  
	High Gain  
	High Key  
	Highest  
	Hysteresis  

	I
	IAC Driver  
	Important Synthesizer Information  
	Individual Mode  
	Input Problems  
	Input source checkboxes  
	Input/Output Settings  
	Insert Delay  
	Insert Effect menu  
	Insert Effect Parameters  
	Installation and Setup  
	Introduction  

	K
	Key Concepts  
	Key Up  
	Keyboard  
	Keyboard  Concepts  
	Keyboard Application  
	Keyboard Menus  
	Keyboard Overview  
	Keyboard Parameters  
	Keyboard Reference  

	L
	Large Hall  
	Last  
	Last Key  
	Latch  
	latency  
	Launch Retro AS-1 Status  
	Layer  
	Layer radio button  
	Legato  
	Legato High  
	Legato Last  
	Legato Low  
	Length  
	Level Meter  
	Level Meters  
	LFO Delay  
	LFO Modulator  
	LFO Speed  
	LFO Type  
	List  
	List Record button  
	Low  
	Low Gain  
	Low Key  
	Lowest  

	M
	Mac OS Installation  
	Mac OS Setup  
	Mac OS versus Windows 95  
	Main  
	Main Page  
	Manual  
	Manual Conventions  
	Manual Organization  
	Master FX On/Off button  
	Master Level Meters  
	Master Section  
	Master Volume Sliders  
	Maximum CPU %  
	MIDI  
	MIDI & Input Problems  
	MIDI applications  
	MIDI Channel  
	MIDI Channel menu  
	MIDI Clock Sync via OMS  
	MIDI commands  
	MIDI Concepts  
	MIDI Control examples  
	MIDI Control Numbers  
	MIDI Flow  
	MIDI Hardware Setup  
	MIDI Implementation  
	MIDI Implementation Chart  
	MIDI Input  
	MIDI input (Mac OS)  
	MIDI input (Windows)  
	MIDI Input menu  
	MIDI Input Port  
	MIDI Mapper  
	MIDI Overview  
	MIDI Processor  
	MIDI Processor Application  
	MIDI Processor Concepts  
	MIDI Processor Files  
	MIDI Processor Menus  
	MIDI Processor Overview  
	MIDI Processor Reference  
	MIDI Processor Settings  
	MIDI Processor Setups  
	MIDI Program Change Selects Setup  
	MIDI slider  
	MIDI Software Integration (Mac OS)  
	MIDI Software Integration (Windows)  
	MIDI Sync checkbox  
	Mix  
	Mixer  
	Mixer Application  
	Mixer Concepts  
	Mixer Files  
	Mixer Menus  
	Mixer Overview  
	Mixer Reference  
	Mixer with the Editor  
	Mode radio buttons  
	Modifying Envelopes in Graphical Mode  
	Modulation  
	modulation amount  
	modulation destination  
	Modulation Page  
	Modulation routings  
	modulation source  
	Modulator Add Button  
	Modulator Delete Button  
	Modulator Trigger Menu  
	Modulator Type Menu  
	Modulators  
	Modulators List  
	Modulators Parameters  
	Monitors & Sound control panel  
	monophonic  
	MoviePlayer  
	multimedia  
	Multimedia Control Panel  
	Multiple  
	Mute Button  

	N
	New  
	New On Startup  
	No sound output  
	Non-Registered Parameter Numbers  
	not enough polyphony  
	Note pull-down menu  
	Notes menu  
	NRPN control  
	NRPN examples  
	NRPN Tables  
	Number Of Voices  

	O
	Off  
	OMS  Overview  
	OMS applications  
	OMS Driver  
	OMS IAC Driver  
	OMS Input  
	OMS MIDI applications  
	OMS Names  
	OMS Patch Names  
	On/Off Button  
	Opcode Vision/StudioVision  
	Open  
	Optimizing Overview  
	Optimizing Performance  
	Oscillator Keyboard Track button  
	Oscillator On/Off button  
	Oscillator Overview  
	Oscillator Parameters  
	Oscillator Sliders  
	Oscillator Type Menu  
	Oscillator Volume  
	Oscillators  
	Output  
	Overdrive  

	P
	Package Contents  
	Page Menu  
	Pan  
	Pan Slider  
	Parameter Editing Conventions  
	Parameter slider  
	Parametric EQ  
	password  
	Paste  
	patchcords  
	Pedal  
	Pedal Down  
	Pedal menu  
	Pedal Up  
	Performance  
	performance is poor  
	Performance Variables  
	Phaser  
	Play With Spacebar  
	Played  
	Polyphonic  
	Polyphony  
	Polyphony Problems  
	Poor “live play” response time  
	Poor sound quality  
	Port is in use by another application  
	Port menu  
	Portable Document Format  
	Portamento  
	Portamento Type  
	Predelay  
	Preferences  
	Problems  
	Program  
	Program Files  
	Program menu  
	Program Overview  
	Programs  
	programs via MIDI  

	Q
	Q  
	Quick Start  
	QuickTime Driver Overview  
	QuickTime™ Driver  
	Quit  
	QWERTY  

	R
	Ramp Delay  
	Ramp Modulator  
	Ramp Speed  
	Random  
	Random checkbox  
	Random Modulator  
	Random Modulator Filter  
	Randomize  
	Range menu  
	Rate  
	Real-World Examples  
	Record button  
	Record To Disk  
	Record To Disk Overview  
	Reflection  
	Reflection Mode  
	Release  
	Rename... button  
	Reset  
	resolution  
	Resonance  
	Retro AS-1 Application Problems  
	Retro AS-1 Control Panel  
	Retro AS-1 Device Driver  
	Retro AS-1 Engine  
	Retro AS-1 FreeMIDI Input  
	Retro AS-1 Keyboard  
	Retro AS-1 OMS & FreeMIDI drivers  
	Retro AS-1 OMS Input  
	Retro AS-1 OMS Names  
	Retro AS-1 OMS Patch Names  
	Retro AS-1 Programs  
	Retro AS-1 Programs folder  
	Retro AS-1 QuickTime Driver  
	Retro AS-1 Serial Input  
	Retro AS-1 Status  
	Retro AS-1 Variables  
	Retro AS-1 Windows Device Driver  
	Reverb  
	Reverb Mode  
	Reverse  
	Revert  
	Room  
	Root menu  
	Routing Add Button  
	Routing Amount Slider  
	Routing Delete Button  
	Routing Destination Menu  
	Routing Source Menu  
	Routings  
	Routings List  
	Routings Parameters  

	S
	Sample Rate  
	Save  
	Save As  
	Save As ‘New’ Template  
	Screenshots  
	Second/Upper  
	Select All  
	Selecting banks and programs via MIDI  
	Send  
	Serial DMA  
	Serial DMA driver  
	Serial Input  
	Setting up MIDI Clock Sync via OMS  
	Setup  
	Setup Files  
	Setup Layers  
	Setup List  
	Setup List Parameters  
	Shelf EQ  
	Single  
	Single Mode  
	slider  
	slider values  
	Sliders  
	sliders  
	Small Hall  
	Software Components  
	software components  
	Software Credits  
	Software Installer  
	Software Integration (Mac OS)  
	Solo Button  
	Sound control panel  
	Sound Manager  
	Sound output is choppy  
	Sound Output Quality  
	Sound Problems  
	Source Menu  
	Sparse  
	Special Thanks  
	Speed  
	Split  
	Split Mode  
	Split Note menu  
	Split/Layer Parameters  
	Spread  
	Stand-Alone Operation  
	Start Record To Disk  
	State Variable BP (Band Pass)  
	State Variable BS (Band Stop)  
	State Variable HP (High Pass)  
	State Variable LP (Low Pass)  
	Status  
	Steinberg Cubase  
	Stereo Mode  
	Steve O’Connell  
	Stop button  
	Stop Record To Disk  
	StudioVision  
	StudioVision Sync Setup  
	Suggested System Enhancements  
	Sustain Decay  
	Sustain Level  
	Symmetry  
	Sync checkbox  
	Sync Menu  
	Sync Setup  
	Synthesis Demystified  
	Synthesizer  
	Synthesizer Information  
	Synthesizer Menu  
	System Alert  
	System Exclusive Commands  
	System Performance  
	System Requirements  

	T
	Tempo slider  
	Theo Byassee  
	Threshold  
	Time  
	Tone  
	Transpose  
	Trigger button  
	Trigger Menu  
	Trigger menu  
	Trigger Mode  
	Troubleshooting  
	Type Menu  

	U
	Undo  
	Uninstall  
	Up & Down  
	Use current synth settings  
	Use default settings  
	Use Direct MIDI Input  
	User Interface  
	Using Record To Disk  
	Using the Mixer with the Editor  
	Using the QuickTime Driver  

	V
	velocity  
	Virtual Memory  
	Vision  
	Vision Sync Setup  
	Volume  
	Volume Control  
	Volume Slider  
	Volume Sliders  
	Volumes in Windows 95  

	W
	Warn About AppleTalk  
	Warn about effect editing control  
	Warn about missing banks and programs  
	WAV  
	Welcome!  
	Where to go  
	Will Puckett  
	Windows 95 Installation  
	Windows 95 Setup  
	Windows Device Driver  
	Windows Menu  
	Windows MIDI Mapper  
	Working with Banks and Programs  
	Working with MIDI  


	Mr. Waveform

